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CHAPTER 1

Read Me First

Related References
 Release Notes

* Cisco SD-WAN Controller Compatibility Matrix and Server Recommendations

User Documentation
* Cisco IOS XE (Cisco IOS XE SD-WAN Devices)
* Cisco SD-WAN (Cisco vEdge Devices)
* Cisco IOS XE (SD-WAN) Qualified Command Reference
* User Documentation for Cisco IOS XE (SD-WAN) Release 17

» User Documentation for Cisco vEdge Devices

Communications, Services, and Additional Information

* Sign up for Cisco email newsletters and other communications at: Cisco Profile Manager.

* For information on the latest technical, advanced, and remote services to increase the operational reliability
of your network visit Cisco Services.

* To browse and discover secure, validated enterprise-class apps, products, solutions, and services, visit
Cisco Devnet.

* To obtain general networking, training, and certification titles from Cisco Press Publishers, visit Cisco
Press.

* To find warranty information for a specific product or product family, visit Cisco Warranty Finder.
* To view open and resolved bugs for a release, access the Cisco Bug Search Tool.

* To submit a service request, visit Cisco Support.

Documentation Feedback

To provide feedback about Cisco technical documentation use the feedback form available in the right pane
of every online document.
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CHAPTER 2

Information About Cisco SD-WAN Cloud onRamp
for Colocation Solution

* Cisco SD-WAN Cloud onRamp for Colocation Solution, on page 3
* Cisco SD-WAN Cloud onRamp for Colocation Solution Components, on page 4

Cisco SD-WAN Cloud onRamp for Colocation Solution

As more applications move to the cloud, the traditional approach of backhauling traffic over expensive WAN
circuits to a data center is no longer relevant. The conventional WAN infrastructure was not designed for
accessing applications in the cloud. The infrastructure is expensive and introduces unnecessary latency that
degrades the experience.

Network architects are reevaluating the design of the WANSs to achieve the following:

* Support a cloud transition.
* Reduce network costs.

* Increase the visibility and manageability of the cloud traffic.

The architects are turning to Software-Defined WAN (SD-WAN) fabric to take advantage of inexpensive
broadband Internet services and to route intelligently a trusted SaaS cloud-bound traffic directly from remote
branches.

With the Cisco SD-WAN Cloud onRamp for Colocation solution built specifically for colocation facilities,
the solution routes the traffic to the best-permissible path from branches and remote workers to where all
applications are hosted. The solution also allows distributed enterprises to have an alternative to enabling
direct internet access at the branch and enhance their connectivity to infrastructure-as-a-service (IaaS) and
software-as-a-service (SaaS) providers.

The solution provides enterprises with multiple distributed branch offices that are clustered around major
cities or spread over several countries the ability to regionalize the routing services in colocation facilities.
Reason being, these facilities are physically closer to the branches and can host the cloud resources that the
enterprise needs to access. So, essentially by distributing a virtual Cisco SD-WAN over a regional architecture
of colocation centers, the processing power is brought to the cloud edge.

The following image shows how you can aggregate the access to the multicloud applications from multiple
branches to regional colocation facilities.
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. Cisco SD-WAN Cloud onRamp for Colocation Solution Components

Figure 1: Cisco SD-WAN Cloud onRamp for CoLocations
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The solution can serve four specific types of enterprises:

» Multinational companies that cannot use direct internet connections to the cloud and SaaS platforms due
to security restrictions and privacy regulations.

* Partners and vendors without Cisco SD-WAN but still need connectivity to their customers. They do not
want to install SD-WAN routing appliances in their site.

* Global organizations with geographically distributed branch offices that require high bandwidth, optimum
application performance, and granular security.

» Remote access that need secure VPN connections to an enterprise over inexpensive direct internet links.
The Cisco SD-WAN Cloud onRamp for Colocation solution can be hosted within certain colocation facilities

by a colocation IaaS provider. You can select the colocation provider that meets your needs in a region on a
regional basis as long as it supports the necessary components.

Cisco SD-WAN Cloud onRamp for Colocation Solution
Components

The Cisco SD-WAN Cloud onRamp for Colocation solution can be deployed in multiple colocations. A
colocation is a stack of compute and networking fabric that brings up multiple virtual networking functions
and multiple service chains on them. This stack connects branch users, endpoints to a hybrid cloud or data
center. Cisco vManage is used as the orchestrator to provision the devices in a colocation. Each colocation
does not have visibility of other colocations in the same site or across sites.

The following image shows the components of Cisco SD-WAN Cloud onRamp for Colocation solution.
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Cisco SD-WAN Cloud onRamp for Colocation Solution Components .

Figure 2: Cisco SD-WAN Cloud onRamp for Colocation Solution Architectural Overview
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« Cisco Cloud Services Platform, CSP-5444 and CSP-5456—Cloud Services Platform (CSP) is an x86
Linux hardware platform that runs NFVIS software. It is used as the compute platform for hosting the
virtual network functions in the Cisco SD-WAN Cloud onRamp for Colocation solution. Multiple CSP
systems can be used in a Cisco SD-WAN Cloud onRamp for Colocation deployment.

Cisco Network Function Virtualization I nfrastructure Software—The Cisco Network Function
Virtualization Infrastructure Software (NFVIS) software is used as the base virtualization infrastructure
software running on the x86 compute platform. The Cisco NFVIS software provides VM lifecycle
management, VM service chaining, VM image management, platform management, PNP for bootstrapping
a device, AAA features, and syslog server. See the NFVIS Functionality Changes for SD-WAN Cloud
OnRamp for Colocation in NFVIS documentation.

« Virtual Network Functions—The Cisco SD-WAN Cloud onRamp for Colocation solution supports
both Cisco-developed and third-party Virtual Network Functions (VNFs). The following table includes

the validated VNFs and their versions:

Table 1: Validated Virtual Network Functions

Virtual Network Functions Version
Cisco CSR1000V 17.1.1,17.2,17.3
Cisco Catalyst 8000V 17.4.1a

Cisco IOS XE SD-WAN Device

16.12.1,16.12.2r, 17.2.1r, 17.3.1a

Cisco ASAv

9.12.2,9.13.1,9.15.1

CheckPoint

R80.30, R80.40
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. Cisco SD-WAN Cloud onRamp for Colocation Solution Components

Version

6.4.0.1, 6.5.0-115
19.2.1,20.1.1, 20.3.1, 20.4.1
9.0.0

Virtual Network Functions

Cisco FTDv/NGFW

Cisco vEdge Cloud Router
Palo Alto Firewall (PAFW)

Fortinet Firewall 6.0.2

To validate third-party VNFs on the Cisco SD-WAN Cloud onRamp for Colocation solution, you can
use the Cisco certification program. For more information about validating third-party VNFs, see
https://developer.cisco.com/site/nfv/#the-ecosystem-program .

Physical Networ k Functions—A Physical Network Function (PNF) is a physical device that is dedicated
to provide a specific network function as part of a colocation service chain such as a router or a firewall.
The following are the validated PNFs and their versions:

Table 2: Validated Physical Network Functions

Version

6.4.0.1,6.5

Physical Network Functions

Cisco FTD
Model: FPR-9300

Cisco ASR 1000 Series 16.12.1,17.1,17.2, 17.3

Network Fabric—Forwards traffic between the VNFs in a service chain by using a L2 and VLAN-based
lookup. The last VNF can forward traffic to the network fabric either through L2 or L3 forwarding. The
network fabric can include either of the following:

* Cisco Catalyst 9500-40X switch: Supports 40 10G ports and two 40G ports, which is used as the
network fabric

* Cisco Catalyst 9500-48Y4C switch: Supports 48 1G/10G/25G ports and four 40G/100G ports, which
is used as the network fabric.

Management Networ k—A separate management network connects the NFVIS software running on
the CSP systems, the virtual network functions, and the switches in fabric. This management network is
also used for transferring files and images into and out of the systems. The Out of Band management
switch configures the management network. The IP addresses assigned to the CSP devices, Cisco Catalyst
9500-40X or Cisco Catalyst 9500-48Y4C switches are acquired by the management network pool through
DHCP configuration. The orchestrator manages VNF management IP addresses and assigns through the
VNF Day-0 configuration file.

Virtual Network Function Networ k Connectivity — A VNF can be connected to the physical network
by using either Single Root 10 Virtualization (SR-IOV) or through a software virtual switch. A VNF
can have one or more virtual network interfaces (VNICs), which can be directly or indirectly connected
to the physical network interfaces. A physical network interface can be connected to a software virtual
switch and one or more VNFs can share the virtual switch. The Cisco SD-WAN Cloud onRamp for
Colocation solution manages the creation of virtual switch instances and the virtual NIC membership to
create connectivity. By default, all the physical interfaces and the management interface in the CSP
system are available for use by VNFs.
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In Cisco SD-WAN Cloud onRamp for Colocation deployments, SR-IOV interfaces are configured in
Virtual Ethernet Port Aggregator (VEPA) mode. In this mode, the NIC sends all the traffic that is received
from the VNFs to the external Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switches. The
Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C transfers the traffic that is based on the L2 MAC
address and VLAN. It can send the traffic back to the CSP or to an external connected network. The
Catalyst 9500 switch ports that are connected to the CSP interfaces are configured in VEPA mode. When
a VLAN is configured on a VNF VNIC, the VLAN must be configured on the connected port on Cisco
Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switches.

A VNF using a SR-IOV interface and a VNF using the software switch can be service chained through
the external switch fabric.

Physical Network Function Network Connectivity— A PNF can be connected to the Cisco Catalyst
9500-40X or Cisco Catalyst 9500-48Y4C switch ports, which are the free data ports available from the
right side.

Service Chains—In Cisco SD-WAN Cloud onRamp for Colocation solution deployment, the traffic
between the VNFs is service chained externally through Cisco Catalyst 9500-40X or Cisco Catalyst
9500-48Y4C. The service chaining requirement provides service chaining functionality to the traffic
across VNFs running either on a single CSP or across multiple CSP systems in a cluster. The service
chaining is based on the source and destination endpoints in the service chain and is not based on the
provider application. In Cisco SD-WAN Cloud onRamp for Colocation solution, L2 (VLAN, destination
MAC address) based service chaining has been used.

Cisco Colocation Manager —The Cisco Colocation Manager (CCM) component is a software stack
that manages the Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switches. In this solution,
Cisco Colocation Manager is hosted on NFVIS software in a docker container. The CSP devices host
Cisco Colocation Manager along with PNFs and VNFs as shown in the solution architectural overview

A single CCM instance per cluster is brought up in one of the CSP devices after activating a cluster. The
CCM software accepts the Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C configuration and
monitors them. See Configure Cisco SD-WAN Cloud onRamp for Colocation Solution Devices Using
Cisco vManage for more information.

Orchestration through Cisco vM anage —Cisco vManage server is used for orchestrating the Cisco
SD-WAN Cloud onRamp for Colocation solution. For more information, see the Cisco SD-WAN
Configuration Guides.
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CHAPTER 3

Prerequisites and Requirements of Cisco
SD-WAN Cloud onRamp for Colocation Solution

* Cisco SD-WAN Cloud onRamp for Colocation Solution Requirements, on page 9
* Prerequisites for Deploying Solution, on page 15
» Sizing Requirements of Cisco SD-WAN Cloud onRamp for Colocation Solution Devices, on page 16

Cisco SD-WAN Cloud onRamp for Colocation Solution
Requirements

The following are the hardware, software, Cloud OnRamp for Colocation cluster, and cabling requirements
for deploying Cisco SD-WAN Cloud onRamp for Colocation solution.

Hardware Requirements

The following table lists the hardware requirements:

Table 3: Feature History

Feature Name |Release Description

Information
Support for Cisco SD-WAN | Starting from this release, Cisco CSP-5456 is supported on the Cloud
Cisco Cloud Release 20.4.1 | onRamp for Colocation solution. The CSP-5456 offers a higher capacity
Services of 56 cores, which maximizes the placement of VNFs in service chains.
Platform,
CSP-5456

Table 4: Hardware Requirements

Components Hardware Requirements
Compute platform CSP- 5444 and CSP-5456
Physical form factor Cisco UCS C240 M5SX (2RU)
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Components

Hardware Requirements

Processor cores

CSP-5444: 44 physical cores
CSP-5456: 56 physical cores

PCle NIC slots 6

Disk 8*1.2TB=9.6TB

Disk slots 26 (24 useable)

Memory 192 GB of RAM

RAID 12-Gbps SAS HW controller, 4 GB flash-backed write cache (FBWC),

RAID 10.

Base Networking

4x1PCIE card in M5 6x1GE Intel i350 ports, 2x1GE LoM

Note 2-GigE interfaces in a port channel configuration are required
for the NFVIS and VM management traffic.

Network Interface Cards (NIC)

2xIntel X520 2-port 10G (Niantic) and Intel XL710 4-port 10G SFP+
(Fortville)

Note Two Fortville 10G interfaces in port-channel configuration and
connected to a virtual switch. This connectivity is required for
production traffic to or from the VMs, which support only virtio
interface.

Note Two Fortville 10G interfaces in port-channel configuration and
connected to a virtual switch. This configuration is required for
VNF HA state synchronization between VNFs hosted on two
different CSP systems.

Note Four Niantic 10G interfaces in SR-IOV mode. The VMs that
need high performance and low latency network connectivity to
bypass the hypervisor or virtual switch require these interfaces.
The VMs that can support SR-IOV must be connected to the
SR-IOV virtual function (VFs). Link redundancy is not available
in this mode.

Note For prescriptive connections, ensure that the Fortville NIC (X710)
is placed in riser 1, slot-2 and Niantic cards (X520) in riser1, slot
1; and riser 2, slot 4.

Processors (2)

2xIntel Xeon Gold 6152 Series

Power Supplies

Dual power
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Software Requirements .

Components

Hardware Requirements

Network fabric

Catalyst 9500-40X
Supports forty10G ports and two 40G ports

Catalyst 9500-48Y 4C
Supports forty-eight 1G/10G/25G ports and four 40G/100G ports

Management network

Any switch with sufficient number of 1G ports and port channel feature can
be used as the management switch. Two switches are recommended to
support hardware and link redundancy.

Software Requirements

The following table lists the software requirements:

Table 5: Software Requirements

Components

Software Requirements

Virtualization infrastructure

Cisco NFVIS Cloud OnRamp for Colocation

software See Release Notes for Cisco SD-WAN Cloud OnRamp for Colocation
Solution.
Orchestration Cisco vManage

See

* Cisco SD-WAN Product Documentation for more information.

* Cisco SD-WAN Release Notes for more information about the latest
vManage features.

All CSP devices and switches must run same version of the software in the Cloud OnRamp for
Colocation solution. Any new software version for all devices in a colocation is hosted on Cisco

vManage, upon availability.

Supported Platforms and Firmware

The following table lists the supported platform and firmware versions of Cisco NFVIS:

Platform Firmware Version
CSP-5444, CSP-5456 BIOS C240M5.4.1.2b.0.0917201934
CIMC 4.1(2b)

To upgrade a CIMC version, see the Cisco Host Upgrade Utility User Guide.
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Note We recommend that you reach out the Technical Assistance Center (TAC) when upgrading the CIMC version.

Wiring Requirements

Table 6: Feature History

Feature Name |Release Description
Information

Support for SVL | Cisco IOS XE | With this feature, you can configure SVL ports on 100-G Ethernet
Port Release 17.8.1a |interfaces of Cisco Catalyst 9500-48Y4C switches, thus ensuring a high
Configuration on level of performance and throughput.

100G Interfaces | &S¢0 YManage

Release 20.8.1

Cisco NFVIS
Release 4.8.1

The solution supports both flexible and prescriptive connections between Cisco CSP devices and Cisco Catalyst
9500 switches.

Prescriptive Connections

Prescriptive connections are supported on both Cisco Catalyst 9500-48Y4C and Cisco Catalyst 9500-40X
switches.

Ensure that you connect the SVL ports and uplink ports of the Catalyst 9500 switches based on the following
information:

Cisco Catalyst 9500-40X
* Stackwise Virtual Switch Link (SVL) ports: 1/0/38-1/0/40, and 2/0/38-2/0/40

* Uplink ports: 1/0/36, 2/0/36 (input VLAN handoff) and 1/0/37, 2/0/37 (output VLAN handoff)

Cisco Catalyst 9500-48Y4C

The following image shows the high-level design of the physical connectivity for Cisco Catalyst 9500-40X
switch.
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Figure 3: Prescriptive Connections for Cisco Catalyst 9500-40X
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Ports
In the preceding topology, each CSP has two 1-GB management ports configured as port channels to the OOB
management switch. Each of the Cisco Catalyst 9500-40X switch is connected to the 1-GB port. This
connectivity requires two ports on the Management switch per cloud onramp for colocation. The service
provider handoff is connected to 10-GB ports on this switch. All service providers ports are trunked into the
Cisco Catalyst 9500-40X switch. All the VLANSs are configured on all ports of Cisco Catalyst 9500-40X
switch.

You can similarly connect the CSP devices with the Cisco Catalyst 9500-48Y4C switches in a prescribed
manner.

Y

Note The management switches are not orchestrated and must be manually provisioned. Although the management
switches are not orchestrated, ensure that the management switches and devices are connected as per the

defined connections.

Flexible Connections

Flexible connections are supported on Cisco Catalyst 9500-40X and Cisco Catalyst 9500-48Y4C switches.
For flexible connections:

* Exactly two Niantic cards and one Fortville card should be inserted into a Cisco CSP device in any riser
card slot.
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A\

Note Ifyou insert the Niantic cards into slots other than riser slots 1 and 4, and Fortville
card into any slot other than slot 2, then clean install Cisco NFVIS on the Cisco
CSP device after connecting all the cards.

» All data ports on a Cisco CSP device connected to any available ports on Cisco Catalyst 9500-40X or
Cisco Catalyst 9500-48Y4C switches.

N

Note Ensure that you connect all ports on Cisco CSP devices and they are connected
in a redundant manner to the primary and secondary switch ports. If all Cisco
CSP ports are not connected, the cluster activation process fails.

» Connect SVL ports anywhere between 1/0/1-1/0/48 and 2/0/1-2/0/48. It cannot be connected between
1/0/48-1/0/52 or 2/0/48-2/0/52.

* Connect Uplink ports anywhere between 1/0/1-1/0/48 and 2/0/1-2/0/48 for 10G/25G throughput, or
between 1/0/49-1/0/52 and 2/0/49-2/0/52 for 40G/100G throughput

* Connect all Niantic and Fortville ports of a Cisco CSP device for redundancy. For example, if Niantic
ports are plugged into riser slots 1 and 2 and Fortville ports are plugged into riser slot 4, then you can
connect the Cisco CSP interfaces to the switches in either of the following ways:

* Primary switch: eth1-1, eth2-1, eth4-1, eth4-3
Secondary Switch: eth1-2, eth2-2, eth4-2, eth4-4

* Primary switch: eth1-2, eth2-1, eth4-1, eth4-2
Secondary Switch: eth1-1, eth2-2, eth4-3, eth4-4

* Connect Physical Network functions (PNFs) to any available Cisco Catalyst 9500-40X or Cisco Catalyst
9500-48Y4C switches

* Connect each of the Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switch to the 1-GB
management port. Each Cisco CSP device has two 1-GB management ports configured as port channels
to the OOB management switch. The management switches are not orchestrated through Cisco vManage.
Therefore, ensure that you connect the management switches and management ports as shown in the
following image.

The following image shows the flexible connectivity between the Cisco CSP devices and Cisco Catalyst
9500-48Y4C switches where the SVL and uplink ports are connected to the default ports.
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Figure 4: Cisco SD-WAN Cloud onRamp for Colocation Solution Flexible Connections
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Prerequisites for Deploying Solution

The following are prerequisites for deploying the Cisco SD-WAN Cloud onRamp for Colocation solution:

* A minimum of two CSP PID (two Niantics and one Fortville) required. You can order more CSP devices
as per the number of service chains that are required per cluster (including HA instances). Also, consider
the throughput requirement or number of sessions terminating the cloud onramp for colocation when
ordering the number of CSP devices.

* A smart account that is required to propagate the ordered devices to the PNP cloud and vOrchestrator.

» Two Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C and OOB switches, and a DHCP server
per cluster are required.

* Port channel, RJ45 and data SFP along with cables for connectivity are required.
* Cisco ASR 1000 series or a router for WAN termination are required.
* Terminal server for configuring switches and CIMC is required.

* Split management IP pool per cluster into two parts. Configure one part on a DHCP server by considering
number of physical devices in a cluster and IP addresses required for broadcast and gateway. Configure
the other part of management IP pool on the vManage for VNFs and Cisco Colo Manager. The first IP
address in the vManage management pool is used for Cisco Colo Manager. Ensure that you configure
this IP address and PNP server for the switch.

Cisco SD-WAN Cloud OnRamp for Colocation Solution Guide, Release 20.8.1 [Jjj



Prerequisites and Requirements of Cisco SD-WAN Cloud onRamp for Colocation Solution |
. Sizing Requirements of Cisco SD-WAN Cloud onRamp for Colocation Solution Devices

* OOB management switch is required to terminate the traffic.

Sizing Requirements of Cisco SD-WAN Cloud onRamp for
Colocation Solution Devices

The cloud onramp for colocation cluster requirements can be categorized into small, medium, large, and extra
large clusters that are based on throughput and compute demands.

Consider the following criteria to determine the various cloud onramp for colocation size categories:

\}

Note The cloud onramp for colocation size must be determined before orchestration when ordering the devices
such as, CSP devices, and Cisco Catalyst 9500-40X and Cisco Catalyst 9500-48Y4C switches.

* Depending on the number of connections that are required for public clouds and the number of customers
trying to reach these clouds, decide the number of required service chains.

* Depending on the policies that must be enforced, decide the number of VMs required in each service
chain.

* From the preceding two criteria, you can determine on an average the throughput that is required per
service chain.

In a single Cisco SD-WAN Cloud onRamp for Colocation Solution solution deployment, you can deploy two
to three CSP systems in a cluster.
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CHAPTER 4

Get Started with Cisco SD-WAN Cloud onRamp
for Colocation Solution

* Cisco SD-WAN Cloud onRamp for Colocation Solution—Deployment Workflow, on page 17
* Install Cisco NFVIS Cloud OnRamp for Colocation on Cisco CSP , on page 18

* Bring up Cisco Cloud Services Platform Devices, on page 21

* Bring up Switch Devices, on page 25

* Bring up Cisco Colo Manager , on page 27

* Provision and Configure Cisco SD-WAN Cloud onRamp for Colocation Solution, on page 28

Cisco SD-WAN Cloud onRamp for Colocation
Solution—-Deployment Workflow

This topic outlines the sequence of how to get started with the colo devices and build clusters on vManage.
Once a cluster is created and configured, you can follow the steps that are required to activate the cluster.
Understand how to design service groups or service chains and attach them to an activated cluster. The
supported Day-N operations are also listed in this topic.

1. Complete the solution prerequisites and requirements. See Prerequisites and Requirements of Cisco
SD-WAN Cloud onRamp for Colocation Solution, on page 9.

* Complete wiring the CSP devices (set up CIMC for initial CSP access) and Cisco Catalyst 9500-40X
or Cisco Catalyst 9500-48Y4C switches (set up console server) along with OOB or management
switches. Power on all devices.

* Set up and configure DHCP server. See Provision DHCP Server Per Colocation, on page 28 .
2. Verify the installed version of Cisco NFVIS and install NFVIS, if necessary. See Install Cisco NFVIS
Cloud OnRamp for Colocation on Cisco CSP , on page 18 .

3. Setup or provision a cluster. A cluster constitutes of all the physical devices including CSP devices, and
Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switches. See Get Started with Cisco SD-WAN
Cloud onRamp for Colocation Solution, on page 17.

* Bring up CSP devices. See Onboard CSP Devices Using Plug-and-Play Process , on page 21.

* Bring up Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switches. See Bring up Switch
Devices, on page 25.
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* Provision and configure a cluster. See Provision and Configure Cluster, on page 38.

Configure a cluster through cluster settings. See Cluster Configuration, on page 41.

4. Activate a cluster. See Create and Activate Clusters, on page 39.

5. Design service group or service chain. See Manage Service Groups, on page 64.

)

Note  You can design a service chain and create a service group anytime before creating clusters or activating clust
after all VMs are uploaded to the repository.

6. Attach or Detach service group and service chains to a cluster. See Attach or Detach a Service Group in
a Cluster, on page 88.

A\

Note Service chains can be attached to a cluster after the cluster is active.

7. (Optional) Perform all Day-N operations.

* Detach a service group to detach service chains. See Attach or Detach a Service Group in a Cluster,
on page 88.

* Add and delete CSP devices from a cluster. See Add Cloud OnRamp Colocation Devices Using
Cisco vManage, on page 35 and Delete Cloud OnRamp for Colocation Devices from vManage, on
page 37.

* Deactivate a cluster. See Remove Cluster from vManage, on page 61.
* Reactivate a cluster. See Reactivate Cluster from Cisco vManage, on page 64.

* Design more service group or service chain. See Create Service Chain in a Service Group, on page
65.

Install Cisco NFVIS Cloud OnRamp for Colocation on Cisco CSP

This section provides information about a series of tasks you need to perform to install NFVIS Cloud OnRamp
for Colocation on a Cisco CSP device.

Log Into CIMC User Interface

Before you begin
* Ensure that you have configured the IP address to access CIMC.

* If not installed, install Adobe Flash Player 10 or later on your local system.

For details on how to configure an IP address for CIMC, see the Set up CIMC for UCSC-Series Server guide
on cisco.com.
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Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8
Step 9
Step 10

Step 11

Step 12

Step 13
Step 14
Step 15

Step 16
Step 17
Step 18

Step 19

Log Into CIMC User Interface .

For information about upgrading CIMC, see the CIMC Firmware Update Utility guide on cisco.com.

In your web browser, enter the IP address that you configured to access CIMC during initial setup.
If a security dialog box displays, do the following:

a) Optional: Select the check box to accept all content from Cisco.

b) Click Yesto accept the certificate and continue.

In the log in window, enter your username and password.

When logging in for the first time to an unconfigured system, use admin as the username and passwor d as the password.

Click Log In.
The Change Passwor d dialog box only appears the first time you log into CIMC.

Change the password as appropriate and save.

The CIMC home page is displayed.

From the CIMC Server tab, select Summary, and click Launch KVM Console.

The KVM Console opens in a separate window.

From the Virtual M edia menu on the KVM Console, select Activate Virtual Devices.

If prompted with an unencrypted virtual media session message, select Accept this session, and click Apply. The
virtual devices are activated now.

From the Virtual M edia menu on the KVM Console, select Map CD/DVD.
Browse for the installation file (ISO) on your local system, and select it.
Click Map Device.

The ISO image file is now mapped to the CD/DVD.

From the CIMC Server tab, select BIOS.

For more information about upgrading BIOS, see the BIOS Upgrade guide on cisco.com.

From the BIOS Actionsarea, select Configure Boot Order.

The Configure Boot Order dialog box appears.

From the Device Typesarea, select CD/DVD Linux Virtual CD/DVD, and then click Add.
Select HDD, and then click Add.

Set the boot order sequence using the Up and Down options. The CD/DVD Linux Virtual CD/DVD boot order option
must be the first choice.

To complete the boot order setup, Click Apply.
Reboot the server by selecting the Power Off Server option from the Server Summary page in CIMC.
After the server is down, select the Power On Server option in CIMC.

When the server reboots, the KVM console will automatically install Cisco Enterprise NFVIS from the virtual CD/DVD
drive. The entire installation might take 30 minutes to one hour to complete.

After the installation is complete, the system is automatically rebooted from the hard drive. Log into the system when
the command prompt changes from "localhost" to "nfvis" after the reboot.
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Wait for some time for the system to automatically change the command prompt. If it does not change automatically,
press Enter to manually change the command prompt from "localhost" to "nfvis". Use admin as the login name and
Admin123# as the default password.

Note The system prompts you to change the default password at the first login. You must set a strong password
as per the on-screen instructions to proceed with the application. You cannot run API commands or proceed
with any tasks unless you change the default password at the first login. API will return 401 unauthorized
error if the default password is not reset.

Step 20 You can verify the installation using the System API or by viewing the system information from the Cisco Enterprise
NFVIS portal.

\)

Note Ensure that the RAID configuration is 4.8 TB RAID-10. To configure RAID through CIMC, see the Cisco
UCS Servers RAID Guide on cisco.com.

Activate Virtual Device

You will have to launch the KVM Console to activate virtual devices.

Before you begin

Ensure that you have the Java 1.6.0 14 or a higher version installed on your local system.

Step 1 Download the Cisco Enterprise NFVIS image from a prescribed location to your local system.
Step 2 From CIMC, select the Server tab, and click Launch KVM Console.

Note A JNLP file will be downloaded to your system. You must open the file immediately after it is downloaded to
avoid the session timeout.

Step 3 Open the renamed .jnlp file. When it prompts you to download Cisco Virtual KVM Console, click Yes. Ignore all security
warnings and continue with the launch.

The KVM Console is displayed.

Step 4 From the Virtual Media menu on the KVM Console, select Activate Virtual Devices.

If prompted with an unencrypted virtual media session message, select Accept thissession, and click Apply. The virtual
devices are activated now.

Map NFVIS Cloud OnRamp for Colocation Image

Step 1 From the Virtual M edia menu on the KVM Console, select Map CD/DVD....

Step 2 Browse for the installation file (ISO) on your local system, and select it .
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Step 3

Step 4

Click Map Device.
The ISO image file is now mapped to the CD/DVD.

From the KVM console, power cycle (warm reboot) and system installation process starts and NFVIS is installed.

Bring up Cisco Cloud Services Platform Devices .

Bring up Cisco Cloud Services Platform Devices

Table 7: Feature History

Feature Name |Release Description

Information
Onboarding CSP | Cisco SD-WAN | This feature enables you to onboard CSP devices by loading the Day-0
Device with Release 20.4.1 | configuration file to a USB drive. Use this onboarding option when you
Day-0 can't access the Internet to reach the Plug-and-Play Connect server.
Configuration
Using USB
Drive

To bring up the Cisco Cloud Services Platform (CSP) devices, you can use the following options:

» Automated deployment: Securely onboards and deploys CSP devices with factory settings into the Cisco
SD-WAN network during the Day-0 configuration. The deployment dynamically discovers the IP address
of Cisco vBond Orchestrator using the Plug-and-Play (PnP) process for Cisco CSP devices.

* Bootstrap deployment: Requires you to share the configuration files with the CSP devices. You can either
create a configuration file and copy it to a bootable USB, or add the configuration file to the USB. The
bootable USB is connected and available on the devices at the time of bootup.

Onboard CSP Devices Using Plug-and-Play Process

This topic describes how the bringing up of Cisco CSP devices are automated using the PnP process.

Step 1
Step 2

Step 3

Before you begin

* Ensure that you connect the CSP devices as per the prescribed topology, and power them on.

* Connect the Plug-and-Play (PnP) supported interface to the WAN transport (typically Internet).

Power on a Cisco CSP device. The following process occurs:

When the device boots up, it obtains the IP address, default gateway, and DNS information through the DHCP process
on the supported PnP interface of the device.

The device connects with the Cisco cloud hosted PnP Connect server and shares its chassis or serial number with the PnP
server to be authenticated by it.

After authentication, the PnP Connect portal provides the device with information about the Cisco vBond Orchestrator,
organization name, and root certificates.
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Step 4
Step 5

Step 6
Step 7

Step 8

For deployments that use enterprise root-ca certificate, information about Cisco vBond Orchestrator IP address or DNS,
organization-name, and enterprise root-ca certificate are downloaded on the device from the PnP Connect portal using
the HTTPS protocol. The device uses this information to initiate control connections with the Cisco vBond Orchestrator.

You can view the availability of the device and association with the Cisco vBond Orchestrator on the PnP interface
through the PnP Connect portal.

The PnP Connect portal then displays a Redirect Successful status when the device is redirected through PnP to the
Cisco vBond Orchestrator.

After authentication with the Cisco vBond Orchestrator, the device is provided with Cisco vManage and Cisco vSmart
Controller information to register and establish a secure connection.

The device attempts to establish a secure control connection with the Cisco vManage server.

After authentication with the Cisco vBond Orchestrator, the Cisco vManage server responds to the device with the system
IP of the device and reauthenticates the device using the shared system-ip information.

To join the Cisco SD-WAN overlay network, the device reinitiates control connections to all the SD-WAN controllers
using the configured system-ip IP address.

Onboard CSP Devices Using USB Bootstrapping Process

If you're unable to use the automated discovery option, use this deployment option to configure the
factory-shipped device, which comes without any configuration.

We recommend this deployment option when:

* The device is connected to a private WAN transport (MPLS) that can’t provide a dynamic IP address.

* Internet access isn't available to reach the Plug-and-Play Connect server.

Pointsto Consider

* The USB drive can have multiple Day-0 configuration files, which are identified by the serial number
of the device in the file name. This naming convention enables you to use the same USB drive for
bootstrapping multiple devices.

* The supported Day-0 configurations included in the configuration file are:

« Static IP configuration of the device
* Cisco vBond Orchestrator IP address and the port configuration

* DNS server and domain name configuration

* The bootstrap configuration can be uploaded to a USB key and inserted into a device at the install site.

Before you begin
* The device must be in factory default state with no added configuration.
* The device must be installed with a fresh image of Cisco NFVIS.

* The USB drive must be Virtual File Allocation Table (VFAT) formatted to recognize and automount the
drive. Insert the USB drive into a laptop or desktop to format it.
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* The device should be able to reach the Cisco vBond Orchestrator.

Step 1 Create a configuration file on the root folder of the USB drive.
Ensure that the configuration file name is, nfvis_config_ SERIAL.xml, where
SERIAL represents the serial number of the CSP device.
For example,

nfvis_config_ WZP232903K6.xml

Step 2 Copy the following to the configuration file.

<config xmlns="http://tail-f.com/ns/config/1.0">
<vm_lifecycle xmlns="http://www.cisco.com/nfvis/vm lifecycle">
<networks>
<network>
<name>int-mgmt-net</name>
<subnet>
<name>int-mgmt-net-subnet</name>
<address>192.168.30.6</address>
<netmask>255.255.255.0</netmask>
<gateway>192.168.30.1</gateway>
</subnet>
</network>
</networks>
</vm_lifecycle>

<system xmlns="http://viptela.com/system">
<organization-name>vIPtela Inc Regression</organization-name>
<sp-organization-name>vIPtela Inc Regression</sp-organization-name>
<vbond>
<remote>172.23.191.87</remote>
<port>12346</port>
</vbond>
</system>

<vpn xmlns="http://viptela.com/vpn">.
<vpn-instance>
<vpn-id>0</vpn-id>
<interface>
<if-name>colo-mgmt</if-name>
<tunnel-interface>
<encapsulation>
<encap>ipsec</encap>
</encapsulation>
</tunnel-interface>
<shutdown>false</shutdown>
</interface>
</vpn-instance>
</vpn>
</config>

Note It’s mandatory to copy the above-mentioned static IP configuration of the device to the configuration file. The
static IP configuration of the device is represented by the following Day-0 configurations:

<address></address>, <netmask></netmask>, and <gateway></gateway>

Step 3 Insert the USB drive into the Cisco CSP device and power on the device.
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When the device boots up, the device searches for the configuration file in the bootable USB drive. After the file is
located, the device suspends the PnP process and loads the bootstrap configuration file.

Step 4 Remove the USB drive.

Note If you don’t unmount the USB drive and reboot the device after the configuration has been applied, the USB
drive configuration isn’t reapplied. The CSP device isn’t in Factory Data Reset (FDR) state or restored to its
original system state.

Step 5 To access a CSP device, SSH to a static IP address provided in Step 2 such as, 192.168.30.6.
Step 6 Change the default password at the first login when the system prompts you to change.

Ensure that you set a strong password based on the on-screen instructions. You can't run API commands or proceed with
any tasks unless you change the default password at the first login.

What to do next

To verify the device onboarding process, proceed to Verify Onboarded Devices and Activate Devices, on
page 24.

Verify Onboarded Devices and Activate Devices

Step 1 Log in to Cisco vManage with admin credentials using the URL HTTPS: //vManage-ip-address/.
Step 2 Click Configuration > Devices.
From the list of devices, the CSP devices that have the serial number with the word token aren’t yet onboarded. To

authenticate these devices with the SD-WAN controllers, Cisco vManage provides a One-Time Password (OTP). The
OTP is autogenerated by Cisco vManage after adding the CSP device in the SD-WAN controller authorized device list.

Step 3 Under the Valid column, verify the validity of the installed certificate of all the listed CSP devices. See Failures with
Certificate installation, on page 149. Also, verify if root CA has been installed. See CSP hasn’t established connectivity
with vManage, on page 151.

Note For device onboarding using enterprise root-ca certificates, the CSP device receives the root certificates, along
with the Cisco vBond Orchestrator and organization name information from the PnP Connect portal.

Step 4 To activate the CSP device and associate the chassis number and the Serial No (one-time password) with the CSP device,
on the CLI of the CSP device, use the following command:

request activate chassissnumber chassis-number token token-number
For more information about the request device command, see request device.

Example:
request activate chassissnumber CSP-5444-serial-number token 70d43cfbdOb3b426da63dba2dd4f4ca9
Step 5 To bring up the remaining CSP devices, repeat Steps 1—4 for each of the CSP devices.
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Bring up Switch Devices

Step 1

Step 2

Step 3

This section describes about how Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switch devices are
brought up through the Day-0 configuration.

Before you begin
Ensure that you note the following before bringing up the switch devices:

* Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switch devices have both Network-Advantage
and DNA-Advantage licenses. To verify the available licenses on the switch devices, use the following
command:

Device# show license status

To know more about the license usage information, see the show license usage command.

* Either PNP redirect setup or manual PNP profile being set on the switch devices is required. For a PNP
redirect setup, add switches SN and Cisco Colo Manager IP address to PNP, and add entries of
devicehelper.cisco.com to OOB router of the network if the DHCP server is on OOB router. For example,

#conf t
#ip host devicehelper.cisco.com <OOB router of the network>

* Ensure that both switches are connected as per the SVL mode configuration.

Clean the switch configuration if they have been previously used.

a) Renumber switch, which is required for SVL stack mode.

Note Ensure that you do not touch the switches during SVL mode. Also, do not perform any action such as,
pressing enter or space, which can cause switches to complete SVL.

Use the show switch command to determine the switch number and whether the provisioned switch exists in the
switch stack. If the switch number is two, then use the sSwitch 2renumber 1 command, and then erase the configuration.

b) To erase the switch startup configuration and return it to its initial state, use the write erase command.

¢) To reload the switch with a new configuration, use the following commands in privileged EXEC mode and enter no
for not saving the modified configuration:

switch (config) #reload

Note You do not need to save the configuration.

d) Perform steps b and ¢ on the secondary switch device after the switch stack reloading has been completed. This action
ensures that the secondary switch device is reloaded twice.

After Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switch boots up, it gets an IP address from the local DHCP
server and initiates PNP discovery.

The DHCP server with option 43 enables Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switch to reach the
PNP server in Cisco Colo Manager.

The Cisco Colo Manager IP address is the PNP server IP address of a cluster on vManage. Ensure that DHCP server with
option 43 always point to the port, 9191.

Cisco SD-WAN Cloud OnRamp for Colocation Solution Guide, Release 20.8.1 [Jjj



. Bring up Switch Devices

Example:

Get Started with Cisco SD-WAN Cloud onRamp for Colocation Solution |

The following is an example of local PNP server for switches:

ip dhcp pool Cat9k
network 10.114.11.39 255.255.255.0

dns-server 172.31.232.182
default-router 172.31.232.182

option 43 ascii "5A;B2;K4;I110.114.11.40;J9191"

Where, 10.114.11.40 is the local PNP server or Cisco Colo Manager IP address.

The output after setting DHCP server with option 43 to port, 9191 is:

ip
ip
ip
ip
ip
ip
ip
ip
|

dhcp
dhcp
dhcp
dhcp
dhcp
dhcp
dhcp
dhcp

excluded-address
excluded-address
excluded-address
excluded-address
excluded-address
excluded-address
excluded-address
excluded-address

172
172
172
172
172
172
172
172

.31.
.31.
.31.
.31
.31
.31
.31
.31

232.182 172.31.232.185
233.182
232.254

.23.
.23
.23
.23
.23

10 172.31.23.49

.52 172.31.23.100
.252
.253
.230 172.31.23.250

Step 4 After the switches reach the PNP server on Cisco Colo Manager, it pushes the Day-0 configuration. The Day-0 configuration
push happens if a cluster is activated on vManage. If a cluster is not activated, the Cisco Catalyst 9500-40X or Cisco
Catalyst 9500-48Y4C switches reach the PNP server on Cisco Colo Manager every minute and stays in backoff mode.

After the switch devices are brought up, the SSH connection and NETCONF sessions on the switch devices
are enabled for Cisco Colo Manager to push Day-N configuration and ongoing switch management is continued.

Example

About Uplink Ports 36 and 37 in Prescriptive Connections

For prescriptive connections, ports 36 (input VLAN handoff) and 37 (output VLAN handoff) are
reserved for uplink ports.
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\)

Note The 1/0/36, 1/0/37 and 2/0/36, 2/0/37 switch ports are configured in "active" mode. If a user is not
using port channel and not connected to ports 36 and 37, the OOB switch ports that are connected
to Cisco Catalyst 9500-40X on ports 36 or 37 must be configured as "passive" mode.

For example,
« interface Port-channel1 switchport trunk allowed VLAN 100-106

example VLANs

switchport mode trunk
!

« interface TenGigabitEthernet1/0/1

port connected to cat9k 1/0/36 or 1/0/37
switchport mode trunk
channel-group 1 mode passive

spanning-tree portfast
|

« interface TenGigabitEthernet1/0/2

interface TenGigabitEthernetl1/0/2
switchport mode trunk
channel-group 1 mode passive

spanning-tree portfast
!

What to do next

To bring up another switch, repeat all the mentioned steps in sequence for the next switch.

Bring up Cisco Colo Manager

This section describes about how Cisco Colo Manager is brought up. The Cisco Colo Manager acts as a PNP
agent for the Catalyst 9K switches in a cluster. It takes care of the Day-0 configuration push to the Catalyst
9K switches and also relays the configuration from vManage to Catalyst 9K.

\)

Note During cluster activation process, Cisco Colo Manager is automatically brought up.

Step 1 All CSP devices in the cloud onramp for colocation establish a DTLS tunnel with vManage.

Step 2 vManage selects one CSP device by sending a NETCONF action API to bring up Cisco Colo Manager on that CSP
device.

Step 3 Cisco Colo Manager is in "Starting" state when it is brought up. Cisco Colo Manager can then move to "Healthy" or

"Unhealthy" state depending on the health check status.
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What to do next

After switch configuration and once colo manager is up, both switches reach the colo manager. Ensure that
you check the PNP list on Cisco Colo Manager to verify that both the switch devices have called home. See
Switch devices are not calling home to PNP or Cisco Colo Manager, on page 142.

\)

Note For activation to continue, both switches must call home.

Provision and Configure Cisco SD-WAN Cloud onRamp for
Colocation Solution

To order Cisco SD-WAN Cloud onRamp for Colocation PID, choose Cisco SD-WAN Cloud onRamp for
Colocation on Cisco Commerce Workspace (CCW).

Customer-specific order details such as, Smart Account name, Virtual Account name must be provided while
ordering.

To provision and configure the Cisco SD-WAN Cloud onRamp for Colocation solution, perform the following:

1. Ensure that Cloud Service Platform (CSP) devices and Cisco Catalyst 9500-40X or Cisco Catalyst
9500-48Y4C switches are cabled as per the prescribed or flexible connections, and powered on.

2. The Smart Account synchronizes customer-specific device order details with PNP Connect and
vOrchestrator.

Provision DHCP Server Per Colocation

To manage IP addresses of the physical devices such as switches, VNFs, and CSP devices, you must configure
a DHCP server per colocation. The Cisco Colo Manager IP address can be configured in DHCP option 43 for
Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C to reach Cisco Colo Manager.

vManage fixes and assigns Cisco Colo Manager IP addresses for a colocation. It manages and assigns IP
addresses of all VNFs through Day-0 configuration.

\)

Note The subnet for both physical (CSP devices, switches) and virtual appliances (Cisco Colo Manager, VNF)
must be same.

You can pick an appropriate subnet for a colocation and limit the pool for IP addresses depending on the
number of CSP devices and switches in a colocation. vManage picks the first IP address entered in the VNF
management IP pool in the vManage interface and configures it as the (Switch PNP Server IP) Cisco Colo
Manager IP address. The second and third IP addresses form the management pool are used for switch
management [P addresses. The Switch PNP Server | P field can be edited to provide an alternative IP address
if a different IP address is configured in the DHCP server for PNP of switches. The remaining IP addresses
from the vManage pool are assigned to the remaining VNFs in the colocation.
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Note Ensure that you set up a DNS server in each colocation.

Device Port Connectivity Details and Service Chaining for Prescriptive

Connections

In Cisco SD-WAN Cloud onRamp for Colocation solution deployments, the Cisco Catalyst 9500-40X switches
connected to CSP systems perform service chaining. If VMs support SR-IOV, Cisco Catalyst 9500-40X
switches perform service chaining, whereas VMs without SR-IOV support, service chaining is done by Open
Virtual Switch (OVS).

Virtual switch-based service chains are used for High Availability traffic and control traffic.

VLAN-based L2 service chaining from Cisco Catalyst 9500-40X switch is used for Cisco SD-WAN Cloud
onRamp for Colocation solution. In this service chaining, each virtual NIC interface of a VM in a service
chain is configured on the same access VLAN on a CSP virtual switch. The switch pushes the VLAN tag of
the packets entering and leaving the vNIC interface. The VNF can remain unaware of the next service in the
service chain. To forward traffic between the VNFs hosted either on the same CSP or across different CSP
devices in a cluster, the physical switch with the matching VLAN gets configured.

In Cisco SD-WAN Cloud onRamp for Colocation solution deployments, the deja-vu check is disabled on the
switch ports that are connected to the CSP devices for unicast traffic.

The following topology displays connectivity of the CSP ports to Cisco Catalyst 9500-40X switches and the
OOB switch.

Figure 5: Service Chain Connectivity with OVS, VEPA Enabled Switch Ports
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The following is the location of an interface in switches:
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Note The location of an interface is applicable once switches are in SVL mode after successful cluster activation.

SW-1#show platform

Switch Ports Model Serial No. MAC address Hw Ver.  Sw\Ver.
1 50 (C9500-40X FCW2219A1WP 848a.8da0.c200 V01 16.12.X
@ 50 C9500-40X FCW2219A1XH 848a.8da0.d000 VO1 16.12.X

Switch/Stack Mac Address : 848a.8da0.c200 - Local Mac Address

Mac persistency wait time: Indefinite

Switch numbr 1 Switch numb

: Interfaces — 1/0/1-1/0/40 Interfaces — 2/0/1-2/0/40

M FCW2219A1WP Vi FCW2219A1XH m

nEEmmmmmns = s

The following ports are VEPA disabled and configured with port channels:
* 1/0/1-1/0/16

* 2/0/1-2/0/16

The following ports are VEPA enabled and port channels configuration is disabled:
* 1/0/17-1/0/32

* 2/0/17-2/0/32

)

Note VEPA ports are only applicable to SRIOV interfaces.

The following ports are the WAN connectivity ports:

* 1/0/36, 2/0/36—Connect port 1/0/36 to receive outside traffic from branch/VPN connections (via an
OOB switch).

* 1/0/37, 2/0/37—Connect port 1/0/37 to forward service chain traffic to specific VLANSs that is mapped
to provider networks on an OOB switch.

You can connect the ports as follows:

* Data ports—Connect ports 1/0/1-1/0/35 to CSP devices. To achieve redundancy and HA across switches,
you can connect two ports to one CSP and the other two can be connected to next CSP. For example,
ports 1/0/1 and 2/0/1 is used for data and HA respectively can be connected to the first CSP, CSP #1.
Next, 1/0/2 and 2/0/2 is another port channel that is connected to the next CSP, CSP #2, and so on. Hence,
the OV ports consume all eight CSP devices.

* WAN connectivity ports—Connect port 1/0/36 on configured VLANY/s to receive outside traffic (Input
VLAN handoff). Connect port 1/0/37 to forward service chain traffic to specific VLANs that is mapped
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to provider networks (Output VLAN handoff). External input or output VLAN traffic can come from

branch or VPN connections and provider networks terminate at the Cloud OnRamp for Colocation through
the OOB switch. For each service chain configured in the cluster and input or output VLAN configured
for each service chain, the configuration on the ports, 36 and 37 occurs during service chain deployment.

If ports 36 or 37 are connected to the OOB switch and not using port channels, ensure that all VLAN
handoffs are configured either on input or output VLAN handoffs correspondingly. For example, if port
36 is connected, configure all VLAN handoff on input VLAN handoff for a service chain. If port 37 is
s connected, configure all VLAN handoff on output VLAN handoff for a service chain.

* Connect ports 1/0/38-1/0/40 in Stackwise Virtual Switch Link (SVL) configuration.

The following cabling image shows how the physical network functions are connected to the Cisco
Catalyst 9500-40X switches.

Figure 6: PNF Cabling Image
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The following table provides the ports available for PNF:

Table 8: Ports on Cisco Catalyst 9500-40X Switches for PNF

Number of CSP Devices | Number of PNFs Switch Ports available | Switch Ports available
for PNFs on First Switch | for PNFs on Second
Switch
7 1 1/0/15-1/0/16, 2/0/15-2/0/16,
1/0/31-1/0/32 2/0/31-2/0/32
6 2 1/0/13-1/0/16, 2/0/13-2/0/16,
1/0/29-1/0/32 2/0/29-2/0/32

Cisco SD-WAN Cloud OnRamp for Colocation Solution Guide, Release 20.8.1 [Jjj



. Validated Service Chains

Get Started with Cisco SD-WAN Cloud onRamp for Colocation Solution |

Number of CSP Devices | Number of PNFs Switch Ports available | Switch Ports available
for PNFs on First Switch | for PNFs on Second
Switch
4 4 1/0/11-1/0/16, 2/0/11-2/0/16,
1/0/27-1/0/32 2/0/27-2/0/32

To remove CSP devices and shuffle ports, perform the following steps:

1

If all eight CSP devices are connected to switches and if you want to connect a PNF device to the switches:

a. Deactivate or remove the eighth CSP (CSP connected to the right most data ports on switch) from the
cluster by using the RMA workflow on vManage.

b. Disconnect the CSP physical connections on Cisco Catalyst 9500-40X switches.

c. Connect the PNF device in place of the disconnected CSP.

If one of the first seven CSP devices must be removed to make additional ports available for PNF, perform

the following steps:

a. Perform the steps mentioned in 1.

b. Move the right most connected CSP that is the eighth CSP to the ports that are made available by the

removed CSP.

For example, if the first CSP is removed, move the eighth CSP to the position of the first CSP and

connect the PNF in place of the eighth CSP.

For the intial phase of Cisco SD-WAN Cloud onRamp for Colocation solution deployment, full chain VNF
configuration is supported. In a full chain configuration, all the VNFs for the producer and consumer chains
are part of a single service chain. The VNF's are not shared across different types of producers and consumers.
A separate instance of a service chain supports each combination of consumer and producer type. For a full
chain configuration, all the VNFs in a chain are L2 service chained.

Cisco vManage manages the Cisco SD-WAN Cloud onRamp for Colocation solution service chain
configuration. Cisco vManage assigns the VLANs from the VLAN pool that is provided for the colocation
to the individual VM VNICs and configures the switch with appropriate VLANs. The VNFs can remain
unaware about the service chain. Apart from the Day-0 VNF configuration, Cisco vManage does not configure

the individual VNFs that are part of the service chain. .

Validated Service Chains

In Cisco SD-WAN Cloud onRamp for Colocation solution deployments, the following are the four validated
service chains that you can deploy within a cluster from vManage. For all the validated service chains, each

VM can be instantiated in HA or standalone modes.

* Employee Remote VPN Access—In this service chain, there is a firewall, which can be in L3 VPN HA
or L3 VPN non-HA modes. The firewall VNFs can be ASAv, Palo Alto Networks Firewall,
Firepower Threat Defense Virtual (FTDv). Here, ASAv is in routed mode, no Day-0 configuration
support for the VPN connect, no BGP on consumer chain, and no VLANS.

Il Cisco SD-WAN Cloud OnRamp for Colocation Solution Guide, Release 20.8.1



| Get Started with Cisco SD-WAN Cloud onRamp for Colocation Solution
Validated Service Chains .

Figure 7: Employee Remote VPN Access Service Chain
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* Internet Edge (Outbound Internet, eCommerce, SaaS)—In this service chain, a firewall is followed with
a router. The firewall modes can be L3-VLAN HA and L3-VLAN non-HA. The routers can be in L3
HA and L3 non-HA modes. Here, ASAv is always in routed mode. One VLAN handoff is required and
inbound subinterfaces can be up to four. The termination can be in routed mode or in a trunk mode with
subinterfaces up to four. You can choose the hypervisor tagged VLANs versus VNF to do the VLAN
tagging. In VNF VLAN tagging, you can terminate to a minimum of 1 VLAN and maximum of 4 VLANS.
In hypervisor tagged VLANS, all VLANS are tagged in the same inbound VNF interface.

Figure 8: Internet Edge Service Chain
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* SD-WAN Access—In this service chain, vEdge is followed by a firewall, which is followed by a router.
The firewall modes can be L2 HA, L2 non-HA, L3 HA and L3 non-HA. The routers can be in L3 HA
and L3 non-HA modes.

Figure 9: SD-WAN Access Service Chain
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* Cloud Edge (Public Cloud Access)—In this service chain, firewall is followed by a router, where the
firewall is in routed mode. The firewall modes can be, L3 HA and L3 non-HA. The routers can be in L3
HA and L3 non-HA modes. This service chain is Internet Edge (Outbound Internet, eCommerce, SaaS)
with firewall mode being L3.
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Figure 10: Cloud Edge (Public Cloud Access) Service Chain
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See Create Service Chain in a Service Group, on page 65 topic about how you can choose the validated service
chains through vManage.

Validated VM Packages

VM packages are created as per use cases. These packages have recommended Day-0 configuration for each
supported use case. Any user can bring the required custom Day-0 configuration and package the VM as per
their requirement. In the validated packages, various Day-0 configurations are bundled into a single VM
package. For example, if a VM is a firewall VM, it can be used in transparent or routed mode if it is in the
middle of a service chain. If a VM is the first or last VM in a service chain, it can be a terminating tunnel to
a branch or provider, or routed traffic, or can terminate multiple branches, or a provider. Each use case is set
up as a special tag in image metadata for a user to make a selection at deployment or while provisioning a
service chain. If a VM is in the center of a service chain, vManage can automate the IP addresses and VLANs
for those segments. If VM is terminating to a branch or provider, user must configure the IP addresses, peer
addresses, autonomous system numbers, and others.

Customized Service Chains

Service chains are a named list of service-functions and associated endpoint-group through which packets
flow. You can customize service chains and create service chain templates. A service chain template is a chain
of VMs serving the intent of connecting the ingress traffic to the cloud. Service chain templates can have
predefined service chains containing validated VMs .

The first VNF and the last VNF in a customized service chain can be a router (or firewall). In SD-WAN case,
the first VM is a vEdge, which is orchestrated. In non-SD-WAN case, the first VM can be modeled as a
gateway router, which is not orchestrated.

You can choose a service chain template and modify the template by inserting one or more VMs and delete
one or more VMs. For each VM in the service chain, you can select the VM image that has been brought up
from the VM catalog. For example, if the first VM in the service chain is a ROUTER, you can select either
Cisco 1000v, or choose from VM repository, or any third-party router.
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CHAPTER 5

Configure Cisco SD-WAN Cloud onRamp for
Colocation Solution Devices Using Cisco
vManage

* Add Cloud OnRamp Colocation Devices Using Cisco vManage, on page 35
* Delete Cloud OnRamp for Colocation Devices from vManage, on page 37

» Manage Clusters in vManage, on page 37

* Manage Service Groups, on page 64

* Attach or Detach a Service Group in a Cluster, on page 88

* Day-N Configuration Workflow of Cisco SD-WAN Cloud onRamp for Colocation Solution, on page
88

Add Cloud OnRamp Colocation Devices Using Cisco vManage

Step 1
Step 2
Step 3
Step 4

You can add CSP devices, switch devices, and VNFs using Cisco vManage. When you order the Cisco
SD-WAN Cloud onRamp for Colocation solution product identifier (PID), the device information is available
from the smart account that can be accessed by Cisco vManage.

Before you begin

Ensure that the setup details are as follows:

* Cisco SD-WAN setup details such as, Cisco vManage [P address and credentials, Cisco vBond IP address
and credentials

* NFVIS setup details such as, Cisco CSP device CIMC IP address and credentials or UCSC CIMC IP
address and credentials

* Able to access both the switch consoles

From the Cisco vManage menu, choose Tools> SSH Terminal to start an SSH session with Cisco vManage.
Choose a CSP device or a switch device.

Enter the username and password for the CSP device or switch device, and click Enter.

Get the PID and serial number (SN) of a CSP device.
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The following sample output shows the PID for one of the CSP devices.

CSP# show pl

platform-detail hardware info Manufacturer "Cisco Systems Inc"
platform-detail hardware info PID CSP-5444

platform-detail hardware info SN WZP224208MB

platform-detail hardware info hardware-version 74-105773-01
platform-detail hardware info UUID da39edec-d831-e549-b663-%9e407afd5ac6
platform-detail hardware info Version 4.6.0-15

The output shows both the CSP device PID and serial number.

Step 5 Get the serial number of both the Catalyst 9500 switch devices.
The following sample shows the serial number of the first switch.

Switchl# show version

Cisco I0S XE Software, Version 17.03.03

Cisco IOS Software [Amsterdam], Catalyst L3 Switch Software (CAT9K IOSXE), Version 17.3.3, RELEASE
SOFTWARE (fc2)

Technical Support: http://www.cisco.com/techsupport

Copyright (c) 1986-2021 by Cisco Systems, Inc.

Compiled Fri 26-Feb-21 02:01 by mcpre

Technology Package License Information:

Technology-package Technology-package
Current Type Next reboot
network-advantage Smart License network-advantage
dna-advantage Subscription Smart License dna-advantage

AIR License Level: AIR DNA Advantage
Next reload AIR license Level: AIR DNA Advantage

Smart Licensing Status: Registration Not Applicable/Not Applicable

cisco C9500-40X (X86) processor with 1331521K/6147K bytes of memory.
Processor board ID FCW2229A0RK

1 Virtual Ethernet interface

96 Ten Gigabit Ethernet interfaces

4 Forty Gigabit Ethernet interfaces

2048K bytes of non-volatile configuration memory.
16777216K bytes of physical memory.

1638400K bytes of Crash Files at crashinfo:.
1638400K bytes of Crash Files at crashinfo-1:.
11264000K bytes of Flash at flash:.

11264000K bytes of Flash at flash-1:.

Base Ethernet MAC Address : 00:aa:6e:£3:02:00
Motherboard Assembly Number : 73-18140-03
Motherboard Serial Number : FOC22270RF8

Model Revision Number : DO

Motherboard Revision Number : BO

Model Number : C9500-40X

System Serial Number : FCW2229A0RK

CLEI Code Number

From this output, you can know the Catalyst 9500 switch series and the serial number.

Step 6 Create a .CSV file with the PID and serial number records for all the CSP devices and Catalyst 9500 switches in a
colocation cluster.

For example, from the information available from Steps 4,5, the CSV-formatted file can be as follows:
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Step 7

Delete Cloud OnRamp for Colocation Devices from viManage .

C9500-40,FCW2229A0RK CSP-5444,SN WZP224208MB

Note You can create a single .CSV file for all devices in a colocation cluster.

Upload all the CSP and switch devices using Cisco vManage. For more information, see Uploading a device authorized
serial number file.

After upload, you can see all the CSP and switch devices listed in the table of devices.

Delete Cloud OnRamp for Colocation Devices from vManage

Step 1
Step 2
Step 3
Step 4
Step 5

To delete the CSP devices from vManage, perform the following steps:

Before you begin
Ensure that you consider the following:

* [f any service chains are attached to a device that is deleted, detach service groups. See Attach or Detach
a Service Group in a Cluster, on page 88.

» Ifa CSP device that is being deleted is hosting Cisco Colo Manager, see Recovery of Cisco Colo Manager,
on page 129.

From the Cisco vManage menu, choose Configuration > Certificates.

For the desired device, click ... and choose Invalid.

In the Configuration > Certificates window, click Send to Controller.

In the Configuration > Devices window, for the desired device, click ... and choose Delete WAN Edge.
Click OK to confirm the deletion of the device.

Deleting a device removes the serial and chassis numbers from the WAN edge router serial number list,
and also permanently removes the configuration from Cisco vManage.

Manage Clusters in vManage

Use the Cloud onRamp for Colocation screen to configure a colocation cluster and service groups that can be
used with the cluster.

The three steps to configure are:

* Create a cluster. See Create and Activate Clusters, on page 39.
* Create a service group. See Create Service Chain in a Service Group, on page 65.

« Attach a cluster with a service group. See Attach or Detach a Service Group in a Cluster, on page 88.

A colocation cluster is a collection of two to eight CSP devices and two switches. The supported cluster
templates are:
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* Small cluster—2 Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C+2 CSP
* Medium Cluster—2 Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C+4 CSP
* Large Cluster—2 Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C+6 CSP
*» X-Large Cluster—2 Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C+8 CSP

\}

Note Ensure that you add a minimum of two CSP devices one-by-one to a cluster. You can keep adding three, four,
and so on, up to a maximum of eight CSP devices. You can edit a Day-N configuration of any cluster, and
add pairs of CSP devices to each site up to a maximum of eight CSP devices.

Ensure that all devices that you bring into a cluster have the same software version.

\)

Note You can’t use the CSP-5444 and CSP-5456 devices in the same cluster.

Following are the cluster states:

* Incomplete—When a cluster is created from the vManage interface without providing the minimum
requirement of two CSP devices and two switches. Also, cluster activation is not yet triggered.

* Inactive—When a cluster is created from the vManage interface after providing the minimum requirement
of two CSP devices and two Switches, and cluster activation is not yet triggered.

* Init—When the cluster activation is triggered from the vManage interface and Day-0 configuration push
to the end devices is pending.

* Inprogress—When one of the CSP devices within a cluster comes up with control connections, the cluster
moves to this state.

* Pending—When the Day-0 configuration push is pending or VNF install is pending.
» Active—When a cluster is activated successfully and NCS has pushed the configuration to the end device.

* Failure—If Cisco Colo Manager has not been brought up or if any of the CSP devices that failed to
receive an UP event.

A cluster transitioning to an active state or failure state is as follows:
* Inactive> Init > Inprogress> Pending > Active—Success
* Inactive > I nit > Inprogress > Pending > Failure—Failure
During a cluster creation, cluster clearing, and cluster deletion, ensure that you clean the configurations of

both switches. See Troubleshoot Catalyst 9500 Issues, on page 142 for more information about cleaning switch
configuration that has been used previously.

Provision and Configure Cluster

This topic describes about activating a cluster that enables deployment of service chains.

To provision and configure a cluster, perform the following:
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Create and Activate Clusters .

1. Create a colocation cluster by adding two to eight CSP devices and two switches.

CSP devices can be added to a cluster and configured using Cisco vManage before bringing them up. You
can configure CSP devices and Catalyst 9K switches with the global features such as, AAA, default user
(admin) password, NTP, syslog, and more.

2. Configure colocation cluster parameters including IP address pool input such as, service chain VLAN
pool, VNF management IP address pool, management gateway, VNF data plane IP pool, and system IP
address pool.

3. Configure a service group.

A service group consists of one or more service chains.

)

Note

You can add a service chain by selecting one of the predefined or validated service chain template, or
a custom one. For each service chain, configure input and output VLAN handoff and service chain throu
or bandwidth, as mentioned. The service chain is configured in Mbps, and you can assign as high as 10
and as low as 10 M. The default service chain bandwidth is 10 Mbps. See the Sizing Requirements of
SD-WAN Cloud onRamp for Colocation Solution Devices topic.

4. Configure each service chain by selecting each VNF from the service template. Choose a VNF image that
is already uploaded to the VNF repository to bring up the VM along with required resources (CPU,
memory, and disk). Provide the following information for each VNF in a service chain:

* The specific VM instance behavior such as, HA, shared VM can be shared across service chains.

* Day-0 configuration values for tokenized keys and not part of the VLAN pool, management IP
address, or data HA IP address. The first and last VMs handoff-related information such as peering
IP and autonomous system values must be provided. The internal parameters of a service chain are
automatically updated by Cisco vBond Orchestrator from the VLAN, or Management, or Data Plane
IP address pool provided.

5. Add the required number of service chains for each service group and create the required number of
service groups for a cluster.

6. To attach a cluster to a site or location, activate the cluster after all configuration is complete.

You can watch the cluster status change from In progress to active or error in the Task View window.

To edit a cluster:

1. Modify the activated cluster by adding or deleting service groups or service chains.

2. Modify the global features configuration such as, AAA, system setting, and more.

You can predesign a service group and service chain before creating a cluster. You can then attach the service
group with a cluster after the cluster is active.

Create and Activate Clusters

This topic provides the steps on how you can form a cluster with CSP devices, Cisco Catalyst switches as a
single unit, and provision the cluster with cluster-specific configuration.
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Before you begin

* Ensure that you synchronize the clocks for Cisco vManage and CSP devices. To synchronize a clock for
CSP devices, configure the NTP server for CSP devices when you enter information about cluster settings.

* Ensure that you configure the NTP server for Cisco vManage and Cisco vBond Orchestrator. To configure
the NTP server, see the Cisco SD-WAN System and Interface Configuration Guide.

* Ensure that you configure the OTP for the CSP devices to bring up the CSP devices.

* Ensure that you power on both the Catalyst 9500 switches and ensure that they are operational.

Step 1 From the Cisco vManage menu, choose Cisco vManage, click Configuration > Cloud OnRamp for Colocation.
a) Click Configure & Provision Cluster.
b) Provide the following information:

Table 9: Cluster Information

Field Description

Cluster Name The cluster name can contain 128 alphanumeric
characters.

Description The description can contain 2048 alphanumeric characters.

SiteID The overlay network site identifier. Ensure that the value

you enter for Site ID is similar to the organizations Site
ID structure for the other Cisco SD-WAN overlay

elements.
L ocation The location can contain 128 alphanumeric characters.
Cluster Type To configure a cluster in a multitenant mode so that it can

be shared across multiple tenants, choose Shared.

Note In the single-tenant mode, the cluster type Non
Shared is selected by default.

¢) To configure switches, click a switch icon in the Switchesbox. In the Edit Switch dialog box, enter a switch name
and choose the switch serial number from the drop-down list. Click Save.

The switch name can contain128 alphanumeric characters.

The switch serial numbers that you view in the drop-down list are obtained and integrated with Cisco vManage using
the PnP process. These serial numbers are assigned to switches when you order Cisco SD-WAN Cloud onRamp for
Colocation solution PID on the CCW and procure the switch devices.

Note You can keep the serial number field blank for switch devices and CSP devices, design your colocation
cluster, and then edit the cluster later to add the serial number after you procure the devices. However, you
can’t activate a cluster with the CSP devices or switch devices without the serial numbers.

d) To configure another switch, repeat Step c.
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Step 2

e)

f)

2)
h)

)
)

k)

Cluster Configuration .

To configure CSP devices, click a CSP icon in the Appliances box. The Edit CSP dialog box is displayed. Provide
a CSP device name and choose the CSP serial number from the drop-down list. Click Save.

The CSP device name can contain 128 alphanumeric characters.

Configure OTP for the CSP devices to bring up the devices.
To add remaining CSP devices, repeat Step e.

Click Save.

After you create a cluster, on the cluster configuration window, an ellipsis enclosed in a yellow circle appears next
to a device where the serial number isn't assigned for the device. You can edit a device to enter the serial numbers.
To edit a CSP device configuration, click a CSP icon, and perform the process mentioned in substep e.

To set the mandatory and optional global parameters for a cluster, on the cluster configuration page, enter the parameters
for Cluster Configuration. See Cluster Configuration, on page 41.

Click Save.

You can view the cluster that you created in a table on the cluster configuration page.

To activate a cluster,

a)
b)

Click a cluster from the cluster table.
For the desired cluster, click ... and choose Activate.

When you activate the cluster, Cisco vManage establishes a DTLS tunnel with the CSP devices in the cluster,
where it connects with the switches through Cisco Colo Manager. When the DTLS tunnel connection is
running, a CSP device in the cluster is chosen to host the Cisco Colo Manager. Cisco Colo Manager starts up
and Cisco vManage sends global parameter configurations to the CSP devices and Cisco Catalyst 9500
switches. For information about cluster activation progress, see Progress of Cluster Activation, on page 50.

)

Note In Cisco vManage Release 20.7.x and earlier releases, the Cisco Colo Manager (CCM) and CSP device

configuration tasks time out 30 minutes after the tasks are created. In the case of long-running image installation
operations, these configuration tasks may time out and fail, while the cluster activation state continues to be

in a pending state.

From Cisco vManage Release 20.8.1, the CCM and CSP device configuration tasks time out 30 minutes after

the last heartbeat status message that Cisco vManage received from the target devices. With this change,

long-running image installation operations do not cause configuration tasks to fail after a predefined interval

of time after task creation.

Cluster Configuration

The cluster configuration parameters are:

Login Credentials

1. On the Cluster Topology window, click Add next to Credentials. In the Credentials configuration
window, enter the following:

* (Mandatory) Template Name—The template name can contain 128 alphanumeric characters.

* (Optional) Description—The description can contain 2048 alphanumeric characters.
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Resource Pool
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Click New User.
« In the Name field, enter the username.
* In the Passwor d field, enter the password and confirm the password in the Confirm Password field.

* In the Role drop-down list, select administrators.

Click Add.

The new user with username, password, and role with action appears.
Click Save.

The login credentials for the new user are added.
To cancel the configuration, click Cancel.

To edit the existing credential for the user, click Edit and save the configuration.

On the Cluster Topology window, click Add next to Resour ce Pool. In the Resour ce Pool configuration
window, enter values for the following fields:

* Name—The name of the IP address pool should contain 128 alphanumeric characters.
* Description—The description can contain 2048 alphanumeric characters.
In the DTL S Tunnel | P field, enter the IP addresses to be used for the DTLS tunnel. To enter multiple

IP addresses, separate them by commas. To enter a range, separate the IP addresses with a hyphen (for
example, 172.16.0.180-172.16.255.190).

In the Service Chain VLAN Pool field, enter the VLAN numbers to be used for service chains. To enter
multiple numbers, separate them by commas. To enter a numeric range, separate the numbers with a
hyphen (for example, 1021-2021).

Consider the following points when entering the VLAN information:

1002-1005 are the reserved VLAN values, and they shouldn’t be used in the cluster creation VLAN pool.

N

Note Valid VNF VLAN pool: 1010-2000 and 1003-2000
Invalid: 1002-1005 (shouldn’t be used)

A

Caution  1002-1005 isn't allowed for configuration. The VLANS tht are allowed should be contiguous.

Example: Enter data VLAN pool as 1006-2006. Ensure that this VL AN range isn’t used in the Input/Output
VLAN during service chain creations.

In the VNF Data Plane | P Pool field, enter the IP addresses to be used for auto configuring data plane
on a VNF interface. To enter multiple IP addresses, separate them by commas. To enter a range, separate
the IP addresses with a hyphen (for example, 10.0.0.1-10.0.0.100).
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5. Inthe VNF Management | P Pool field, enter the IP addresses to be used for the VNF. To enter multiple
IP addresses, separate them by commas. To enter a range, separate the IP addresses with a hyphen (for
example, 192.168.30.99-192.168.30.150).

A\

Note These addresses are IP addresses for secure interfaces.

6. Inthe Management Subnet Gateway field, enter the IP address of the gateway to the management
network. It enables DNS to exit the cluster.

7. Inthe Management Mask field, enter the mask value for the failover cluster. For example, /24 and not
255.255.255.0

8. In the Switch PNP Server |P field, enter the IP address of the switch device.

N

Note The IP address of the switch is automatically fetched from the management pool, which is the first IP ad
You can change it if a different IP address is configured in the DHCP server for the switch.

9. Click Save.

Port Connectivity

Table 10: Feature History

Feature Name |Release Description
Information

Support for SVL | Cisco IOS XE | With this feature, you can configure SVL ports on 100-G Ethernet
Port Release 17.8.1a |interfaces of Cisco Catalyst 9500-48Y4C switches, thus ensuring a high
Configuration on level of performance and throughput.

100G Interfaces Cisco vManage

Release 20.8.1

Cisco NFVIS
Release 4.8.1

Prerequisites for Configuring SVL and Uplink Ports

* When configuring the SVL and uplink ports, ensure that the port numbers you configure on Cisco
vManage match the physically cabled ports.

* Ensure that you assign serial numbers to both the switches. See Create and Activate Clusters.

Configure SVL and Uplink Ports
* On the Cluster Topology window, click Add next to Port Connectivity.

In the Port Connectivity configuration window, both the configured switches appear. Hover over a
switch port to view the port number and the port type.
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Change Default SVL and Uplink Ports

Before you change the default port number and port type, note the following information about Cisco Catalyst
9500-40X and Cisco Catalyst 9500-48Y4C switches:

» From Cisco vManage Release 20.8.1, you can configure two SVL ports and one Dual-Active Detection
(DAD) port when creating a colocation cluster with two Cisco Catalyst 9500-40X switches or two Cisco
Catalyst 9500-48Y4C switches.

* To ensure that SVL and DAD ports are configured correctly for Cisco Catalyst 9500-48Y4C switches,
note the following information:

* Configure the SVL ports on same-speed interfaces, that is, either 25-G interfaces or 100-G interfaces.
Ensure that both switches have the same configuration.

* Configure the DAD port only on 25-G interfaces on both switches.
* In case of an existing cluster, you can change the SVL ports only if it is inactive.
* A cluster created in releases earlier than Cisco vManage Release 20.8.1 automatically displays two

SVL ports and one DAD port after the upgrade to Cisco vManage Release 20.8.1.

* In case of Cisco Catalyst 9500-40X switches, you must configure the SVL and DAD ports on 10-G
interfaces on both switches.

* The following are the default SVL, DAD, and uplink ports of Cisco Catalyst 9500 switches:
Cisco Catalyst 9500-40X
* SVL ports: Tel/0/38-Te1/0/39, and Te2/0/38-Te2/0/39

In Cisco vManage Release 20.7.x and earlier releases, the default SVL ports are Tel/0/38-Tel/0/40
and Te2/0/38-Te2/0/40.

* DAD ports: Tel/0/40 and Te2/0/40

* Uplink ports: Tel/0/36, Te2/0/36 (input VLAN handoff), Te1/0/37, and Te2/0/37 (output VLAN
handoff)

Cisco Catalyst 9500-48Y4C
* SVL ports: Hul/0/49-Hu1/0/50 and Hu2/0/49-Hu2/0/50

In Cisco vManage Release 20.7.x and earlier releases, the default SVL ports are Twel/0/46-Twe1/0/48
and Twe2/0/46-Twe2/0/48.

* DAD ports: Twel/0/48 and Twe2/0/48

* Uplink ports: Twel/0/44, Twe2/0/44 (input VLAN handoff), Twel/0/45, and Twe2/0/45 (output
VLAN handoff) for 25-G throughput.

* [, E, and S represent the ingress, egress, and SVL ports, respectively.

* Ensure that the physical cabling is the same as the default configuration, and click Save.

To change the default ports when the connectivity is different for SVL and uplink ports, perform the following:
1. If both the switches are using the same ports:

a. Click a port on a switch that corresponds to a physically connected port.
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NTP

ne i

b. To add the port configuration to the other switch, check the Apply change check box.

If both the switches aren’t using the same ports:
a. Click a port on Switchl.
b. Choose a port type from the Port Type drop-down list.

c. Click a port on Switch2 and then choose the port type.

2. To add another port, repeat step 1.
3. Click Save.

4. To edit port connectivity information, in the Cluster Topology window, click Edit next to Port
Connectivity.

N

Note  You can modify the SVL and uplink ports of a cluster when the cluster hasn’t been activated.

5. To reset the ports to default settings, click Reset.

The remaining ports (SR-IOV and OVS) on the Cisco CSP devices and the connections with switches are
automatically discovered using Link Layer Discovery Protocol (LLDP) when you activate a cluster. You don't
need to configure those ports.

Cisco Colo Manager (CCM) discovers switch neighbor ports and identifies whether all Niantic and Fortville
ports are connected. If any port isn’t connected, CCM sends notifications to Cisco vManage that you can view
in the task view window.

Optionally, configure the NTP server for the cluster:

1. On the Cluster Topology window, click Add next to NTP. In the NTP configuration window, enter the
following:

» Template Name—Name of the NTP template should be in alphanumeric characters and the name
should contain upto 128 characters.

* Description—The description should be in alphanumeric characters and can be upto 2048 characters.

2. Inthe Preferred server field, enter the IP address of the primary NTP server.
3. Inthe Backup server field, enter the IP address of the secondary NTP server.

4. Click Save.
The NTP servers are added.

5. To cancel the NTP server configuration, click Cancel.

6. To edit the NTP server configuration details, click Edit.
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Syslog Server
Optionally, configure the syslog parameters for the cluster:
1. On the Cluster Topology window, click Add next to Syslog. In the Syslog configuration window, enter
the following:
» Template Name—Name of the system template should be in alphanumeric characters and the name
can contian upto 128 characters.
* Description—The description can be up to 2048 characters and can contain only alphanumeric
characters.
2. In the Severity drop-down list, choose the severity of syslog messages to be logged.
3. To add a new syslog server, click New Server.
Type the IP address of a syslog server.
4. Click Save.
5. To cancel the configuration, click Cancel.
6. To edit the existing syslog server configuration, click Edit and save the configuration.
TACACS Authentication

Table 11: Feature History

Feature Name |Release Description
Information

TACACS Cisco SD-WAN | This feature allows you to configure the TACACS authentication for
Authentication |Release 20.3.1 |users accessing the Cisco CSP and Cisco Catalyst 9500 devices.
Authenticating the users using TACACS validates and secures their

Cisco vManage access to the Cisco CSP and Cisco Catalyst 9500 devices.

Release 20.3.1

The TACACS authentication determines the valid users who can access the Cisco CSP and Cisco Catalyst
9500 devices after a cluster is active.

Pointsto consider

* By default, the admin users with Role-based access control (RBAC) are authorized to access the Cisco
CSP and Cisco Catalyst 9500 devices.

* Do not configure the same user with different passwords when configuring using TACACS and RBAC.
If same user with a different password is configured on TACACS and RBAC, the RBAC user and
password authentication is used. For information about how to configure RBAC on the devices, see
Login Credentials, on page 41.

To authenticate users:

1. To add TACACS server configuration, on the Cluster Topology window, click Other Settings> Add
next to TACACS.
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To edit TACACS server configuration, in the Cluster Topology window, click Other Settings> Edit
next to TACACS.

In the TACACS configuration window, enter information about the following:

» Template Name—The TACACS template name can contain 128 alphanumeric characters.

* (Optional) Description—The description can contain 2048 alphanumeric characters.

2. To add a new TACACS server, click + New TACACS SERVER.
* In Server |P Address, enter the IPv4 address.
Use IPv4 addresses for hostnames of TACACS server.

* In Secret enter the password and confirm the password in Confirm Secret.

3. Click Add
The new TACACS server details are listed in the TACACS configuration window.

N

Note You can add a maximum of four TACACS servers.

4. To add another TACACS server, repeat step 2 to step 3.

When authenticating users, if the first TACACS server is not reachable, the next server is verified until
all the four servers are verified.

5. Click Save.

6. To delete a TACACS server configuration, choose a row from the TACACS server details list and click
Delete under Action.

N

Note To modify an existing TACACS server information, ensure to delete a TACACS server and then add a
server.

7. To view the TACACS server configuration, in Cisco vManage, click Configuration > Devices.

For the desired Cisco CSP device or Cisco Catalyst 9500 switch, click ... and choose Running
Configuration.

Backup Server Settings
Pointsto Consider

* If you don't use an NFS server, Cisco vManage can’t successfully create backup copies of a CSP device
for future RMA requirements.

» The NFS server mount location and configurations are same for all the CSP devices in a cluster.

* Don't consider an existing device in a cluster as the replacement CSP device.
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A\

Note Ifareplacement CSP device isn’t available, wait until the device appears in Cisco
vManage.

* Don't attach further service chains to a cluster after you identify that a CSP device in the cluster is faulty.

* The backup operation on a CSP device creates backup files containing NFVIS configuration and VMs
(if VMs are provisioned on the CSP device). You can use the following information for reference.

* An automated backup file is generated and is in the format:
serial number +" "+ time stamp + ".bkup"
For example,
WZP22180EW2 2020 06 _24T18 07 00.bkup

* An internal state model is maintained that specifies the status of the overall backup operation and
internal states of each backup component:

* NFVIS: A configuration backup of the CSP device as an xml file, config.xml.

* VM_Images: All VNF tar.gz packages in data/intdatastore/uploads which are listed
individually.

* VM_Images Flavors: The VM images such as, img_flvr.img.bkup.
* Individual tar backups of the VNFs: The files such as, vmbkp.

* The backup.manifest file contains information of files in the backup package and their checksum
for verification during restore operation.

To create backup copies of all CSP devices in a cluster, perform the following steps:

1. On the Cluster Topology window, click Add next to Backup.

To edit backup server settings, on the Cluster Topology window, click Edit next to Backup
In the Backup configuration window, enter information about the following fields:

* Mount Name—Enter the name of the NFS mount after mounting an NFS location.

* Storage Space—Enter the disk space in GB.

* Server IP: Enter the IP address of the NFS server.

* Server Path: Enter the folder path of the NFS server such as, /data/colobackup
* Backup: Click Backup to enable it.

* Time: Set a time for scheduling the backup operation.

* Interval: Choose from the options to schedule a periodic backup process.

* Daily: The first backup is created a day after the backup configuration is saved on the device,
and everyday thereafter.

» Weekly: The first backup is created seven days after the backup configuration is saved on the
device, and every week thereafter.
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* Once: The backup copy is created on a chosen day and it's valid for the entire lifetime of a
cluster. You can choose a future calendar date.

2. Click Save.

3. To view the status of the previous five backup operations, use the show hostaction backup status
command. To know about the backup status configuration command, see Backup and Restore NFVIS
and VM Configurations. To use this command:

a. In Cisco vManage, click the Tools> SSH Terminal screen to start an SSH session with Cisco
vManage.

b. Choose the CSP device.

C. Enter the username and password for the CSP device and click Enter to log in to the CSP device and
run the show hostaction backup status command.

Restore CSP Device
You can perform the restore operation only by using the CLI on the CSP device that you're restoring.
1. Use the mount nfs-mount storage command to mount NFS:

For more information, see Network File System Support.

N

Note To access the backup file, the configuration for mounting an NFS file system should match the faulty d
You can view this information from other healthy CSP devices as the NFS mount location and configur
are same for all the CSP devices. To view and capture the information, you can do one of the followin,

* In the Cluster Topology window, click Add next to Backup.

* Use the show running-config command to view the active configuration that is running on a CSP d
See Prerequisites and Restrictions for Backup and Restore of CSP Devices.

mount nfs-mount storage { mount-name | server_ip server_ip | server_path server_path |
storage space total_gb storage space total_gb | storage type storage type }

Forexanuﬂe,mount nfs-mount storage nfsfs/ server ip 172.19.199.199 server path
/data/colobackup/ storage space total gb 100.0 storagetype nfs

2. Restore the backup information on a replacement CSP device using the hostaction restore command:
For example,

hostaction restore except-connectivity file-path
nfs:nfsfs/WZP22180EW2_ 2020 06 24T18 07 00.bkup

A

Note  Specify the except-connectivity parameter to retain the connectivity with the NFS server mounted in S

3. Use the show hostaction backup status command to view the status of the previous five backup images
and their operational status.
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. Progress of Cluster Activation

Also, you can view the backup images from the notifications available on the Cisco vManage Monitor >
L ogs> Eventspage.

A\

Note In Cisco vManage Release 20.6.x and earlier releases, you can view the backup images from the notificatio
available on the Cisco vManage Monitor > Events page.

Use the show hostaction restore-status command on the CSP device to view the status of the overall
restore process and each component such as system, image and flavors, VM and so on.

To fix any failure after viewing the status, perform a factory default reset of the device.

A\

Note The factory default reset sets the device to default configuration. Therefore, before performing the restore
operation from Steps 1-4 on the replacement device, verify that all the restore operation prerequisites are m
See Prerequisites and Restrictions for Backup and Restore of CSP Devices, on page 59.

To know more about how to configure the restore operation on CSP devices, see Backup and Restore NFVIS
and VM Configurations.

Progress of Cluster Activation

Table 12: Feature History

Feature Name |Release Description

Information

Monitor Cluster |Cisco SD-WAN | This feature displays the cluster activation progress at each step and
Activation Release 20.1.1 | shows any failures that may occur during the process. The process of
Progress activating a cluster takes approximately 30 minutes or longer, and you

can monitor the progress using the vManage task view window and
events from the Monitoring page.

To check cluster activation status after activating a cluster, view the progress on the task view window:

\}

Note

In Cisco vManage Release 20.7.x and earlier releases, Cisco Colo Manager (CCM) bring up and activation
progress is reported as part of the CLOUD ONRAMP CCM task. This task shows the seven steps in the CCM
bring up and activation sequence and indicates whether the sequence was successfully completed or not. The
Push Feature Template Configuration task shows the status of the RBAC settings configuration push.

From Cisco vManage Release 20.8.1, CLOUD ONRAMP CCM task is completed when Cisco vManage
receives CCM Healthy from the target CSP device. The Push Feature Template Configuration task shows the
seven steps in the CCM bring up and activation sequence and indicates whether the sequence was successfully
completed or not, along with the status of the RBAC settings configuration push.
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Progress of Cluster Activation .

Figure 11: Cluster Activation (Cisco vManage Release 20.7.x and earlier)

©Success 192.168.168.241 CCM Bring up and Activation 19 Feb 2020 4:53:37 PM PST

[19-Feb-2020 16:53:38 PST] CCM : 192.168.168.241 bring up is In-Progress
[19-Feb-2020 16:53:41 PST] Successfully received notification with CCM_STARTING State. Will wait for Healthy notification before sending device list
[19-Feb-2020 16:54:47 PST] Successfully received notification with CCM_HEALTHY State. Will stop listening to notification

[19-Feb-2020 16:54:47 PST] CCM : 192.168.168.241 bring up succeeded on CSP : 209.165.201.17

[19-Feb-2020 16:56:57 PST] CCM : 192.168.168.241 activation is In-Progress

[19-Feb-2020 16:56:58 PST] Successfully received notification with INPROGRESS State from 209.165.201.17

[19-Feb-2020 16:57:09 PST] Successfully received notification with INPROGRESS State from 209.165.201.17

520409

[19-Feb-2020 16:57:09 PST] Successfully received notification with INPROGRESS State from 209.165.201.17
[19-Feb-2020 16:57:35 PST] Successfully received notification with INPROGRESS State from 209.165.201.17
[19-Feb-2028 16:58:10 PST] Successfully received notification with INPROGRESS State from 209.165.201.17
[19-Feb-2020 17:00:10 PST] Successfully received notification with INPROGRESS State from 209.165.201.17
[19-Feb-2020 17:00:15 PST] Successfully received notification with INPROGRESS State from 209.165.201.17
[19-Feb-2020 17:00:15 PST] Successfully received notification with SUCCESS State from 209.165.201.17
[19-Feb-2020 17:00:31 PST] CCM : 192.168.168.241 activation process succeeded

520410

Figure 12: CLOUD ONRAMP CCM Task (Cisco vManage Release 20.8.1 and later)

Status. Chassis Number Message Start Time System 1P

@ success 192.168.65.174 CCM Bring up and Activation 20 Apr 2022 2:22:56 PMPDT  192.168.65.174

[20-Apr-2022 21:22:56 UTC] CCM : 192.168.65.174 bring up is In-Progress
[20-Apr-2022 21:23:10 UTC] Successfully received notification with CCH_STARTING State. Will wait for Healthy notification before sending device list
[20-Apr-2022 21:24:17 UTC] Successfully received notification with CCH_HEALTHY State. Will stop listening to notification

[20-Apr-2022 21:24:18 UTC] CCM : 192.168.65.174 bring up succeeded on CSP : 172.26.255.234

[20-Apr-2022 21:24:18 UTC] Post CCM 192.168.65.174 bring up, COM Activation is in progress with PULL config

Figure 13: Push Feature Template Configuration Task (Cisco vManage Release 20.8.1 and later)

Status Message Chassis Number Device Model Hostname System 1P Site ID VManage IP
@ Success Template successfully attache...  com-nExpress_cluster coM cem-nExpress_cluster 172.16.255.201 -- 172.16.255.22

[2-Apr-2022 3:24:47 UTC] Device: Step 6 of 7: Both switch interfaces are up
[2-Apr-2022 3:25:01 UTC] Device: Devices onboard successfully for tenant®, state: Step 7 of 7: Devices done onboarding Device list : switchl : 10.0.5.152 (C9500-48Y-CAT2324L269), switch? : 10.0.5.151 (C9500-48Y-CAT2324L2H3)
[2-Apr-2022 3:25:01 UTC] Device: After devices onboard successfully, CCM will apply remaining cluster settings.

[2-Apr-2022 3:25:01 UTC] Device: Loading config in CCM

[2-Apr-2022 : Received configuration from vManage

[2-Apr-2022 3:25: : Successfully loaded config for tenantd

[2-Apr-2022 3:25:27 UTC] Template successfully attached to device

Perform the following verification steps:

1. To view cluster state and change the state:

a. From the Cisco vManage menu, choose Configuration > Cloud onRamp for Colocation. For the
cluster that is goes into a "PENDING" state, click ..., and choose Sync. This action moves a cluster
back to an "ACTIVE" state.

b. To view if a cluster moves back to an "ACTIVE" state, you can view the successful activation for the
cluster.

2. To view the service groups present on CSP devices, from the Cisco vManage menu, choose Monitor >

Devices> Colocation Cluster.

Cisco vManage Release 20.6.x and earlier: To view the service groups present on CSP devices, from the
Cisco vManage menu, choose Monitor > Network > Colocation Clusters.

Choose a cluster and then choose a CSP device. You can choose and view other CSP devices.

3. To check if cluster is activated from a CSP device:

a. From the Cisco vManage menu, choose Configuration > Devices.

b. View device status of all the CSP devices and ensure that they are in synchronization with Cisco
vManage.

C. View the state of CSP devices and verify that the certificates are installed for CSP devices.
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A\

Note If the state of CSP devices doesn’t show "cert installed" for more than five minutes after CSP activation
through OTP, see Troubleshoot Cisco Cloud Services Platform Issues, on page 147 .

After a cluster is activated from a CSP device, the Cisco Colo Manager (CCM) performs the cluster
activation tasks on the Cisco NFVIS host.

4. To view if CCM is enabled for a CSP device,
a. From the Cisco vManage menu, choose Monitor > Devices.

Cisco vManage Release 20.6.x and earlier: From the Cisco vManage menu, choose Monitor >
Network.

b. Click Colocation Cluster.
Cisco vManage Release 20.6.x and earlier: Click Colocation Clusters.
View whether CCM is enabled for specific CSP devices.

5. To monitor CCM health,
a. From the Cisco vManage menu, choose Monitor > Devices.

Cisco vManage Release 20.6.x and earlier: From the Cisco vManage menu, choose Monitor >
Network.

b. Click Colocation Cluster.
Cisco vManage Release 20.6.x and earlier: Click Colocation Clusters.
View whether CCM is enabled for the desired CSP devices.

c. For the CCM-enabled CSP device, click the CSP device.

d. To view CCM health, click Colo Manager.
If the Cisco Colo Manager status doesn’t change to "HEALTHY" after "STARTING", see Troubleshoot
Cisco Colo Manager Issues, on page 155 .

If the status of Cisco Colo Manager changes to "HEALTHY" after "STARTING" but the status of Cisco
Colo Manager shows IN-PROGRESS for more than 20 minutes after the switch configurations are already
complete, see Switch devices are not calling home to PNP or Cisco Colo Manager, on page 142 .

View Cluster

To view cluster configuration, perform the following steps:

Step 1 From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation.
Step 2 For the desired cluster, click ... and choose View.

The Cluster window displays the switch devices and CSP devices in the cluster and shows the cluster settings that are
configured.

You can only view the global parameters of a cluster, configuration of switch devices and CSP devices.
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Step 3 Click Cancel to return to the Cluster window.

Edit Cluster in vManage

To modify any existing cluster configuration such as global parameters, perform the following steps:

Step 1 From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation
Step 2 For the desired cluster, click ... and choose Edit.

The Cluster window displays the switch devices and CSP devices in the cluster and shows the cluster settings that are
configured.

Step 3 In the cluster design window, you can modify some of the global parameters. Based on whether a cluster is in active or
inactive state, you can perform the following operations on a cluster:

a. Inactive state:
« Edit all global parameters, and the Resource pool parameter.

* Add more CSP devices (up to eight).

* Can’t edit the name or serial number of a switch or CSP device. Instead, delete the CSP or switch and add another
switch or CSP with a different name and serial number.

* Delete an entire cluster configuration.

b. Active state:
« Edit all global parameters, except the Resource pool parameter.

Note You can't change the Resource pool parameter when the cluster is active. However, the only option
to change the Resource pool parameter is to delete the cluster and recreate it with the correct Resource
pool parameter.

 Can’t edit the name or serial number of a switch or CSP device. Instead, delete the CSP or switch and add another
switch or CSP with a different name and serial number.

e Can’t delete a cluster in an active state.

* Add more CSP devices (up to eight).

Step 4 Click Save Cluster.

Add CSP Device to Cluster

You can add and configure the CSP devices using Cisco vManage.

Before you begin

Ensure that the Cisco NFVIS version that you use is same for all the CSP devices in the cluster.
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. Add CSP Device to Cluster

Step 1 From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation
Step 2 For the desired cluster, click ... and choose Add/Delete CSP.

Step 3 To add a CSP device, click + Add CSP. The Add CSP dialog box appears. Enter a name and choose the CSP device
serial number. Click Save.

Step 4 To configure a CSP device, click the CSP icon in the CSP box. The Edit CSP dialog box appears. Enter a name and
choose the CSP device serial number. Click Save.

The name can contain 128 alphanumeric characters.

Note To bring up the CSP devices, ensure that you configure the OTP for the devices.

Figure 14: Add a CSP Device

Serial Number

CsPssssnZPIZIENCS

Step 5 Click Save.
Step 6 After saving, perform the onscreen configuration instructions as shown in the following images:

K3 CONFIGURATION | CLOUD ONRAMP FOR COLOCATION “Configure’action will be applied 1o 4 devicels)
sttached to 2 device template(s).
Device Template
ColocationCluster-ele. - 2

Device st (Total: 3 devices)
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Step 7

Delete CSP Devices from Cluster .

Committing these changes affect

& confiem configuration changes on 4 devices

To check whether the CSP device is added, use the Task View window that displays a list of all running tasks.

Delete CSP Devices from Cluster

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

You can delete CSP devices using Cisco vManage.

From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation

For the desired cluster, click ... and choose Add/Delete CSP.

To delete a CSP device, click the CSP icon from the Appliances box.

Click Delete.

Click Save.

Perform the onscreen instructions to proceed with the deletion as shown in the following images.

CSP-5444-WZP22160NCS
11124

CSP-5444-W2ZP224208LS
RERF

Please select a device from the device st

Cisco SD-WAN Cloud OnRamp for Colocation Solution Guide, Release 20.8.1 .



Configure Cisco SD-WAN Cloud onRamp for Colocation Solution Devices Using Cisco vManage |
[l Delete csp with ccm

Step 7 Reset the CSP devices to factory-default settings. See Factory reset of CSP device, on page 152.
Step 8 To decommission invalid CSP devices, from the Cisco vManage menu, choose Configur ation > Devices.
Step 9 For the CSP devices that are in the deactivated cluster, click the ... and choose Decommission WAN Edge.

This action provides new tokens to the devices.

If an HA service chain is deployed on a CSP device that is deleted, the corresponding HA service chains are
deleted from the CSP device that hosts the HA instances.

Delete CSP with CCM

Step 1 Determine the CSP device that hosts the CCM.

Step 2 If CCM Enabled is true on a CSP device and you decide to delete this CSP device, for the device, click ... and choose
Add/Delete CSP.

From the Montior window, you can view whether CCM is enabled. The following image shows how where you can
view the CCM status.
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Replace Cisco CSP Devices After RMA .

Figure 15: CSP Device with CCM

0 moniToR Cluster_CloudDock
Cluster  Services  Network Functions
CPU(Cores)
) Allocated 98
Switches Available: 34
Total 132
Switch2 Switch1
> >
< <
.
Allocated:  229.50
Available: 346,50
Total 576
Appliances
Disk(GB)
Allocated:  2460.90
Available: 1228410
CSP2  CSP1  CSP4 Total 14745

Q Search Options v Total Rows: 5
> vedge-nfvis-CSP-5444 1.1.1.26 reachable false 30 Jul 2019 11:47:07 AM PDT
[>:] vedge-nfvis-CSP-5444 11127 reachable true 30 Jul 2019 11:36:21 AM PDT
[>:] vedge-nfvis-CSP-5444 1.1.1.29 reachable false 30 Jul 2019 11:56:24 AM PDT

Switch2

Switch1

When the CSP device that you choose to remove from a cluster, runs the service chain monitoring service and CCM,
ensure that you click Sync for the cluster. Clicking the sync button starts the service chain health monitoring service on
a different CSP device and continues monitoring the existing service chain health.

Ensure that Cisco vManage has control connections to all the CSP devices for a cluster so that it can bring up CCM
instance on another CSP device.

After you delete a CSP device with CCM, the CCM instance starts on another CSP device on the cluster.

\}

Note The service chain monitoring is disabled until the CCM instance doesn't start in any of the remaining CSP
devices.

Replace Cisco CSP Devices After RMA

SUMMARY STEPS
1. From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation
2. For the desired cluster, click ... and choose RMA.
3. Do the following in the RMA dialog box:

DETAILED STEPS

Step 1 From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation
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Step 2 For the desired cluster, click ... and choose RMA.
Step 3 Do the following in the RMA dialog box:
a) Select Appliance: Choose a CSP device that you want to replace.

All CSP devices in a specific colocation cluster are displayed in the format, CSP Name-<Serial Number>.

b) Choose a serial number for a new CSP device from the drop-down list.
¢) Click Save.

After saving, you can view the configuration.

Return of Materials of Cisco CSP Devices

Table 13: Feature History

Feature Name |Release Description
Information

RMA Support | Cisco SD-WAN | This feature allows you to replace a faulty CSP device by creating
for Cisco CSP | Release 20.5.1 |backup copies of the device, and then restoring the replacement device

Devices . to a state it was in before the replacement. The VMs running in HA
Cisco vManage . . . . .
mode operate uninterrupted with continuous flow of traffic during device
Release 20.5.1
replacement.

You can now create backup copies and restore NFVIS configurations and VMs.
Pointsto Consider

* You can use Network File Storage (NFS) servers to create regular backup copies of the CSP devices.

« If you’re using an external NFS server for the backup operation, ensure that you maintain and clean the
NFS directory regularly. This maintenance ensures that the NFS server has sufficient space for the
incoming backup packages.

* [f you don’t use NFS servers, don't configure the backup server settings using Cisco vManage. However,
if you're not configuring the backup server settings, you can't restore the replacement device. You can
use delete CSP to remove the faulty device, add a new CSP device, and then start provisioning the service
chains onto the added CSP device.

RMA Process for Cisco CSP Devices

Ensure that you perform the Return of Materials (RMA) process in the following order:

1. Create a backup copy of all the CSP devices in a cluster using Cisco vManage. See Backup Server Settings,
on page 47.
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A\

Note During CSP device replacement, create a backup copy of the device in the NFS server when creating a
using Cisco vManage. Perform one of the following if you’re bringing up a cluster or editing an existi
cluster.

* Bring up a colocation cluster: At the time of cluster creation and activation, provide information :
the NFS storage server and backup intervals. If the backup task fails on a CSP device, the device r
an error, but the cluster activation continues. Ensure that you update the cluster after addressing t!
failure and wait for a successful cluster activation.

+ Edit a colocation cluster: For an existing active cluster, edit the cluster and provide information a
the NFS storage server and backup intervals.

2. Contact Cisco Technical Support to get a replacement CSP device. See Cisco Cloud Services Platform
5000 Hardware Installation Guide for more information about replacing a CSP device.

3. Rewire the replacement Cisco CSP device with the Cisco Catalyst 9500 switches to move the wiring of
the faulty device to the replacement device. See Wiring Requirements, on page 12.

4. Verify that the Cisco CSP ISO image running on the replacement device is the same that was running on
the faulty device.

5. Restore the replacement device using CLI.

Prerequisites and Restrictions for Backup and Restore of CSP Devices

Prerequisites
Backup Operation

* The connectivity to the NFS server from CSP devices should be established before configuring the backup
server settings using Cisco vManage.

* The backup directory on the NFS server should have write permission.

 The external NFS server should be available, reachable, and maintained. The maintenance of the external
NEFS server requires you to check the available storage space and network reachability regularly.

* The schedule for the backup operation should be synced with the local date and time on the CSP device.

Restore Operation

* The replacement device should have the same resources as the faulty device. These resources are, Cisco
NFVIS image version, CPU, memory and storage as the faulty CSP device.

* The connectivity between the replacement device and switch ports should be same as the faulty device
and switches.

*» The PNIC wiring of the replacement device should match the faulty device on the Catalyst 9500 switches.
For example,

If slot-1/port-1 (eth1-1) on the faulty device is connected to switch-1 and port, 1/0/1, then connect
slot-1/port-1 (eth1-1) of the replacement device to the same switch port, such as switch-1 and port, 1/0/1.
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* The onboarding of the replacement device should be completed using the PnP process for CSP devices.

* To prevent the loss of backup access during the restore operation, the configuration for mounting an NFS
server to access the backup package should match the configuration on the faulty device.

You can view configuration information from other CSP devices as the NFS mount location and
configurations are same for all the CSP devices. To view the active configuration that is running on a
healthy CSP device, use the show running-config command. Use this active configuration information
when creating a mount point during the restore operation.

For example,

nfvis# show running-config mount
mount nfs-mount storage nfsfs/

storagetype nfs

storage space_ total gb 123.0

server ip 172.19.199.199
server path /data/colobackup/

|

* The authentication of the replacement device with the Cisco SD-WAN controllers using the OTP process
should be completed after restoring the replacement device.

N

Note Use the request activate chassis-number chassis-serial-number token
token-number command to authenticate a device by logging in to Cisco NFVIS.

* The replacement device shouldn't have any configuration other than the configuration of the faulty device.

Restrictions

Backup Operation
* The periodic backup operation doesn't start during the upgrade of a CSP device.
» If the NFS folder path isn't available on the NFS server, the backup operation doesn't start.
* Only one backup operation can occur at a specific time.

* The backup operation fails if the available disk space on the NFS server is less than the combined size
of the VM export size and tar.gz VM packages.

* The backup device information can only be restored on a replacement CSP device and not on any existing
device that is already part of the cluster.

» The NFS mount configurations can’t be updated after they are configured for a CSP device. To update,
delete the NFS configuration and reapply an updated configuration to the NFS server and reconfigure
the backup schedule. Perform this update when the backup operation isn't in progress.

Restore Operation
* Only one restore operation can occur at a specific time.
» If a backup file doesn’t exist in the NFS server, the restore operation doesn't start.

* The restore operation isn't supported when you convert a cluster from a single tenant mode to multitenant
mode, and conversely.
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Remove PNF Devices from Cluster .

Remove PNF Devices from Cluster

Step 1
Step 2

Step 3

Detach all service groups and service chains that has the PNF.
(Optional) Delete the service groups.

If the deleted PNF is an ASR router, which is orchestrated using Cisco vManage, invalidate and decommission the device
from the Device window.

Remove the cables that connect the PNF with the Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switches and
manually remove the VLAN configuration from the Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C corresponding
interfaces.

Remove Cluster from vManage

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8
Step 9

Step 10

Step 11
Step 12

To decommission an entire cluster from Cisco vManage, perform the following steps:

From the Cisco vManage menu, choose Configuration > Certificates.

Verify the Validate column for the CSP devices that you wish to delete, and click Invalid.

For the invalid devices, click Send to Controllers.

From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation.

For the cluster that has invalid CSP devices, click ... and choose Deactivate.

If the cluster is attached to one or more service groups, a message appears that displays the service chains hosting the
VMs that are running on the CSP device and whether you can continue with the cluster deletion. However, although
you confirm the deletion of a cluster, you’re not allowed to remove the cluster without detaching the service groups

that are hosted on this CSP device. If the cluster isn’t attached to any service group, a message appears that gets a
confirmation from you about the cluster deletion.

Note You can delete the cluster, if necessary, or can keep it in deactivated state.

To delete the cluster, choose Delete.

Click Cancel if you don't wish to delete the cluster.

To decommission invalid devices, from the Cisco vManage menu, choose Configuration > Devices.
For the devices that are in the deactivated cluster, click ... and choose Decommission WAN Edge.

This action provides new tokens to your devices.

Reset the devices to the factory default by using the command:

factory-default-reset all

Log into Cisco NFVIS by using admin as the login name and Admin123# as the default password.

Reset switch configuration and reboot switches. See Clean switches configuration and reset switches to factory defaults,
on page 146 .
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Remove and Replace Switch

Step 1

Step 2

Step 3

The Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C series of switches are used in the data path for
switching traffic between the different VNF devices in a service chain. There are two switches that are stacked
by using Stackwise Virtual (SVL) technology.

To achieve a redundant stack, the switches use a set of two stackwise virtual links (SV links) and one dual
active detection (DAD link). For prescriptive connections on Cisco Catalyst 9500-40X, ports 38, 39 are SVL
links and port 40 is the DAD link. For prescriptive connections on Cisco Catalyst 9500-48Y4C, ports 46, 47
are SVL links and port 48 is the DAD link.

In a stack, there are two switches in which one of the switches is active and the other is the standby. The
control plane databases are synchronized between the switches. Each switch is assigned a switch number as
part of the stack. The switches are numbered 1 and 2 in the current scenario. For more information on SVL
redundancy, see High Availability Switch Configuration Guide.

\}

Note In the case of a switch failure, ensure that you know the switch number that failed. This switch can be used
to set up as the replacement.

To replace a switch in the stack:

On the switch 1 console, use the show switch command to view the configuration.

Switch# show switch
Switch/Stack Mac Address : c4b3.6a70.£f480 - Foreign Mac Address
Mac persistency wait time: Indefinite

H/W Current

Switch# Role Mac Address Priority Version State
*1 Active c4b3.6a71.0b00 1 vOo1l Ready
2 Member 0000.0000.0000 0 V01l Removed
Note Here, the switch number that is removed is two. This switch number is required when configuring the new
switch.

On the switch that replaces the failed unit, ensure that the switch number is one. This is achieved by using the show
switch command again on the new unit.

Switch# show switch
Switch/Stack Mac Address : 5486.bc78.c900 - Local Mac Address
Mac persistency wait time: Indefinite

H/W Current
Switch# Role Mac Address Priority Version State

*1 Active 5486.bc78.c900 1 V01l Ready

If the new switch is numbered two, ensure that you renumber it to 1 and then reload the switches. Use the following
commands to view the switch number and then renumber the switch to 1:

Switch# show switch
Switch/Stack Mac Address : 5486.bc78.c900 - Local Mac Address
Mac persistency wait time: Indefinite

H/W Current
Switch# Role Mac Address Priority Version State

*2 Active 5486.bc78.c900 1 V01l Ready
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Step 4

Step 5

Step 6

Remove and Replace Switch .

Switch# switch 2 renumber 1

WARNING: Changing the switch number may result in a configuration change for that switch. The

interface configuration associated with the old switch number will remain as a provisioned

configuration. New Switch Number will be effective after next reboot. Do you want to continue?[y/n]?
[yes]:

Switch#reload

System configuration has been modified. Save? [yes/no]: no
Reload command is being issued on Active unit, this will reload the whole stack
Proceed with reload? [confirm]

Jun 17 19:41:01.793: %SYS-5-RELOAD: Reload requested by console. Reload Reason: Reload Command

Connect the required cables for SVL; which are ports 38, 39, and 40 from the first Cisco Catalyst 9500-40X switch to
the second switch.

On the second switch, configure and save the configuration.

Switch (config) #

stackwise-virtual

domain 10

|

interface TenGigabitEthernetl/0/38
stackwise-virtual link 1

|

interface TenGigabitEthernetl/0/39
stackwise-virtual link 1

|

interface TenGigabitEthernetl1/0/40
stackwise-virtual dual-active-detection

Renumber the new unit to be the same as the one it’s replacing, and then reload the box.

Switch# switch 1 renumber 2

WARNING: Changing the switch number may result in a configuration change for that switch. The

interface configuration associated with the old switch number will remain as a provisioned

configuration. New Switch Number will be effective after next reboot. Do you want to continue?[y/n]?
[yes]: yes

Switch# reload

After the new switch comes up, it joins the stack and synchronizes with the configuration.

Here's the sample output from the show switch command.

Switch# show switch
Switch/Stack Mac Address : c4b3.6a70.f480 - Foreign Mac Address
Mac persistency wait time: Indefinite

H/W Current

Switch# Role Mac Address Priority Version State
*1 Active c4b3.6a71.0b00 1 Vol Ready
2 Member 5486.bc78.c900 1 vO0o1l Ready
Switch#

*Jun 17 21:00:57.696: $IOSXE REDUNDANCY-6-PEER: Active detected switch 2 as standby.

*Jun 17 21:00:57.694: $STACKMGR-6-STANDBY ELECTED: Switch 1 RO/0: stack mgr: Switch 2 has

been elected STANDBY.

*Jun 17 21:01:02.651: SREDUNDANCY-5-PEER MONITOR EVENT: Active detected a standby insertion
(raw-event=PEER FOUND (4))
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*Jun 17 21:01:02.651: SREDUNDANCY-5-PEER _MONITOR EVENT: Active detected a standby insertion
(raw-event=PEER_REDUNDANCY STATE_CHANGE (5))

*Jun 17 21:01:53.686: %HA CONFIG_SYNC-6-BULK CFGSYNC_SUCCEED: Bulk Sync succeeded
*Jun 17 21:01:54.688: %RF-5-RF_TERMINAL STATE: Terminal state reached for (SSO)
Switch#
Switch# show switch
Switch/Stack Mac Address : c4b3.6a70.£f480 - Foreign Mac Address
Mac persistency wait time: Indefinite

H/W Current

Switch# Role Mac Address Priority Version State
*1 Active c4b3.6a71.0b00 1 V0ol Ready
2 Standby 5486.bc78.c900 1 V0ol Ready

Reactivate Cluster from Cisco vManage

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7
Step 8
Step 9

To add new CSP devices or when CSP devices are considered for RMA process, perform the following steps:

From the Cisco vManage menu, choose Configuration > Devices.

Locate the devices that are in a deactivated cluster.

Get new token from Cisco vManage for the devices.

Log into Cisco NFVIS using admin as the login name and Admin123# as the default password.

Use the request activate chassissnumber chassis-serial-number token token-number command.

Use Cisco vManage to configure the colocation devices and activate the cluster. See Create and Activate Clusters, on
page 39.

If you've deleted the cluster, recreate and then activate it.
From the Cisco vManage menu, choose Configuration > Certificates. Locate and verify status of the colocation devices.

For the desired device that should be valid, click Valid.
For the valid devices, click Send to Controllers.

Manage Service Groups

A service group consists of one or more service chains. You can configure a service group using Cisco
vManage. A service chain is the structure of a network service, and consists of a set of linked network functions.

VNF Placement for Service Chains in vManage

The service chain placement component chooses a CSP device that hosts each VNF in service chains. The
placement decision is based on available bandwidth, redundancy and computation resources (CPUs, memory,
and storage) availability. The placement logic returns an error if the bandwidth, CPU, memory, and storage
needs of all the VNFs in the service chains that are configured for a Cloud OnRamp for Colocation aren’t
met. You receive notifications if the resources aren’t available and service chains aren’t deployed.
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Create Service Chain in a Service Group
A service group consists of one or more service chains.

Table 14: Feature History

Feature Name |Release Feature Description
Information

Monitor Service | Cisco SD-WAN | This feature lets you configure periodic checks on the service chain
Chain Health Release 19.2.1 | data path and reports the overall status. To enable service chain health
monitoring, NFVIS version 3.12.1 or later should be installed on all
CSP devices in a cluster.

From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation

a) Click Service Group and click Create Service Group. Enter the service group name, description, and colocation
group.
The service group name can contain 128 alphanumeric characters.

The service group description can contain 2048 alphanumeric characters.

For a multitenant cluster, choose a colocation group or a tenant from the drop-down list. For a single-tenant cluster,
the colocation group admin is chosen by default.

b) Click Add Service Chain.
¢) Inthe Add Service Chain dialog box, enter the following information:

Table 15: Add Service Chain Information

Field Description

Name The service chain name can contain 128 alphanumeric characters.

Description The service chain description can contain alphanumeric 2048 characters.
Bandwidth The service chain bandwidth is in Mbps. The default bandwidth is 10 Mbps and

you can configure a maximum bandwidth of 5 Gbps.

Input Handoff VLANS and The Input VLAN handoff and output VLAN handoff can be comma-separated
Output Handoff VLANS values (10, 20), or a range from 10-20.
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Field Description

Monitoring A toggle button that allows you to enable or disable service chain health
monitoring. The service chain health monitoring is a periodic monitoring service
that checks health of a service chain data path and reports the overall service
chain health status. By default, the monitoring service is disabled.

A service chain with subinterfaces such as, SCHM (Service Chain Health
Monitoring Service) can only monitor the service chain including the first VLAN
from the subinterface VLAN list.

The service chain monitoring reports status based on end-to-end connectivity.
Therefore, ensure that you take care of the routing and return traffic path, with
attention to the Cisco SD-WAN service chains for better results.

Note * Ensure that you provide input and output monitoring IP addresses
from input and output handoff subnets. However, if the first and
last VNF devices are VPN terminated, you don't need to provide
input and output monitoring IP addresses.

For example, if the network function isn’t VPN terminated, the
input monitoring IP can be 192.0.2.1/24 from the inbound subnet,
192.0.2.0/24. The inbound subnet connects to the first network
function and the output monitoring IP can be, 203.0.113.11/24
that comes from outbound subnet, 203.0.113.0/24 of the last
network function of a service chain.

* Ifthe first or last VNF firewall in a service chain is in transparent
mode, you can't monitor these service chains.

Service Chain A topology to choose from the service chain drop-down list. For a service chain
topology, you can choose any of the validated service chains such as, Router -
Firewall - Router, Firewall, Firewall - Router. See You can also create a
customized service chain. See Create Custom Service Chain, on page 74.

d) Inthe Add Service Chain dialog box, click Add.

e)
f)

Based on the service chain configuration information, a graphical representation of the service group with all the
service chains and the VNFs automatically appear in the design view window. A VNF or PNF appears with a "V"
or "P" around the circumference for a virtual a physical network function. It shows all the configured service chains
within each service group. A check mark next to the service chain indicates that the service chain configuration is
complete.

After you activate a cluster, attach it with the service group and enable monitoring service for the service chain, when
you bring up the CSP device where CCM is running. Cisco vManage chooses the same CSP device to start the
monitoring service. The monitoring service monitors all service chains periodically in a round robin fashion by setting
the monitoring interval to 30 minutes. See Monitor Cloud onRamp Colocation Clusters, on page 111.

In the design view window, to configure a VNF, click a VNF in the service chain.
The Configure VNF dialog box appears.

Configure the VNF with the following information and perform the actions, as appropriate:
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« Disk Image/l mage Package (Select File)
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Create Service Chain in a Service Group .

The following fields are available from Cisco vManage Release 20.7.1:

« Disk Image/l mage Package (Filter by Tag, Name and Version)

« Scaffold File (Select File)

« Scaffold File (Filter by Tag, Name and Version)

Table 16: VNF Properties of Router and Firewall

Field

Description

I mage Package

Choose a router, firewall package.

Disk Image/l mage Package (Select File)

Choose a tar.gz package or a qcow?2 image file.

Disk Image/l mage Package (Filter by Tag, Name and
Version)

(Optional) Filter an image or a package file based on the
name, version, and tags that you specified when uploading
a VNF image.

Scaffold File (Select File)

Choose a scaffold file.

Note * This field is mandatory if a qcow2 image
file has been chosen. It is optional if a

tar.gz package has been chosen.

* If you choose both a tar.gz package and
a scaffold file, then all image properties
and system properties from the scaffold
file override the image properties and
system properties, including the Day-0
configuration files, specified in the tar.gz
package.

Scaffold File (Filter by Tag, Name and Version)

(Optional) Filter a scaffold file based on the name,
version, and tags that you specified when uploading a
VNF image.

Click Fetch VNF Properties. The available information
box.

for the image is displayed in the Configure VNF dialog

Name VNF image name

CPU (Optional) Specifies the number of virtual CPUs that are
required for a VNF. The default value is 1 vCPU.

Memory (Optional) Specifies the maximum primary memory in
MB that the VNF can use. The default value is 1024 MB.

Disk (Optional) Specifies disk in GB required for the VM. The

default value is 8 GB.
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Field Description

A dialog box with any custom tokenized variables from Day-0 that requires your input appears. Provide the values.

In the following image, all IP addresses, VLAN, and autonomous system within the green box are system-specific

information that is generated from the VLAN, IP pools provided for the cluster. The information is automatically
added into the Day-0 configurations of VMs.

Cisco SD-WAN Cloud OnRamp for Colocation
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The following images are a sample configuration for VNF IP addresses and autonomous system numbers, in Cisco
vManage.
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:

If you're using a multitenant cluster and a comanged scenario, configure the Cisco SD-WAN VM by entering the
values for the following fields and the remaining fields, as required for the service chain design:

Note To join the tenant overlay network, the provider should provide correct values for the following fields.
Field Description
Serial Number The authorized serial number of a Cisco SD-WAN device. The service provider can get

the device serial number from the tenant before creating the service chain.

oTP The OTP of the Cisco SD-WAN device that is available after authenticating it with Cisco
SD-WAN Controllers. The service provider can get the OTP for the corresponding serial
number from the tenant before creating the service chain.

Siteld The identifier of the site in the tenant Cisco SD-WAN overlay network domain in which

the Cisco SD-WAN device resides, such as a branch, campus, or data center. The service
provider can get the site Id from the tenant before creating the service chain.

Tenant ORG Name

The tenant organization name that is included in the Certificate Signing Request (CSR).
The service provider can get the organization name from the tenant before creating the
service chain.

System | P connect to
Tenant

The IP address to connect to the tenant overlay network. The service provider can get
the IP address from the tenant before creating the service chain.

Tenant vBond | P

The IP address of the tenant Cisco vBond Orchestrator. The service provider can get the
Cisco vBond Orchestrator IP address from the tenant before creating the service chain.
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For edge VMs such as first and last VM in a service chain, you must provide the following addresses as they peer
with a branch router and the provider router.

Table 17: VNF Options for First VM in Service Chain

Field Mandatory or
Optional

Description

Firewall Mode |Mandatory

Choose Routed or Transparent mode.

Note Firewall mode is applicable to firewall VMs only.

Enable HA Optional

Enable HA mode for the VNF.

Termination Mandatory

Choose one of the following modes:
* L3 mode selection with subinterfaces that are in trunk mode

<type>selection</type> <val help="L3 Mode With
Sub-interfaces (Trunked)" display="VNF-Tagged">vlan</val>

* L3 mode with IPSEC termination from a consumer-side and rerouted to
the provider gateway

<val help="L3 Mode With IPSEC Termination From Consumer and
Routed to Provider GW" display="Tunneled">vpn</val>

* L3 mode with access mode (nontrunk mode)

<val help="L3 Mode In Access Mode (Non-Trunked)"

display="Hypervisor-Tagged">routed</val>

g) Click Configure. The service chain is configured with the VNF configuration.
h) To add another service chain, repeat the procedure from Steps b-g.

i) Click Save.

The new service group appears in a table under the Service Group. To view the status of the service chains
that are monitored, use the Task View window, which displays a list of all running tasks along with the total
number of successes and failures. To determine the service chain health status, use the show system:system
status command on the CSP device that has service chain health monotioring enabled.
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QoS on Service Chains

Table 18: Feature History

Feature Name |Release Description
Information

QoS on Service |Cisco SD-WAN | This feature classifies the network traffic based on the Layer 2 virtual
Chains Release 20.1.1 |local-area network (VLAN) identification number. The QoS policy
allows you to limit the bandwidth available for each service chain by
applying traffic policing on bidirectional traffic. The bidirectional traffic
is the ingress side that connects Cisco Catalyst 9500-40X switches to
the consumer and egress side that connects to the provider.

Prerequisites

* Ensure that you use the Quality of Service (QoS) traffic policing on service chains that do not have shared
VNF and PNF devices.

A\

Note  You cannot apply QoS policy on service chains with shared VNF devices where
input and output VLANS are same for multiple service chains.

* Ensure that you use the following versions of software for QoS traffic policing:

Software Release

Cisco NFVIS Cloud OnRamp for Colocation 4.1.1 and later

Catalyst 9500-40X 16.12.1 and later

The QoS policing policy is applied on the network traffic based on the following workflow:

1. Cisco vManage saves the bandwidth, input, or output VLAN information to VNF and PNF devices. To
provide bandwidth and VLAN information, see Create Service Chain in a Service Group, on page 65.

2. CCM saves the bandwidth, input, or output VLAN values information to the Cisco Catalyst 9500-40X or
Cisco Catalyst 9500-48Y4C switches.

3. CCM creates corresponding class-maps and policy-maps in Cisco Catalyst 9500-40X or Cisco Catalyst
9500-48Y4C switches based on VLAN match criteria.

4. CCM applies input service-policy on the ingress and egress ports.
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\)

Note From Cisco vManage Release 20.7.1, the QoS traffic policy on service chains is not supported for Cisco
Catalyst 9500 switches.

« [f an active cluster is upgraded to Cisco vManage Release 20.7.1 and CSPs 4.7.1, and if there are service
chains provisioned prior to upgrade, the QoS configuration will be removed from switches during the
upgrade automatically.

* When new service chains are provisioned in Cisco vManage Release 20.7.1, the QoS policy will not be
configured on switches.

* Similarly, new clusters created in Cisco vManage Release 20.7.1 will not configure QoS configuration
for service chains on switches.

Clone Service Groups

Table 19: Feature History

Feature Name |Release Description
Information

Clone Service | Cisco SD-WAN | This feature allows you to create copies of service groups for different
Groups in Cisco | Release 20.5.1 | RBAC users, without having to enter the same configuration information
vManage multiple times. By cloning a service group, you can easily create service

Cisco vManage . . - .
M ¢ | chains by leveraging the stored service chain templates.

Release 20.5.1

When you clone or create copies of service chains, remember the following:

* Cisco vManage copies all configuration information of a service group to a cloned service group regardless
of whether the cloned service group is attached to a cluster.

* Verify the CSV file and ensure that configuration information has a matching service group name during
CSV file upload. Otherwise, an unmatched service group name can result in an error message during
CSV file upload.

* To get an updated list of service group configuration values, always download service group configuration
properties from the service group design view.

Step 1 From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation

Step 2 Click Service Group.
The service group configuration page appears and all the service groups are displayed.

Step 3 For the desired service group, click ... and choose Clone Service Group.
A clone of the original service group appears in the service group design view. Note the following points:

* By default, the cloned service group name and VM names are suffixed with a unique string.

* To view any VM configuration, click a VM in service chains.
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Step 4
Step 5

Step 6

Step 7

Step 8

Clone Service Groups .

« Cisco vManage marks the service chains that require configuration as Unconfigured, next to the edit button of the
service chain.

Modify the service group name, if required. Provide a description for the service group.

To configure a service chain, use one of the following methods:

* Click the edit button for a service chain, enter the values, and then click Save.

* Download the configuration values from a CSV file, modify the values, upload the file, and then click Save. See
Steps 6, 7, 8 on how to download, modify, and upload a CSV file.

The cloned service group appears on the service group configuration page. You can now download the updated service
group configuration values.

To download the cloned service group configuration values, do one of the following:
Note The download and upload of a CSV file is supported for creating, editing, and cloning of the service groups

that aren’t attached to a cluster.

* On the service group configuration page, click a cloned service group, click M ore Actionsto the right of the service
group, and choose Download Properties (CSV).

* In the service group design view, click Download CSV in the upper right corner of the screen.

Cisco vManage downloads all configuration values of the service group to an Excel file in CSV format. The CSV file
can consist of multiple service groups and each row represents configuration values for one service group. To add more
rows to the CSV file, copy service group configuration values from existing CSV files and paste them in this file.

For example, ServiceGroupl Clonel that has two service chains with one VM in each of the service chains is represented
in a single row.

Note In the Excel file, the headers and their representation in the service chain design view is as follows:
* scl/name represents the name of the first service chain.
* scl/vml/name represents the name of the first VNF in the first service chain.
* sc2/name represents the name of the second service chain.

* sc2/vm2/name represents the name of the second VNF in the second service chain.

To modify service group configuration values, do one of the following:

* To modify the service group configuration in the design view, click a cloned service group from the service group
configuration page.

Click any VM in service chains to modify the configuration values, and then click Save.

* To modify the service group configuration using the downloaded Excel file, enter the configuration values in the
Excel file manually. Save the Excel file in CSV format.

To upload a CSV file that includes all the configuration values of a service group, click a service group in the service
group configuration page, and then click Upload CSV from the right corner of the screen.

Click Browseto choose a CSV file, and then click Upload.
You can view the updated values displayed for the service group configuration.

Note You can use the same CSV file to add configuration values for multiple service groups. But, you can update
configuration values for a specific service group only, when uploading a CSV file using Cisco vManage.
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Step 9

To know the representation of service group configuration properties in the CSV file and Cisco vManage design view,
click a service group from the service group configuration page.

Click Show M apping Names.

A text appears next to all the VMs in the service chains. Cisco vManage displays this text after mapping it with the
configuration properties in the CSV file.

Create Custom Service Chain

Step 1

Step 2

Step 3

You can customize service chains,

* By including extra VNFs or add other VNF types.

* By creating new VNF sequence that isn’t part of the predefined service chains.

Create a service group and service chains within the service group. See Create Service Chain in a Service Group, on page
65.

In the Add Service Chain dialog box, enter the service chain name, description, bandwidth, input VLAN handoff, output
VLAN handoff, monitoring health information of a service chain, and service chain configuration. Click Add.

For the service chain configuration, choose Create Custom from the drop-down. An empty service chain in the design
view window is available.

To add a VNF such as a router, load balancer, firewall, and others, click a VNF icon and drag the icon to its proper
location within the service group box. After adding all required VNFs and forming the VNF service chain, configure
each of the VNFs. Click a VNF in the service group box. The Configure VNF dialog box appears. Enter the following
parameters:

a) Choose the software image to load from the Disk | mage/l mage Package (Select File) drop-down list.

Note You can select a qcow?2 image file from Cisco vManage Release 20.7.1.

b) Choose a scaffold file from the Scaffold File (Select File) drop-down list if you have chosen a qcow?2 image file.

Note This option is available from Cisco vManage Release 20.7.1.

c) Optionally, filter an image, a package file, or a scaffold file based on the name, version, and tags that you specified
when uploading a VNF image.

Note This option is available from Cisco vManage Release 20.7.1.

d) Click Fetch VNF Properties.

e) Inthe Name field, enter a name of the VNF.

f) Inthe CPU field, enter the number of virtual CPUs required for the VNF.

g) Inthe Memory field, enter the amount of memory in megabytes to be allocated for the VNF.

h) In the Disk field, enter the amount of memory for storage in gigabytes to be allocated for the VNF.
i) Enter VNF-specific parameters, as required.

Note These VNF details are the custom variables that are required for Day-0 operations of the VNF.

j) Click Configure.
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k) To delete the VNF or cancel the VNF configuration, click Delete or Cancel respectively.

The customized service chains are added to a service group.

)

Note You can customize a VNF sequence with only up to four VNFs in a service chain.

Physical Network Function Workflow

This topic outlines the sequence of operations that you require to create shared PNF devices, configure, and
monitor them. To ensure that the PNF workflow is effective, ensure that cabling is accurate, and VLAN ports
are on the right ports of Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C.

1. Connect the PNF devices to Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switch devices.

2. Tomake Cisco ASR 1000 Series router managed by Cisco vManage, upload WAN edge router authorized
serial numbers from the Cisco Smart Account. See the "Upload WAN Edge Router Serial Numbers from
Cisco Smart Account” section in the System and Interfaces Configuration Guide.

3. Create service chains by using the added PNF devices. See Custom Service Chain with Shared PNF
Devices, on page 76.

4. Attach the service group to a cluster and check the configuration parameters that are generated. See Attach
or Detach a Service Group in a Cluster, on page 88.

5. Configure the PNF and the Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switch devices
according to the configuration parameters generated. See Configure PNF and Cisco Catalyst 9500 Switches,
on page 79.

In the following image, the first PNF is shared with multiple service chains. These service chains access
different cloud applications in Microsoft Azure, AWS, and Google Cloud. The traffic from VLAN 200 enters
the Cisco ASR 1000 series PNF based on SD-WAN policy definition and fetches the next hop firewall based
on VRF configuration and corresponding destination application. The return traffic should traverse the same
path for each application traffic.

To configure the PNF,

1. Log into the ASR1000 Series device, and configure it based on the VLAN and IP address information
available from Cisco vManage.

2. To allow specific VLANSs on both inbound and outbound traffic, configure the Cisco Catalyst 9500-40X
or Cisco Catalyst 9500-48Y4C switch ports where the PNF devices are connected.
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Figure 16: PNF Shared with Multiple Service Chains
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Custom Service Chain with Shared PNF Devices

You can customize service chains by adding supported PNF devices.

A

Caution  Ensure that you don’t share PNF devices across colocation clusters. A PNF device can be shared across service
chains, or across service groups. However, a PNF device can now be shared only across a single cluster.

Table 20: Feature History

Feature Name |Release Feature Description
Information

Manage PNF Cisco SD-WAN | This feature lets you add Physical Network Function (PNF) devices to
Devices in Release 19.2.1 |anetwork, in addition to the Virtual Network function (VNF) devices.
Service Chains These PNF devices can be added to service chains and shared across
service chains, service groups, and a cluster. Inclusion of PNF devices
in the service chain can overcome the performance and scaling issues
caused by using only VNF devices in a service chain.

Before you begin

To create a customized service chain by adding a router or firewall to an existing service chain, ensure that
you note the following points:

» [f a PNF device needs to be managed by Cisco vManage, ensure that the serial number is already available
in Cisco vManage, which can then be available for selection during PNF configuration.

* The FTD device can be in any position in a service chain.

* An ASR 1000 Series Aggregation Services Routers can only be in the first and last position in a service
chain.

* PNF devices can be added across service chains and service groups.
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Step 1

Step 2

Step 3

Step 4
Step 5
Step 6

Custom Service Chain with Shared PNF Devices .

* PNF devices can be shared across service groups. They can be shared across service groups by entering
the same serial numbers.

» PNF devices can be shared across a single colocation cluster, and can't be shared across multiple colocation
clusters.

Create a service group and service chains within the service group. See Create Service Chain in a Service Group, on page
65.

In the Add Service Chain dialog box, enter the service chain name, description, bandwidth, input VLAN handoff, output
VLAN handoff, monitoring health information of a service chain, and service chain configuration. Click Add.

For the service chain configuration, choose Create Custom from the drop-down list. An empty service chain in the
design view window is available. At the left, a set of VNF devices and PNF devices that you can add into the service
chain appears. The 'V' in the circumference of VNF devices represents a VNF and 'P' in the circumference of PNF devices
represent a PNF.

Note Ensure that you choose the Create Custom option for creating service chains by sharing PNF devices.

To add a PNF such as physical routers, physical firewalls in a service chain, click the required PNF icon, and drag the
icon to the proper location within the service chain box.

After adding all required PNF devices, configure each of them.
a) Click a PNF device in the service chain box.

The Configure PNF dialog box appears. To configure a PNF, enter the following parameters:

b) Check HA Enabled if HA is enabled for the PNF device.
c) Ifthe PNF is HA enabled, ensure that you add the HA serial number in HA Serial.

If the PNF device is FTD, enter the following information.
1. Inthe Name field, enter a name of the PNF.
2. Choose Routed or Transparent mode as the Firewall Mode.

3. Inthe PNF Serial field, enter the serial number of the PNF device.

If the PNF device is ASR 1000 Series Aggregation Services Routers, enter the following information.
1. Check the vManaged check box if the device is managed by Cisco vManage.

2. Click Fetch Properties.

3. Inthe Name field, enter a name of the PNF.

4

In the PNF Serial field, enter the serial number of the PNF device.

d) Click Configure.

To add service chains and share PNF devices, repeat from Step 2.
To edit an existing PNF configuration, click the PNF.
In the Share NF To drop-down list, choose the service chains with which the PNF should be shared.

After a PNF is shared, if you hover over a PNF, the respective shared PNF devices are highlighted in blue color. However,
the PNFs from different service groups aren’t highlighted in blue color. After you choose an NF to be shared, a blue color
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rim appears. If the same PNF is shared across multiple service chains, it can be used in different positions by dragging
and placing the PNF icons in a specific positon.
Figure 17: Single PNF in a Service Chain

The following image shows a service chain that consists of a single PNF, Ftd Pnf (not shared with other service chains).
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Figure 18: Two PNF Devices in Service Chains

The following image shows service chains that consist of two PNFs, FTdv_PNF shared across service chain 1 (SC1) and
service chain 2 (SC2) and ASR_PNF (non-shared).
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Figure 19: Three PNF Devices in Service Chains

The following image shows service chains that consist of three PNF devices in two different positions along with Cisco
vManage configuration.
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Configure PNF and Cisco Catalyst 9500 Switches .

HAEnabled  [] VManaged Change Selection
Name Asr_UmanagedPNF
PNF Serial ASR-{3b34881-9346-4257-a94f-8adcof88ae27
ASR1001-X-JAE231101RS
Share PNF to
Cancel Delete

Step 7 To delete or cancel a Network Function configuration, click Delete or Cancel respectively.

You must attach the service groups to a colocation cluster. After attaching service groups that contain PNF
devices, the PNF configuration isn’t automatically pushed to the PNF devices unlike VNF devices. Instead,
you must manually configure the PNF device by noting configuration that is generated on the Monitor Cloud
onRamp Colocation Clusters window. The VLANs must be also configured on the Cisco Catalyst 9500-40X
switch devices. See the ASR 1000 Series Aggregation Services Routers Configuration Guides and Cisco
Firepower Threat Defense Configuration Guides for more information about the specific PNF configuration.

Configure PNF and Cisco Catalyst 9500 Switches

Step 1 Identify ports from the switches where the PNF devices should be added, which are part of a service chain. To verify the
availability of the ports, see .

Step 2 Connect with Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C by using either the terminal server of any of the
Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switches or use the vty session command with the IP address
of the active switch.

Step 3 Configure VLANS from the generated configuration parameters on Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C
switches with interfaces that are connected to the PNF. See the Monitor Cloud onRamp Colocation Clusters screen for
the generated VLAN configuration.

Step 4 To configure an FTD or an ASR 1000 Series device, note the configuration from the Monitor window and then manually
configure it on a device.

Custom Service Chain with Shared VNF Devices

You can customize service chains by including supported VNF devices.
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Step 1

Step 2

Step 3

Table 21: Feature History

Feature Name |Release Feature Description
Information

Share VNF Cisco SD-WAN | This feature lets you share Virtual Network Function (VNF) devices
Devices Across |Release 19.2.1 | across service chains to improve resource utilisation and reduce resource
Service Chains fragmentation.

Before you begin

Ensure that you note the following points about sharing VNF devices:
* You can share only the first, last, or both first and last VNF devices in a service chain.
* You can share a VNF with a minimum of one more service chain and maximum up to five service chains.
* Each service chain can have a maximum of up to four VNF devices in a service chain.

* You can share VNF devices only in the same service group.

Create a service group and service chains within the service group. See Create Service Chain in a Service Group, on page
65.

In the Add Service Chain dialog box, enter the service chain name, description, bandwidth, input VLAN handoff, output
VLAN handoff, monitoring health information of a service chain, and service chain configuration. Click Add.

For the service chain configuration, choose Create Custom from the drop-down list. An empty service chain in the
design view window is available. At the left, a set of VNF devices and PNF devices that you can add into the service
chain appears. The "V' in the circumference of VNF devices represents a VNF and 'P' in the circumference of PNF devices
represent a PNF.

Note Ensure that you choose the Create Custom option for creating a shared VNF package.

To add a VNF such as a router, load balancer, firewall, and others, click a VNF icon from the left panel, and drag the
icon to a proper location within the service chain box.

After adding all required VNF devices, configure each of them.
a) Click a VNF in the service chain box.
The Configure VNF dialog box appears. To configure VNF, enter the following parameters:

b) From the | mage Package drop-down list, choose the software image to load.

To create a customized VNF package from Cisco vManage, see Create Customized VNF Image, on page 94.

¢) Click Fetch VNF Properties.

d) In the Name field, enter a name of the VNF.

e) Inthe CPU field, enter the number of virtual CPUs required for the VNF.

f) Inthe Memory field, enter the amount of memory in megabytes to be allocated for the VNF.

g) Inthe Disk field, enter the amount of memory for storage in gigabytes to be allocated for the VNF.

h) Enter VNF-specific parameters, as required. See Create Service Chain in a Service Group, on page 65 for more
information about VNF-specific properties.

These VNF-specific parameters are the custom user variables that are required for Day-0 operations of a VNF.
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For a complete information about the list of user and system variables for different VNF types when located at various
positions, see Shared VNF Use Cases, on page 81 and Custom Packaging Details for Shared VNF, on page 161 .

Note Ensure that you enter the values of the user variables if they are defined as mandatory, and the system
variables are automatically set by Cisco vManage.

i) Click Configure.

Step 4 To share VNF devices, repeat from Step 2.
Step 5 To edit an existing VNF configuration, click the VNF.

Step 6 Scroll down the VNF configuration to find the Share NF To field. From the Share NF To drop-down list, choose the
service chains with which the VNF should be shared.

After a VNF is shared, if you hover over a VNF, the specific shared VNF devices are highlighted in blue color. After
you choose an NF to be shared, a blue rim appears on it.

Step 7 To delete a VNF or cancel the VNF configuration, click Delete or Cancel respectively.

You must attach service groups to a cluster.

Shared VNF Use Cases

The following are the sample images for some of the shared VNF use cases and their predefined variable list:

Figure 20: Shared—-Cisco vEdge Router VNF in First Position

The Cisco vEdge Router VNF in the first position is shared with the second service chain in the first position.
The input to the first VNF is in access mode (hypervisor-tagged) and the neighbor (ASAv firewall) is in HA
mode.
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Figure 21: Shared-Cisco vEdge Router VNF in First Position

The Cisco vEdge Router VNF in the first position is shared with the second service chain in the first position.
The input to the first VNF is in access mode (hypervisor-tagged) and the neighbor is in StandAlone mode.
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Figure 22: Shared-Cisco vEdge Router VNF in First Position
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The Cisco vEdge Router VNF in the first position is shared with the second service chain in the first position.

The input to the first VNF is in trunk mode (VNF-tagged) and the neighbor is in StandAlone mode.
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Figure 23: Shared—-Cisco vEdge Router VNF in First Position

103

The Cisco vEdge Route VNF in the first position is shared with the second service chain in the first position.

The input to the first VNF is in trunk mode (VNF-tagged) and the neighbor is in HA mode.
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Figure 24: Shared-Cisco CSR1000V VNF in Last Position

The Cisco CSR1000V VNF in the last position is shared with the second service chain in the second position.
The output from the last VNF is in access mode (hypervisor-tagged) and the neighbor (ASAv firewall) is in
StandAlone mode.
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Figure 25: Shared-Cisco CSR1000V VNF in Last Position

The Cisco CSR1000V VNF in the last position is shared with the second service chain in the second position.
The output from the last VNF is in access mode (hypervisor-tagged) and the neighbor is in StandAlone mode.
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Figure 26: Shared-Cisco CSR1000V VNF in Last Position

The Cisco CSR1000V VNF in the last position is shared with the second service chain in the second position.
The output from the last VNF is in access mode (hypervisor-tagged) and the neighbor (Firewall Service) is

in HA mode.
INSIDE_VLAN_1
INSIDE_PRIM
INSIDE_DATA_MASK
INSIDE_PEER_DATA_IP_PRIM
INSIDE_AS
INSIDE_PEER_DATA_IP_SEC
o . VIP_IP_ADDRESS
ServiceGroup4_chain1 INSIDE_SEC
101 @3@ \ & 103
Firewall_Service... Router_ServiceGr... OUTSIDE_PRIM
OUTSIDE_DATA_MASK
OQUTSIDE_PEER_DATA_IP_PRIM
OUTSIDE_AS
ServiceGroup4_chain2 LOCAL_OUTSIDE_AS
101 @2}) &) 104
Firewall_Service... Router_ServiceGr...
INSIDE_‘VLAN_2
INSIDE_PRIM_2

INSIDE_DATA_MASK_2
INSIDE_PEER_DATA_IP_PRIM_2
INSIDE_AS_2
INSIDE_PEER_DATA_[P_SEC_2
VIP_IP_ADDRESS_2
INSIDE_SEC_2

Figure 27: Shared-Cisco CSR1000V VNF in Last Position

The Cisco CSR1000V VNF in the last position is shared with the second service chain in the second position.
The output from the last VNF is in access mode (hypervisor-tagged) and the neighbor (Firewall Service) is
in HA mode.
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Figure 28: Shared—ASAv VNF in First Position

The ASAv VNF in the first position is shared with the second service chain in the first position. The input to
the first VNF is in access mode (hypervisor-tagged) and the neighbor is in redundant mode.

OUTSIDE_PRIM
OUTSIDE_DATA_MASK
OUTSIDE_PEER_DATA_IP_PRIM
QUTSIDE_AS
OUTSIDE_VLAN_L
N . OUTSIDE_PEER_DATA_IP_SEC
ServiceGroup1_chaint ;;¢o: sec

100 @3 @:; 101
INSIDE_PRIM / ASAv
INSIDE_SEC

CSR_1

INSIDE_DATA_MASK
INSIDE_PEER_DATA_IP_PRIM

INSIDE_PEER_DATA_IP_SEC - -
INSIDE AS ServiceGroup1_chain2

LOCAL_INSIDE_AS @

@%\ SR

ASAv CSR_2

OUTSIDE_PRIM_2
OUTSIDE_DATA_MASK_2
OUTSIDE_PEER_DATA_IP_PRIM_2
OUTSIDE_AS_2

OUTSIDE_VLAN_2
OUTSIDE_PEER_DATA_IP_SEC_2
OUTSIDE_SEC_2

Figure 29: Shared-ASAv VNF in First Position

The ASAv (Firewall Service) VNF in the first position is shared with the second service chain in the first
position. The input to the first VNF is in access mode (hypervisor-tagged) and the neighbor is in StandAlone
mode.
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Figure 30: Shared-ASAv VNF in First Position
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The ASAv (Firewall Service) VNF in the first position is shared with the second service chain in the first
position. The input to the first VNF is in access mode (hypervisor-tagged) and the neighbor, which is a router
is in redundant mode.

INSIDE_PRIM
INSIDE_DATA_MASK

INSIDE_PEER_DATA_IP_PRIM

INSIDE_AS
LOCAL_INSIDE_AS

100

100

ServiceGroup5_chain1

Firewall_Service...

ServiceGroup5_chain2

FirewalLServic& Router_ServiceGr...

Figure 31: Shared—-ASAv VNF in First Position
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The ASAv VNF in the first position in HA mode is shared with the second service chain in the first position.

The input to the first VNF is in trunk mode (vnf-tagged) and the neighbor is in redundant mode.
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View Service Groups

To view service groups, perform the following steps:

Step 1 From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation
Step 2 Click Service Group.
Step 3 For the desired service group, click ... and choose View.

You can view the service chains in the design window.

Edit Service Groups

Before attaching a service group with a cluster, you can edit all parameters. After attaching a service group
with a cluster, you can only edit monitoring configuration parameters. Also, after attaching a service group,
you can only add new service chains but not edit or attach a service chain. Hence, ensure that you detach a
service group from a cluster before editing an existing service chain. To edit and delete a service group,
perform the following steps:

Step 1 From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation.

Step 2 Click Service Group.

Step 3 For the desired service group, click ... and choose Edit.

Step 4 To modify either service chain configuration or modify a VNF configuration, click a router or firewall VNF icon.
Step 5 To add new service chains, click Add Service Chain.
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Attach or Detach a Service Group in a Cluster

To complete the Cisco SD-WAN Cloud onRamp for Colocation configuration, you must attach service groups
to a cluster. To attach or detach a service group to and from a cluster, perform the following steps:

Step 1 From the Cisco vManage menu, choose Configuration > Cloud OnRamp for Colocation.
Step 2 Click ... adjacent to the corresponding cluster and choose Attach Service Groups.

Step 3 In the Attach Service Groups dialog box, choose one or more service groups in Available Service Groups and click
Add to move the selected groups to Selected Service Groups.

Step 4 Click Attach.

Step 5 To detach a service group from a cluster, click ... adjacent to the corresponding cluster and choose Detach Service
Groups.

You can’t attach or detach a single service chain within a service group.
Step 6 In the Config Preview window that is displayed, click Cancel to cancel the attach or detach task.
Note

Step 7 To verify if service groups are attached or detached, you can view the status using Cisco vManage. Note the following
points:

« If the status of the tasks in the Task View window is displayed as FAILURE or in PENDING for a long duration,
see Troubleshoot Service Chain Issues, on page 157 .

» [f a Cisco Colo Manager task fails, see Troubleshoot Cisco Colo Manager Issues, on page 155.

If a colocation cluster moves to PENDING state, for a cluster, click ..., and choose Sync. This action moves the cluster
back to ACTIVE state. The Sync option keeps Cisco vManage synchronized with the colocation devices.

Day-N Configuration Workflow of Cisco SD-WAN Cloud onRamp
for Colocation Solution

The following is the background process for a Day-N configuration.

* All Day-N configuration from Cisco vManage requires clusters to be in-sync (devices have to be in
synchronization with Cisco vManage) state.

» When attaching a service group with a cluster, Cisco vManage runs the Placement logic to determine
which VMs are placed on specific CSP devices.

* Switch-related Day-N configuration from Cisco vManage requires Cisco Colo Manager to be in a Healthy
state.

+ Cisco vManage saves all switch-related service chain, cluster, switch configuration to Cisco Colo Manager.

* Cisco Colo Manager moves to In-progress state for any configuration that it receives from Cisco vManage.
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* Cisco Colo Manager translates all global and service chain configuration of Cisco Colo Manager into
the device-specific configuration.

* Cisco Colo Manager reports the states to Cisco vManage whether a configuration push is a success or
failure.

* All the Day-N service chain or VM configuration is sent to CSP devices.

* CSP devices send notification to Cisco vManage about the VM file download status.

* After all VMs are downloaded, Cisco vManage sends the bulk configuration to bring up all VMs.
* CSP devices send notifications to Cisco vManage about VM that are brought up and the states.

* If any switch devices return error, Cisco vManage reports error with a detailed information and the cluster
moves to a FAILURE state.

Ensure that you fix errors that are based on notifications and error messages, and then activate the Cloud
OnRamp for Colocation cluster again.

)

Note During the Day-N configuration, you can modify Serial Number of switches for both the switches devices.

Figure 32: Day-N Workflow
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Note *You can only edit service groups after they are detached from a cluster.
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CHAPTER 6

Software Image Management for Cluster
Components and SWIM

» Manage VM Catalog and Repository, on page 91

» Upgrade Cisco NFVIS Using Cisco vManage, on page 100

* Upgrade Cisco Catalyst 9500 Switches, on page 101

* Supported Upgrade Scenarios and Recommended Connections, on page 104

Manage VM Catalog and Repository

Table 22: Feature History

Feature Name Release Information Description

Support for Cisco VM Image Cisco IOS XE Release 17.7.1a This feature allows you to upload
Upload in qcow?2 Format Cisco SD-WAN Release 20.7.1 a virtual machine image to Cisc.o
vManage in qcow?2 format. Earlier,
Cisco vManage Release 20.7.1 you could upload only a
prepackaged image file in tar.gz
format.

Cisco vManage supports uploading a prepackaged Cisco virtual machine image, tar.gz, or an image in qcow?2
format. It is mandatory to upload a scaffold file if you choose a qcow?2 image file. Similarly, you can now
select either an image package file or a qcow?2 image file with a scaffold file when configuring a Virtual
Network Function (VNF) during service chain creation.

A scaffold file contains the following components:
* VNF metadata (image properties.xml)

* System-generated variables from cluster resource pools for service chaining
(system_generated propeties.xml)

* Tokenized Day-0 configuration files

* Package manifest file (package.mf)

Alternatively, you can package the VM image by providing a root disk image in any of the supported formats
(qcow2). Use the linux command-line NFVIS VM packaging tool, nfvpt.py to package the gcow?2 or
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alternatively create a customized VM image using Cisco vManage. See Create Customized VNF Image, on
page 94.

A VM is SR-IOV capable means sriov_supported is set to true in image properties.xml in the vim package

* tar.gz. Also, the service chain network is automatically connected to SR-IOV network. If sriov_supported
is set to false, an OVS network is created on the data port channel. It’s attached to VM VNICs for service
chaining by using the OVS network. For the Cisco SD-WAN Cloud onRamp for Colocation solution, a VM
uses homogeneous type of network in service chains. This type of network means it’s either OVS or SR-IOV,
and not a combination of SR-IOV and OVS.

Only two data VNICs are attached to any VM—one for inbound traffic and the other for outbound traffic. If
more than two data interfaces are required, use subinterfaces configuration within the VM. The VM packages
are stored in the VM catalog.

\)

Note Each VM type such as firewall can have multiple VM images that are uploaded to Cisco vManage from same
or different vendors and added to a catalog. Also, different versions that are based on the release of the same
VM can be added to a catalog. However, ensure that the VM name is unique.

The Cisco VM image format can be bundled as *.tar.gz and can include:
* Root disk images to boot the VM.
* Package manifest for checksum validation of the file listing in the package.
* Image properties file in XML format that lists the VM meta data.
* (Optional) Day-0 configuration, other files that are required to bootstrap the VM.
* (Optional) HA Day-0 configuration if VM supports stateful HA.

* System-generated properties file in XML format that lists the VM system properties.

VM images can be hosted on both HTTP server local repository that Cisco vManage hosts or on the remote
server.

If VM is in Cisco NFVIS supported VM package format such as, tar.gz, Cisco vManage performs all the
processing and you can provide variable key and values during VNF provisioning.

)

Note Cisco vManage manages the Cisco VNFs, and the Day-1 and Day-N configurations within VNF aren’t
supported for other VNFs. See the Cisco NFVIS Configuration Guide, VM Image Packaging for more
information about VM package format and content, and samples on image properties.xml and manifest
(package.mf).

To upload multiple packages for the same VM, same version, communication manager (CM) type, ensure
that one of the three values (name, version, VNF type) are different. Then, you can repackage the VM * .tar.gz
to be uploaded.

VNF Image Format

Cisco vbond Orchestrator doesn’t distinguish between Cisco VNFs and third-party VNFs. All VNFs are
categorized based on the services that are provided by the VNF such as router, firewall, load balancer, and
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Upload VNF Images .

others. The package metadata has VM-specific attributes. Based on HA NICs and management NICs specified
in the package metadata file, Cisco vBond orchestrator attaches management NIC and HA NIC. By default,
management NIC is zero and HA NIC is one. The number of HA NICs that is specified is attached during
VNF provisioning.

Upload VNF Images

Step 1
Step 2
Step 3

The VNF images are stored in the Cisco vManage software repository. These VNF images are referenced
during service chain deployment, and then they are pushed to Cisco NFVIS during service chain attachment.

From the Cisco vManage menu, choose M aintenance > Software Repository.
To add a prepackaged VNF image, click Virtual Images, and then click Upload Virtual Image.
Choose the location to store the virtual image.

* To store the virtual image on the local Cisco vManage server and download it to CSP devices over a control plane
connection, click vManage. The Upload VNF’s Package to vM anage dialog box appears.

a. Drag and drop the virtual image file or the qcow2 image file to the dialog box or click Browse to choose the
virtual image from the local Cisco vManage server. For example, CSR.tar.gz, ASAv.tar.gz, or ABC.qcow?2

b. If youupload a file, specify the type of the uploaded file: Image Package or Scaffold. Optionally, specify a
description of the file and add custom tags to the file. The tags can be used to filter images and scaffold files
when creating a service chain.

c. Ifyou upload a qcow2 image file, specify the service or VNF type: FIREWALL or ROUTER. Optionally,
specify the following:

* Description of the image

* Version number of the image

* Checksum

* Hash algorithm
You can also add custom tags to the file that can be used to filter images and scaffold files when creating a
service chain.
Note « It is mandatory to upload a scaffold file if you choose a qcow?2 image file.

* The option to select a qcow?2 image file is available from Cisco vManage Release 20.7.1. In Cisco
vManage Release 20.6.1 and earlier releases, you can select only a tar.gz file.

d. Click Upload to add the image to the virtual image repository. The virtual image repository table displays the
added virtual image, and it available for installing on the CSP devices.

* To store the image on a remote Cisco vManage server and then download it to CSP devices, click Remote Server
- vManage. The Upload VNF’s Package to Remote Server-vM anage dialog box appears.

a. Inthe vManage Hostname/l P Addressfield, enter the IP address of an interface on Cisco vManage server that
is in the management VPN (typically, VPN 512).

b. Drag and drop the virtual image file or the qcow2 image file to the dialog box, or click Browse to choose the
virtual image from the local vManage server.
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C.

If you upload a file, specify the type of the uploaded file: mage Package or Scaffold. Optionally, specify a
description of the file and add custom tags to the file. The tags can be used to filter images and scaffold files
when creating a service chain.

If you upload a qcow?2 image file, specify the service or VNF type: FIREWALL or ROUTER. Optionally,
specify the following:

* Description of the image
* Version number of the image
* Checksum

* Hash algorithm

You can also add custom tags to the file that can be used to filter images and scaffold files when creating a
service chain.

Note * It is mandatory to upload a scaffold file if you choose a qcow2 image file.

* The option to select a qcow?2 image file is available from Cisco vManage Release 20.7.1. In Cisco
vManage Release 20.6.1 and earlier releases, you can select only a tar.gz file.

Click Upload to add the image to the virtual image repository. The virtual image repository table displays the
added virtual image, and it is available for installing on the CSP devices.

You can have multiple VNF entries such as a firewall from same or from different vendors. Also, you can
add different versions of VNF that are based on the release of the same VNF. However, ensure that the VNF
name is unique.

Create Customized VNF Image

Before you begin

You can upload one or more qcow?2 images in addition to a root disk image as an input file along with
VM-specific properties, bootstrap configuration files (if any), and generate a compressed TAR file. Through
custom packaging, you can:

* Create a custom VM package along with image properties and bootstrap files (if needed) into a TAR
archive file.

* Tokenize custom variables and apply system variables that are passed with the bootstrap configuration
files.

Ensure that the following custom packaging requirements are met:
* Root disk image for a VNF—qcow?2
* Day-0 configuration files—system and tokenized custom variables
* VM configuration—CPU, memory, disk, NICs

* HA mode—If a VNF supports HA, specify Day-0 primary and secondary files, NICs for a HA link.
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+ Additional Storage—If more storage is required, specify predefined disks (qcow?2), storage volumes
(NEVIS layer)

Step 1 From the Cisco vManage menu, choose M aintenance> Software Repository .
Step 2 Click Virtual Images> Add Custom VNF Package.
Step 3 Configure the VNF with the following VNF package properties and click Save.

Table 23: VNF Package Properties

Field Mandatory or Optional Description

Package Name Mandatory The filename of the target VNF package.
It’s the Cisco NFVIS image name with
.tar or .gz extensions.

App Vendor Mandatory Cisco VNFs or third-party VNFs.
Name Mandatory Name of the VNF image.
Version Optional Version number of a program.
Type Mandatory Type of VNF to choose.

Supported VNF types are: Router,
Firewall, Load Balancer, and Other.

Step 4 To package a VM qcow?2 image, click File Upload, and browse to choose a qcow?2 image file.

Step 5 To choose a bootstrap configuration file for VNF, if any, click Day 0 Configuration and click File Upload to browse
and choose the file.

Include the following Day-0 configuration properties:

Table 24: Day-0 Configuration

Field Mandatory or Optional Description

Mount Mandatory The path where the bootstrap file gets
mounted.

Par seable Mandatory A Day-0 configuration file can be

parsed or not.

Options are: Enable or Disable. By
default, Enableis chosen.

High Availability Mandatory High availability for a Day-0
configuration file to choose.

Supported values are: Standalone, HA
Primary, HA Secondary.

Note If any bootstrap configuration is required for a VNF, create a bootstrap-config or a dayO-config file.
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Step 6

Step 7

Step 8

To add a Day-0 configuration, click Add, and then click Save. The Day-0 configuration appears in the Day 0 Config
File table. You can tokenize the bootstrap configuration variables with system and custom variables. To tokenize
variables of a Day-0 configuration file, click View Configuration File next to the desired Day-0 configuration file. In
the Day 0 configuration file dialog box, perform the following tasks:

Note The bootstrap configuration file is an XML or a text file, and contains properties specific to a VNF and the
environment. For a shared VNF, see Custom Packaging Details for Shared VNF, on page 161 for the list of
system variables that must be added for different VNF types..

a) To add a system variable, in the CL| configur ation dialog box, select, and highlight a property from the text fields.
Click System Variable. The Create System Variable dialog box appears.

b) Choose a system variable from the Variable Name drop-down list, and click Done. The highlighted property is
replaced by the system variable name.

¢) To add a custom variable, in the CL| configuration dialog box, choose and highlight a custom variable attribute
from the text fields. Click Custom Variable. The Create Custom Variable dialog box appears.

d) Enter the custom variable name and choose a type from Type drop-down list.
e) To set the custom variable attribute, do the following:

* To ensure that the custom variable is mandatory when creating a service chain, click Typenext to Mandatory.

* To ensure that a VNF includes both primary and secondary day-0 files, click Type next to Common.

f) Click Done, and then click Save. The highlighted custom variable attribute is replaced by the custom variable name.

To upload extra VM images, expand Advance Options, click Upload Image, and then browse to choose an extra
gcow?2 image file. Choose the root disk, Ephemeral disk 1, or Ephemeral disk 2, and click Add. The newly added VM
image appears in the Upload | mage table.

Note Ensure that you don’t combine ephemeral disks and storage volumes when uploading extra VM images.

To add the storage information, expand Add Stor age, and click Add volume. Provide the following storage information
and click Add. The added storage details appear in the Add Storage table.

Table 25: Storage Properties

Field Mandatory or Optional Description

Size Mandatory The disk size that is required for the
VM operation. If the size unit is GiB,
the maximum disk size can be 256

GiB.

Size Unit Mandatory Choose size unit.
The supported units are: MIB, GiB,
TiB.

Device Type Optional Choose a disk or CD-ROM. By

default, disk is chosen.

L ocation Optional The location of the disk or CD-ROM.
By default, it’s local.
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Step 9

Step 10

Create Customized VNF Image .

Field Mandatory or Optional Description
Format Optional Choose a disk image format.
The supported formats are: gcow?2,
raw, and vindk. By default, it’s raw.
Bus Optional Choose a value from the drop-down

list.

The supported values for a bus are:
virtio, scsi, and ide. By default, it’s
virtio.

To add VNF image properties, expand | mage Properties and enter the following image information.

Table 26: VNF Image Properties

Field

Mandatory or Optional

Description

SR-10V Mode

Mandatory

Enable or disable SR-IOV support. By
default, it’s enabled.

M onitored

Mandatory

VM health monitoring for those VMs
that you can bootstrap.

The options are: enable or disable. By
default, it’s enabled.

Bootup Time

Mandatory

The monitoring timeout period for a
monitored VM. By default, it’s 600
seconds.

Serial Console

Optional

The serial console that is supported or
not.

The options are: enable or disable. By
default, it’s disabled.

Privileged Mode

Optional

Allows special features like
promiscuous mode and snooping.

The options are: enable or disable. By
default, it’s disabled.

Dedicate Cores

Mandatory

Facilitates allocation of a dedicated
resource (CPU) to supplement a VM's
low latency (for example, router and
firewall). Otherwise, shared resources
are used.

The options are: enable or disable. By
default, it’s enabled.

To add VM resource requirements, expand Resour ce Requirements and enter the following information.
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Step 11
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Field

Mandatory or Optional

Description

Default CPU

Mandatory

The CPUs supported by a VM. The
maximum numbers of CPUs supported
are 8.

Default RAM

Mandatory

The RAM supported by a VM. The
RAM can range 2-32.

Disk Size

Mandatory

The disk size in GB supported by a
VM. The disk size can range 4-256.

Max number of VNICs

Optional

The maximum number of VNICs
allowed for a VM. The number of
VNICs can from range 8-32 and by
default, the value is 8.

Management VNIC ID

Mandatory

The management VNIC ID
corresponding to the management
interface. The valid range is from 0 to
maximum number of VNICs.

Number of Management VNICs 1D

Mandatory

The number of VNICs.

High Availability VNIC ID

Mandatory

The VNIC IDs where high availability
is enabled. The valid range is from
O0—maximum number of VNICs. It
shouldn’t conflict with management
VNIC Id. By default, the value is 1.

Number of High Availability VNICs
ID

Mandatory

The maximum number of VNIC IDs
where high availability is enabled. The
valid range is 0—(maximum number of
VNICs-number of management
VNICs-2) and by default, the value is
1.

To add day-0 configuration drive options, expand Day 0 Configuration Drive options and enter the following

information.

Table 28: Day-0 Configuration Drive Options

Field

Mandatory or Optional

Description

Volume L abel

Mandatory

The volume label of the Day-0
configuration drive.

The options are: V1 or V2. By default,
the option is V2. V2 is the config-drive
label config-2. V1 is config-drive label
cidata.
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Field Mandatory or Optional Description

Init Drive Optional The Day-0 configuration file as a disk
when mounted. The default drive is
CD-ROM.

Init Bus Optional Choose an init bus.
The supported values for a bus are:
virtio, scsi, and ide. By default, it’s ide.

The Software Repository table displays the customized VNF image, and image is available for choosing when
creating a custom service chain.

View VNF Images

Step 1 From the Cisco vManage menu, choose M aintenance > Software Repository.
Step 2 Click Virtual Images.
Step 3 To filter the search results, use the filter option in the search bar.

The Software Version column provides the version of the software image.

The Software Location column indicates where the software images are stored. Software images can be stored either in
the repository on the Cisco vManage server or in a repository in a remote location.

The Version Type Name column provides the type of firewall.
The Available Files column lists the names of the VNF image files.

The Update On column displays when the software image was added to the repository.

Step 4 For the desired VNF image, click ... and choose Show I nfo.

Delete VNF Images

Step 1 From the Cisco vManage menu, choose M aintenance > Software Repository.
Step 2 Click Virtual Images. The images in the repository are displayed in a table.
Step 3 For the desired image, click ... and choose Delete.

\}

Note If you're downloading a VNF image to a device, you can’t delete the VNF image until the download process
completes.
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\)

Note Ifthe VNF image is referenced by a service chain, it can’t be deleted.

Upgrade Cisco NFVIS Using Cisco vManage

To upload and upgrade Cisco NFVIS, the upgrade image must be available as an archive file that can be
uploaded to the Cisco vManage repository using Cisco vManage. After you upload the Cisco NFVIS image,
the upgraded image can be applied to a CSP device by using the Software Upgrade window in Cisco vManage.
You can perform the following tasks when upgrading Cisco NFVIS software using Cisco vManage:

* Upload Cisco NFVIS upgrade image. See Upload NFVIS Upgrade Image, on page 100.

» Upgrade a CSP device with the uploaded image. See Upgrade a CSP Device with a Cisco NFVIS Upgrade
Image, on page 101.

* View the upgrade status for the CSP device by clicking the Tasks icon located in the Cisco vManage
toolbar.

Upload NFVIS Upgrade Image

Step 1

Step 2
Step 3

Step 4

Step 5

Download the Cisco NFVIS upgrade image from a prescribed location to your local system. You can also download the
software image to an FTP server in your network.

From the Cisco vManage menu, choose Maintenance> Software Repository .
Click Add New Software > Remote Server/Remote Server - vM anage.

You can either store the software image on a remote file server, on a remote vManage server, or on a vManage server.
vManage server: Saves software images on a local vManage server.

Remote server: Saves the URL pointing to the location of the software image and can be accessed using an FTP or HTTP
URL.

Remote vManage server: Saves software images on a remote vManager server and location of the remote vManage server
is stored in the local Cisco vManage server.

To add the image to the software repository, browse and choose the Cisco NFVIS upgrade image that you had downloaded
in Stepl.

Click Add|Upload.

The Software Repository table displays the added NFVIS upgrade image, and it’s available for installing on
the CSP devices. See the Software Repository topic in the Cisco SD-WAN Configuration Guides.
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Upgrade a CSP Device with a Cisco NFVIS Upgrade Image

Before you begin

Ensure that the Cisco NFVIS software versions are the files that have . nfvispkg extension.

Step 1 From the Cisco vManage menu, choose Maintenance > Software Upgrade > WAN Edge.
Step 2 Check one or more CSP device check boxes for the devices you want to choose.
Step 3 Click Upgrade. The Software Upgrade dialog box appears.

Step 4 Choose the Cisco NFVIS software version to install on the CSP device. If software is located on a remote server, choose
the appropriate remote version.

Step 5 To automatically upgrade and activate with the new Cisco NFVIS software version and reboot the CSP device, check
the Activate and Reboot check box.

If you don’t check the Activate and Reboot check box, the CSP device downloads and verifies the software image.
However, the CSP device continues to run the old or current version of the software image. To enable the CSP device to
run the new software image, you must manually activate the new Cisco NFVIS software version by choosing the device
again and clicking the Activate button in the Software Upgrade window.

Step 6 Click Upgrade.

The Task View window displays a list of all running tasks along with total number of successes and failures. The window
periodically refreshes and displays messages to indicate the progress or status of the upgrade. You can easily access the
software upgrade status window by clicking the Task View icon located in the Cisco vManage toolbar.

Note If two or more CSP devices belonging to the same cluster are upgraded, the software upgrade for the CSP
devices happens in a sequence.

Note The Set the Default Software Version option isn’t available for the Cisco NFVIS images.

The CSP device reboots and the new NFVIS version is activated on the device. This reboot happens during
the Activate phase. The activation can either happen immediately after upgrade if you check the Activate
and Reboot check box, or by manually clicking Activate after choosing the CSP device again.

To verify if CSP device has rebooted and is running, use the task view window. Cisco vManage polls your
entire network every 90 seconds up to 30 times and shows the status on th task view window.

\)

Note  You can delete a Cisco NFVIS software image from a CSP device if the image version isn’t the active version
that is running on the device.

Upgrade Cisco Catalyst 9500 Switches

You can perform a software upgrade for both Cisco Catalyst 9500-40X and Cisco Catalyst 9500-48Y4C
switches.
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. Upgrade Cisco Catalyst 9500 Switches

Step 1

Step 2

Step 3

Before you begin

* Back up the running configuration in both the switches

* Ensure that you download the Cisco Catalyst 9500 upgrade software (.bin file) from cisco.com website
and it is available as an archive file.

To copy the upgraded software from Trivial File Transfer Protocol (TFTP) to the flash of switchl, use the following
commands:

a)

b)

<)

conf t
Enters the configuration mode one per line. Ends with CNTL/Z.

Example:

c9500-1#conf t
blocksize value

Manually changes the block size in the global configuration to speed up the transfer process.

Example:

c9500-1 (config) #ip tftp blocksize 8165
c9500-1 (config) #end

Copy scp
Securely copies switch image files to the flash of switchl.

Example:

c9500-1#copy scp://<cec-1id>@172.16.0.151//auto/tftp-xxx-users2/yyyy/Switch Image/
cat9k iosxe.17.03.01.SPA.bin flash: vrf Mgmt-vrf

To copy the upgraded software from one switch to another switch when they are in the SVL mode, use the following
commands.

If both the switches are not in SVL mode, repeat Step 1 for switch2.

* Cisco Catalyst 9500-40X

copy
Copies from flash of switchl to flash of switch2.

c9500-1#copy flash-l:cat9k iosxe.17.03.01.SPA.bin flash-2:
* Cisco Catalyst 9500-48Y4C
copy

Copies to bootflash of switch2 from switchl

switchl#copy bootflash:cat9k iosxe.17.03.01.SPA.bin stdby-bootflash:
cat9k iosxe.17.03.01.SPA.bin

To remove the startup switch software specification, use the no form of the boot system command on Catalyst 9500
switches.

a)

config t

Enters the configuration mode.
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Upgrade Cisco Catalyst 9500 Switches .

b) noboot system

Clears all startup software configuration.

Step 4 To configure the switch and reload the copied software, use the following commands:

* Cisco Catalyst 9500-40X

a.

boot system switch all flash

Configures the boot variable to boot the switch with the newly copied software.

c9500-1 (config) #boot system switch all flash:
cat9k iosxe.17.03.01.SPA.bin

end
Exits global configuration mode of the switch

c9500-1 (config) #end
Wr mem

Copies the switch configuration changes that you have made and save it to the configuration in flash.

c9500-1#wr mem

* Cisco Catalyst 9500-48Y4C
a. boot system bootflash

Installs the upgraded software, saves the configuration, and reloads the copied software.

switchl (config) #boot system bootflash:
cat9k iosxe.17.03.01.SPA.bin

end
Exits global configuration mode of the switch

switchl (config) #end
wr mem

Copies the switch configuration changes that you have made and save it to the configuration in bootflash.

switchl#wr mem

* Switches without SVL configuration. Configure both the switches to reload the copied software. Use the following
commands on both the switches:

a. boot system flash

C

Configures the switches to boot the image from flash memory.

Switch (config) #boot system flash:
cat9k iosxe.17.03.01.SPA.bin

end
Exits global configuration mode of the switch

Switch (config) #end
Wwr mem

Copies the switch configuration changes that you have made and save it to the configuration in flash.
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. Supported Upgrade Scenarios and Recommended Connections

Step 5

Step 6

Switch#wr mem

To verify only one boot system configuration exists in the running configuration, use the following commands:

a)

b)

show run | i boot
Verifies that the upgraded software is the first boot image.

Example:
c9500-1#show run | i boot

license boot level
Boots a new software license on a switch with the DNA essentials

Example:

c9500-1#license boot level network-advantage addon dna-advantage

diagnostic bootup level
Configures the bootup diagnostic level to trigger diagnostics when the switch boots up.

Example:

c9500-1#diagnostic bootup level minimal

To reload and apply the switch configuration change, use the following command. It applies for both Cisco Catalyst
9500-40X and Cisco Catalyst 9500-48Y4C switches.:

Example:

c9500-1#reload

Supported Upgrade Scenarios and Recommended Connections

The following are the various upgrade scenarios and cluster states that determine the use of prescriptive or
flexible connections.

Table 29: Supported Connections

Cisco vManage

Cisco NFVIS

Cluster State

Supported Connections

Upgrade from Releases
19.3 or 20.1.1.1 to
Release 20.3.1

Upgrade from Releases
3.12 or 4.1 to Releases
4.1.10r4.2.1

Cluster created and active
inCisco vManage
Releases 19.3 or 20.1.1.1

Use prescriptive
connections

Use the latest Release,
20.3.1

Use the latest Release,
42.1

Cluster created and active
in Cisco vManage Release
20.3.1

Can use prescriptive or
flexible connections

Upgrade from Release
20.1.1.1 to Release 20.3.1

Upgrade from Release 4.1
to Releases 4.1.1 or 4.2.1

Cluster created and active
in Cisco vManage Release
20.1.1.1.

Use prescriptive
connections
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Cisco vManage Cisco NFVIS Cluster State Supported Connections

Upgrade from Release Upgrade from Release 4.1 | Cluster created and active | Use prescriptive
20.1.1.1 to Release 20.3.1 | to Releases 4.1.1 or 4.2.1 | in Cisco vManage Release | connections
20.1.1.1.

To add a new Cisco CSP

device after upgrade, see

Add Cisco CSP Device to
Cluster After Upgrading

Cisco vManage and Cisco
NFVIS.

Upgrade from Release Upgrade from Release 4.1 | Cluster created and active | Can use prescriptive or
20.1.1.1 to Release 20.3.1 | to Releases 4.1.1 or 4.2.1 | in Cisco vManage Release | flexible connections
20.3.1

Add Cisco CSP Device to Cluster After Upgrading Cisco vManage and Cisco NFVIS

To add a Cisco CSP device to a cluster if the cluster was created before upgrading Cisco vManage to Release
20.3.1, perform the following steps:

1. Connect the cables for the newly added Cisco CSP device according to prescriptive connections.
2. Upgrade Cisco NFVIS to Release 4.2.1
3. Use the following commands on the newly added Cisco CSP device by logging into Cisco NFVIS:
* request csp-prescriptive-mode
Requests the newly added Cisco CSP device to run in prescriptive mode.
* request activate chassissnumber chassis number token serial number
Activates the Cisco CSP device
Example

request activate chassis-number 71591a3b-7d52-24d4-234b-58e5f4ad0646 token
e0b6£073220d85ad32445e30de88a739

Recommendations Prior to Updating a Cluster

* To use an already active cluster when you upgrade to the latest release of the Cisco SD-WAN Cloud
onRamp for Colocation solution, ensure that you upgrade Cisco vManage and Cisco NFVIS to the latest
releases.

* To create a new cluster when you upgrade to the latest release of the Cisco SD-WAN Cloud onRamp
for Colocation solution, ensure that you upgrade Cisco vManage and Cisco NFVIS to the latest releases
for flexible connections.

Cisco SD-WAN Cloud OnRamp for Colocation Solution Guide, Release 20.8.1 [Jjj



Software Image Management for Cluster Components and SWIM |
. Supported Upgrade Scenarios and Recommended Connections

Il Cisco SD-WAN Cloud OnRamp for Colocation Solution Guide, Release 20.8.1



CHAPTER 7

Monitor Cisco SD-WAN Cloud onRamp for
Colocation Solution Devices

Cisco vManage displays the Cloud OnRamp for Colocation status at a cluster level that indicates the health

of each device. The cluster level resources are displayed to indicate the resource availability, such as the CPU
allocated and available. You can view service groups in the cluster. All the service groups under a cluster are
shown in a table view that indicates the number of VMs in a service chain that are up or down. Also, you can
view the diagram view of a service group. This diagram view displays all service chains and VMs in a service
chain that allows you to look at the resources that are allocated to a VM. The view displays VLANs for each
VNIC attached to the VM. You can look at the VNF view, which is in tabular form that displays VNF details.
You can hover over VM and get information about management IP, CPU, Memory, disk, HA, and VM type.

The historical and real-time operational statistics such as CPU, memory, disk, and VNIC utilization charts
are available for each VM and CSP device. The VNF view can be navigated from a device under the cluster
view or from the services view. See Monitor Operational Status of Cloud OnRamp for Colocation Devices
from Cisco vManage, on page 107.

* Monitor Operational Status of Cloud OnRamp for Colocation Devices from Cisco vManage, on page
107

* Cisco Colo Manager States for Switch Configuration, on page 116

* Cisco Colo Manager States and Transitions from Host, on page 117

* Cisco Colo Manager Notifications, on page 117

* VM Alarms, on page 121

* VM States, on page 122

* Cloud Services Platform Real-Time Commands, on page 122

Monitor Operational Status of Cloud OnRamp for Colocation
Devices from Cisco vManage

Monitoring colocation devices is the process of reviewing and analyzing a device, such as Cloud Services
Platform (CSP) devices and Cisco Colo Manager for health, inventory, availability, and other operation-related
processes. You can also monitor the components of CSP devices such as CPU, memory, fan, temperature,
and so on. For more information about the Cisco vManage Monitoring screens, see the Cisco SD-WAN
Configuration Guides configuration guides.

All notifications are sent to the Cisco vManage notification stream. To use the notification stream command,
see Cisco SD-WAN Command Reference.
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. View Information About VNFs from vManage

Step 1

Step 2

Step 3

Step 4

Step 5

From the Cisco vManage menu, choose Monitor > Devices.
Cisco vManage Release 20.6.x and earlier: From the Cisco vManage menu, choose Monitor > Network.

If Cisco vManage can’t reach the CSP devices and Cisco Colo Manager (CCM) cannot reach the switches, the CSP
devices and CCM are shown as unreachable.

Click a CSP device or a switch from the list by clicking the hostname.
By default, the VNF Status window appears.

Click Select Device and to filter the search results for devices, use the Filter option in the search bar.

The following are the categories of information about the device that are displayed:

* VNF Status—Displays performance specifications, required resources, and component network functions for each
VNF See View Information About VNFs from vManage, on page 108.

* Interface—Displays Interface status and statistics See the "View Interfaces" topic in the Cisco SD-WAN Configuration
Guides.

* Control Connections—Displays status and statistics for control connections See the View Control Connections topic
in the Cisco SD-WAN Configuration Guides.

* System Status—Displays reboot and crash information, hardware component status, and CPU and memory usage.
See the View Control Connections topic in the Cisco SD-WAN Configuration Guides.

* Colo Manager—Displays Cisco Colo Manager health status See View Cisco Colo Manager Health, on page 110.

» Events—Displays latest system logging (syslog) events. See the View Events topic in the Cisco SD-WAN
Configuration Guides.

* Troubleshooting—Displays information about pings and traceroute traffic connectivity tools See the Troubleshoot
a Device topic in the Cisco SD-WAN Configuration Guides.

* Real Time—Displays real-time device information for feature-specific operational commands. See the View Real-Time

Data topic in the Cisco SD-WAN Configuration Guides.

To monitor colocation clusters, from the Cisco vManage menu, choose M onitor > Devicesand click Colocation Cluster.

Cisco vManage Release 20.6.x and earlier: To monitor colocation clusters, from the Cisco vManage menu, choose
Monitor > Network and click Colocation Clusters.

Click the desired cluster name. See Monitor Cloud onRamp Colocation Clusters, on page 111 for more information.

View Information About VNFs from vManage

Table 30: Feature History

Feature Name |Release Description
Information

VNF States and | Cisco SD-WAN | This feature allows you to determine the state of a deployed VM using
Color Codes Release 20.1.1 | color codes, which you can view on the Monitor > Devices page.
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Step 1

Step 2
Step 3
Step 4

Table 31: Feature History

View Information About VNFs from vManage .

Feature Name

Release Information

Description

Switch

Network Utilization Charts for
SR-IOV Enabled NICs and OVS

Cisco SD-WAN Release 20.1.1

This feature allows you to view
network utilization charts of VM
VNICs connected to both SR-IOV
enabled NICs and OVS switch.

You can view performance specifications and required resources for each VNF. Reviewing this information
can help you to determine which VNF to use when you’re designing a network service. To view information
about VNFs, perform the following steps:

From the Cisco vManage menu, choose Monitor > Devices.

Cisco vManage Release 20.6.x and earlier: From the Cisco vManage menu, choose Monitor > Network.

Cisco vManage displays the VNF information in a tabular format. The table includes information such as CPU use,
memory consumption, and disk, and other core parameters that define performance of a network service.

Click a CSP device from the table.
From the left pane, click VNF Status.

From the table, click the VNF name. Cisco vManage displays information about the specific VNF. You can click the
network utilization, CPU utilization, memory utilization, and disk utilization to monitor the VNF resources utilization.

The following VNF information is displayed:

Table 32: VNF Information

Chart options bar

VNF information in graphical format

VNF information in color coded format

* Chart Options drop-down—Click
Chart Options drop-down list to
select the type of data to display.

* Time periods—Click either a
predefined time period, or a
custom time period for which to
display data.

Choose a VNF from the Select Device
drop-down list to display information
for the VNF.

The VNFs are shown in specific colors
based on the following operational
status of the VNF life cycle:

» Green—VNF is healthy, deployed,
and successfully booted up.

* Red—VNF deployment or any
other operation fails, or VNF
stops.

* Yellow—VNF is transitioning
from one state to another.

The right pane displays the following:

« Filter criteria

* VNF table that lists information about all VNFs or VMs. By default, the first six VNFs are selected. The network
utilization charts for VNICs connected to SR-IOV enabled NICs and OVS switch are displayed.
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Figure 33: VNF Information
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The graphical display plots information for the VNFs that you have selected by checking the check box.

* Click the check box at the left to select and deselect VNFs. You can select and display information for a
maximum of six VNFs at a time.

* To change the sort order of a column, click the column title.

View Cisco Colo Manager Health

You can view Cisco Colo Manager (CCM) health for a device, CCM host system IP, CCM IP, and CCM
state. Reviewing this information can help you to determine which VNF to use when you’re designing a
network service chain. To view information about VNFs, perform the following steps:

Step 1 From the Cisco vManage menu, choose Monitor > Devices.
Cisco vManage Release 20.6.x and earlier: From the Cisco vManage menu, choose Monitor > Network.
The information of all devices is displayed in a tabular format.

Step 2 Click a CSP device from the table.

Step 3 From the left pane, click Colo Manager.

The right pane displays information about the memory usage, CPU usage, uptime, and so on, of the colo manager.

Il Cisco SD-WAN Cloud OnRamp for Colocation Solution Guide, Release 20.8.1



| Monitor Cisco SD-WAN Cloud onRamp for Colocation Solution Devices
Monitor Cloud onRamp Colocation Clusters .

Monitor Cloud onRamp Colocation Clusters

Table 33: Feature History

Feature Name |Release Description
Information

Network Cisco SD-WAN | This feature provides the capability to stop, start, or restart VNFs on
Assurance Release 20.3.1 | Cisco CSP devices from the Colocation Cluster tab. You can easily
—VNFs: perform the operations on VNFs using Cisco vManage.

Cisco vManage

Stop/Start/Restart Release 20 3.1

You can view the cluster information and their health states. Reviewing this information can help you to
determine which Cisco CSP device is responsible for hosting each VNF in a service chain. To view information
about a cluster, perform the following steps:

Step 1 From the Cisco vManage menu, choose Monitor > Devices.

Cisco vManage Release 20.6.x and earlier: From the Cisco vManage menu, choose Monitor > Network.

Step 2 To monitor clusters, click Colocation Cluster.
Cisco vManage Release 20.6.x and earlier: Click Colocation Clusters.

All clusters with relevant information are displayed in a tabular format. Click a cluster name. You can monitor cluster
by clicking Config. View and Port Level View.

« Config. View: The primary part of the window displays the CSP devices and switch devices that form the cluster.
In the right pane, you can view the cluster information such as the available and total CPU resources, available and
allocated memory, and so on, based on colocation size.

The detail part of the window contains:
* Search: To filter the search results, use the Filter option in the search bar.
* A table that lists information about all devices in a cluster (Cisco CSP devices, PNFs, and switches).

Click a Cisco CSP device. VNF information is displayed in a tabular format. The table includes information
such as VNF name, service chains, number of CPUs, memory consumption, and other core parameters that
define performance of a network service chain. See View Information About VNFs from vManage, on page
108 .

To start, stop, or reboot a VNF, for the desired VNF, click ... and choose one of the following operations:
» Start.
« Stop.
* Restart.

Note Ensure that service chain provisioning is complete and VMs are deployed, before issuing start, stop, restart
operations on any of the VNFs in the service chain.

After you choose an operation on a VNF, wait until the operation is complete before you issue another operation.
You can view the progress of an operation from the Task View window.
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* Port Level View: After you activate the cluster, to view the port connectivity details, click Port Level View.

You can view detailed port connectivity information for the switches and CSP devices in a color coded format based
on the SR-IOV and OVS modes.

To view the mapping of ports between the Catalyst 9500 switches and CSP devices, click or hover over a CSP
device.

Figure 34: Monitor Port Connectivity Details of a Cluster
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Step 3 Click Services.
Here, you can view the following:

» Complete information of a service chain. The first two columns display the name and description of the service
chain in the service group and the remaining columns mention about the VNF, PNF statuses, monitoring service
enablemement, and the overall health of a service chain. You can also view the colocation user group associated
with a service chain. The various health statuses and their representations are:

» Healthy—An up arrow in green. A service chain is in 'Healthy' status when all the VNF, PNF devices are
running and are in healthy state. Ensure that you configure the routing and policy correctly.

* Unhealthy—A down arrow in red. If one of the VNFs or PNFs are in unhealthy state, the service chain is
reported to be in 'Unhealthy’ status. For example, after deploying a service chain, if one of the network function
IP address changes on the WAN or LAN side, or the firewall policy isn’t configured to let the traffic pass
through, then unhealthy state is reported. This is because the network function or overall service chain is
Unhealthy or both are in Unhealthy state.

* Undetermined—Down arrow in yellow. This state is reported when the health of the service chain can’t be
determined. This state is also reported when there’s no status such as healthy or unhealthy available for the
monitored service chain over a time period. You can’t query or search a service chain with undetermined status.

If a service chain consists of a single PNF and PNF is outside the reachability of Cisco vManage, it can’t be
monitored. If a service chain consists of a single network function, the firewall that has VPN termination on
both sides which can’t be monitored, then it’s reported as Undetermined.

Note If the status of a service chain is undetermined, you can’t choose the service chain to view the detailed
monitoring information.
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* If you had configured a service chain by enabling the monitoring field, then click a service group that is in Healthy
or Unhealthy state. The primary part of the service chain monitoring window contains the following elements:

Graphical display that plots the latency information of the service chain, VNFs, PNFs.
The detail part of the service chain monitoring window contains:
* Search: To filter the search results, use the Filter option in the search bar.
* A table that lists information about all service chains, VNFs, PNFs, their health status, and types.
* Check the service chain, VNF, PNF check boxes for the service chains, VNFs, PNFs you want to choose.

* To change the sort order of a column, click the column title.

The status details column indicates the monitored data path and it provides the per hop analysis.
* Click Diagram and view the service group with all the service chains and VNFs in the design view window.
* Click a VNF. You can view CPU, memory, and disk allocated to the VNF in a dialog box.

» Choose a service group from the Service Groups drop-down. The design view displays the selected service group
with all the service chains and VNFs.

Step 4 Click Network Functions.
Here, you can view the following:

« All the virtual or physical network functions in a tabular format. Use the Show button, and choose to display either
a VNF or PNF.

VNF information is displayed in a tabular format. The table includes information such as VNF name, service chains,
colocation user groups, CPU use, memory consumption, and other core parameters that define performance of
network service. To view more information about the VNF, click a VNF name. See View Information About VNFs
from vManage, on page 108 .

* PNF information is displayed in tabular format. The table includes information such as the serial number and PNF
type. To view and note configuration of a specific PNF, click the desired PNF serial number. Ensure that you manually
note all the configuration of the PNFs and then configure the PNF devices. For example, the following are some of
the PNF configuration where you position the PNF at various locations in the service chain. See the ASR 1000
Series Aggregation Services Routers Configuration Guides and Cisco Firepower Threat Defense Configuration
Guides to configure the PNFs manually.

Figure 35: PNF in the First Position with Service Chain Side Parameters
Configuration of PNF: 4444

Q Search Options v

ServiceGroup3_chain1 ServiceGroup3 - 221.1.41 - - - - 4200000007 255.255.255.248
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Figure 36: PNF in the First Position with Outside Neighbor Information
Configuration of PNF: 4444
Q Search Options v

4200000007 255.255.255.248 - - - 221.1.43 221.1.44 [20C

Figure 37: PNF Shared Across Two Service Chains

The ServiceGroup2_chain3 is a PNF-only service chain and therefore no configuration gets generated. The PNF is
in the last position of the ServiceGroup2 chainl, so only INSIDE variables gets generated.

Configuration of PNF: 33334
Q Search Options v

ServiceGroup2_chain3 ServiceGroup2

ServiceGroup2_chain1 ServiceGroup2 22112 - - - - 4200000002

Figure 38: PNF Shared Across Two Service Chains with Outside Neighbor Information
Configuration of PNF: 33334
Q S

[1830]

2 o - - 255.255.255.248 221.1.25 - - - [1032]

Packet Capture for Cloud onRamp Colocation Clusters

Table 34: Feature History

Feature Name Release Information Description

Packet Capture for Cloud onRamp | Cisco IOS XE Release 17.7.1a This feature lets you capture
Colocation Clusters . ackets at either the physical
Cisco SD-WAN Release 20.7.1 Eetwork interface carg (I}DINIC) level
Cisco vManage Release 20.7.1 or the virtual network interface card
(VNIC) level on a Cloud Services
Platform (CSP) device of a
colocation cluster. You can capture
packets on one or more PNIC or
VNIC on the same device or
different devices with different
browsers at the same time. This
feature lets you gather information
about the packet format, and helps
in application analysis, security,
and troubleshooting.
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You can capture packets flowing to, through, and from a CSP device of a colocation cluster. You can capture
packets at either the PNIC or the VNIC level on the CSP device.

Supported Ports for Packet Capture for Cloud onRamp Colocation Clusters

Packet capture is supported for the following ports:

Table 35: Supported Ports for Packet Capture

Mode VNIC Level PNIC Level

Single Tenancy OVS-DPDK, HA-OVS-DPDK, SR-IOV, MGMT

SR-I0V, OVS-MGMT

Multitenancy (Role-Based Access | OVS-DPDK, HA-OVS-DPDK, |MGMT
Control) OVS-MGMT

Enable Packet Capture on Cisco vManage

Enable the packet capture feature on Cisco vManage before capturing packets at the PNIC or VNIC level on
a CSP device of a colocation cluster:

1
2.

From the Cisco vManage menu, choose Administration > Settings.

In Data Stream, choose Enabled.

Capture Packets at PNIC Level

1
2
3
4.
5
6

From the Cisco vManage menu, choose Monitor > Devices.

Click Colocation Cluster, and choose a cluster.

From the list of devices that is displayed, click a CSP device name.
In the left pane, click Packet Capture.

From the PNIC ID drop-down list, choose a PNIC.

(Optional) Click Traffic Filter to filter the packets that you want to capture based on the values in their
IP headers.

Table 36: Packet Capture Filters

Field Description

SourcelP Source IP address of the packet.
Sour ce Port Source port number of the packet.
Protocol Protocol ID of the packet.

The supported protocols are: ICMP, IGMP, TCP, UDP,
ESP, AH, ICMP Version 6 (ICMPv6), IGRP, PIM, and
VRRP.

Destination | P Destination IP address of the packet.
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Field Description

Destination Port Destination port number of the packet.

7. Click Start.
The packet capture begins, and its progress is displayed:

* Packet Capture in Progress: Packet capture stops after the file size reaches 20 MB, or 5 minutes after
you started packet capture, or when you click Stop.

* Preparing file to download: Cisco vManage creates a file in libpcap format (a .pcap file).

* File ready, click to download the file: Click the download icon to download the generated file.

Capture Packets at VNIC Level

1. From the Cisco vManage menu, choose Monitor > Devices.

2. Click Colocation Cluster, and choose a cluster.

3. From the list of devices that is displayed, click a CSP device name.
4. Choose a VNF, and then click Packet Capture in the left pane.
5

Alternatively, choose Monitor > Devices> Colocation Cluster. Next, choose a cluster and click Networ k
Functions, choose a VNF, and then click Packet Capture in the left pane.

o

From the VNIC | D drop-down list, choose a VNIC.

7. (Optional) Click Traffic Filter to filter the packets to capture based on values in their IP headers. For
more information on these filters, see the above section.

8. Click Start. The packet capture begins, and displays its progress.

Cisco Colo Manager States for Switch Configuration

The various Cisco Colo Manager (CCM) states and transitions when you trigger various processes from Cisco
vManage are:

* INIT state—When the Cisco Colo Manager container is successfully initialized.
* IN-PROGRESS state—When any configuration push is not possible.

» SUCCESS state—When the Cisco Colo Manager container has successfully translated and pushed the
intent that is received from vManage to Cisco Catalyst 9500-40X or Cisco Catalyst 9500-48Y4C switches.

» FAILURE state—If there is any failure in processing or configuration push in Cisco Colo Manager.
When Cisco vManage pushes the Cloud OnRamp for Colocation configuration intent to the CCM for the first
time, it moves from INIT to IN-PROGRESS state. After Cisco Colo Manager pushes the configuration, it

goes back to the SUCCESS or FAILURE state. For every incremental configuration push, it goes to
IN-PROGRESS state. If any of the configurations pushes fail, Cisco Colo Manager goes into FAILURE state.
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\)

Note A notification is sent when Cisco Colo Manager state changes. See Cisco Colo Manager Notifications, on
page 117.

Cisco Colo Manager States and Transitions from Host

Cisco vManage depends on various CSP hosts state for the Cisco Colo Manager to be brought up, which are:

* Starting—When Cisco Colo Manager is brought up and health check script hasn’t been run. During this
phase, Cisco vManage waits for CSP state to change to Healthy.

» Healthy—When the health check script has been run and it has passed the checks. This state implies that
the operational model for configuration status can be queried or configuration can be pushed. During
this phase, if Cisco Colo Manager is in INIT state, Cisco vManage pushes the device list. If Cisco Colo
Manager isn’t in INIT state, Cloud OnRamp for Colocation may be in degraded state and recovery flow
should start.

*» Unhealthy—When all the necessary packages in Network Services Orchestrator (NSO) aren’t up. This
state can be due to various reasons such as, NSO didn’t come up, Cisco Colo Manager package didn’t
come up, or other reasons. This state implies that the configuration status operation isn’t up and
configuration can’t be pushed.

Cisco Colo Manager Notifications

You can view the Cisco Colo Manager notifications from Cisco Colo Manager console by using the show
notification stream viptela command.

The various Cisco Colo Manager internal states are:
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Table 37: CCM Notifications

Monitor Cisco SD-WAN Cloud onRamp for Colocation Solution Devices |

Cisco Colo
Manager
States

Notification Trigger

Notification Output Example

INIT

Init: Cloud OnRamp
for Colocation is
activated and Cisco
vManage brings up
Cisco Colo
Manager on Cisco
CSP.

Note The
Cisco
Colo
Manager
state
must be
in "Init"
only
when the
docker
container
is
initially
brought
up and
must not
be in this
state
unless
container
is
deleted
and
brought
up again.

admin@ncs# show notification stream viptela last 50
notification
eventTime 2019-04-08T17:15:15.982292+00:00
ccmEvent
severity-level minor
host-name ccm
user-id vmanage_admin
config-change false
transaction-id 0O
status SUCCESS
status-code 0
status-message init
details Initializing CCM
event-type CCM-STATUS
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Cisco Colo
Manager
States

Notification Trigger

Notification Output Example

INPROGRESS

Cisco vManage
pushes intent and
Cisco Colo
Manager moves to
in-progress state.

Cisco Col
Manager
generates
multiple
in-progres
notification
for the
switches

Note

that are up|.

8 event-type CCM-STATUS

notification
eventTime 2019-04-08T17:37:54.536953+00:00
ccmEvent
severity-level minor
host-name ccm
user-id vmanage admin
config-change false
transaction-id 0
status SUCCESS
status-code 0O
status-message IN-PROGRESS
details Received configuration from vManage

2]

SUCCESS

During cluster
activation, after
Cisco Catalyst 9500
switches have been
successfully
onboarded, status
moves to
SUCCESS. For any
incremental
configuration, status
moves to SUCCESS
only if
configuration has
been saved
successfully in the
switch devices.

notification
eventTime 2019-04-08T17:51:48.044286+00:00
ccmEvent
severity-level minor
host-name ccm
user-id vmanage_admin
config-change false
transaction-id 0
status SUCCESS
status-code 0
status-message SUCCESS
details Devices done onboarding
event-type CCM-STATUS
|
1
admin@ncs#

Cisco
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Cisco Colo
Manager
States

Notification Trigger

Notification Output Example

FAILURE

If onboarding of
switches fails
during cluster
activation, CCM
status moves to
FAILURE. If any
incremental
configurations are
not saved, CCM
status moves to

notification

eventTime 2019-04-08T18:01:44.943198+00:00
ccmEvent
severity-level critical
host-name ccm
user-id vmanage_ admin
config-change false
transaction-id 0
status FAILURE
status-code 0
status-message FAILURE

details SVL bringup not successful. Could not sync

FAILURE. TenGigabitEthernet2/0/* interfaces.
Note The failure Ievent—type CCM-STATUS

state cannot

transition {@dmin@ncs#

another

state

without

end-user

interventioh.
()nboardhugof admin@ncs# show notification stream viptela last 100 | include
switches fails Step =

notification

during cluster
activation due to
wiring errors in
flexible
connections, and
CCM status moves
to FAILURE.

details Step 5 of 7: Device switchl 192.168.100.21

(C9500-48Y4C-CAT2324L2HM) connected after SVL reload.

details Step 6 of 7: Started sync-from for primary device

switchl 192.168.100.21 (C9500-48Y4C-CAT2324L2HM)

details Step 6 of 7: Sync-from done for primary device switchl
192.168.100.21 (C9500-48Y4C-CAT2324L2HM)

Device list switchl 192.168.100.21

(C9500-48Y4C~-CAT2324L2HM), switch2 192.168.100.19

(C9500-48Y4C-CAT2316L2F2)

details Step 6 of 7: Devices ready for LLDP query Device list
switchl 192.168.100.21 (C9500-48Y4C-CAT2324L2HM), switch2
192.168.100.19 (C9500-48Y4C-CAT2316L2F2)

details Step 6.1 of 7: LLDP Query Details: csp2 has 8/8

interfaces connected, 2/4 sriov, 2/4 fortville to primary

switch; 2/4 sriov, 2/4 fortville to secondary switch;

Found devices with not optimum connections:- cspl has 6/8

interfaces connected, 2/4 sriov, 2/4 fortville to primary

switch; 2/4 sriov, 0/4 fortville to secondary switch;

Minimum Requirement is to have 8/8 interfaces per CSP in

cluster. Recommended action: Please refer to recommended

topologies and minimum requirements details Step 7 of 7:

Devices done onboarding Device list switchl 192.168.100.21

(C9500-48Y4C-CAT2324L2HM), switch2 192.168.100.19
(C9500-48Y4C-CAT2316L2F2)
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VM Alarms

The following are VM alarms and you can view them from Cisco vManage, when Cisco vManage receives
the alarms.

Table 38: Alarms

Alarm Trigger Condition Syslog Messages

INTF_STATUS CHANGE interface status change nfvis
%SYS-6-INTF_STATUS CHANGE:

Interface ethO, changed state to up

VM_STOPPED vm stopped nfvis %SYS-6-VM_STOPPED:
VM stop successful:

SystemAdminTena ROUTER 0 df6733cl-
0768-4ae6-8dce-b223ecdb036¢

VM_STARTED vm started nfvis %SYS-6-VM_STARTED:
VM start successful:

SystemAdminTena ROUTER 0 df6733cl-
0768-4ae6-8dce-b223ecdb036¢

VM_REBOOTED vm rebooted nfvis %SYS-6-VM_REBOOTED:
VM reboot successful:

SystemAdminTena ROUTER 0 df6733cl-
0768-4ae6-8dce-b223ecdb036¢

VM_RECOVERY INIT vm recovery initiation nfvis
%SYS-6-VM_RECOVERY _INIT:
VM recovery initiation successful:

SystemAdminTena ROUTER 0 df6733cl-
0768-4ae6-8dce-b223ecdb036¢

VM_RECOVERY_REBOOT vm recovery reboot nfvis
%SYS-6-VM RECOVERY REBOOT:
VM recovery reboot successful:

SystemAdminTena ROUTER 0 df6733cl-
0768-4ae6-8dce-b223ecdb036¢

VM_RECOVERY COMPLETE |vm recovery complete nfvis
%SYS6-VM RECOVERY COMPLETE:.
VM recovery successful:

SystemAdminTena ROUTER 0 df6733cl-
0768-4ae6-8dce-b223ecdb036¢
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Alarm Trigger Condition Syslog Messages

VM_MONITOR UNSET vm monitoring unset nfvis
%SYS-6-VM_MONITOR UNSET:
Unsetting VM monitoring
successful:
SystemAdminTena ROUTER 0 df6733cl-

0768-4ae6-8dce-b223ecdb036¢

VM_MONITOR SET vm monitoring set nfvis
%SYS-6-VM_MONITOR_SET:
Setting VM monitoring successful:

SystemAdminTena ROUTER 0 df6733cl-
0768-4ae6-8dce-b223ecdb036¢

See Cisco NFVIS Configuration Guide for more information about syslog support and VM alarms.

VM States

The following are the operational status of deployed VM life cycle. In Cisco SD-WAN, you can view and
monitor the VM states from Cisco vManage.

Table 39: VM States

VM States Description

VM_UNDEF STATE VM or VNF is transitioning from one state to another.

VM_INERT STATE VM or VNF is deployed but not alive.

VM_ALIVE _STATE VM or VNF is deployed and successfully booted up
or alive.

VM_ERROR_STATE VM or VNF is in error state when deployment or any
other operation fails.

Cloud Services Platform Real-Time Commands

Table 40: Real-Time Commands

System Information

Container status

show control connections

Control connection history
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Control local properties

Control summary

Control statistics

Control valid vEdges

valid vManage ID

HW Alarms

HW Environments

PNICs

System Status

Host System Mgmt Info

Host System settings

Host System processes

Resource CPU allocation

RBAC Authentication

Resource CPU VNFs

Hardware Inventory

Hardware Temperature thresholds

Control affinity stats
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CHAPTER 8

High Availability

The Cisco SD-WAN Cloud onRamp for Colocation solution allows various consumers to access various
repetitive applications securely. The Cisco SD-WAN Cloud onRamp for Colocation solution High Availability
(HA) is designed to handle several types of failure possible in a cluster deployment. The following types of
failures can occur in a Cisco SD-WAN Cloud onRamp for Colocation solution deployment:

* Compute failure
* Switch failure

* Service chain failure

To resolve the failures, use the following mechanisms:
* Redundancy

* Failure detection

* Redundancy, on page 125
» Handle Various Failure Scenarios, on page 129

Redundancy

The following are the components where redundancy has been added to address failure of the component:
* x86 Compute Hardware—See Redundancy of x86 Compute Hardware, on page 126.
* Network Fabric—See Redundancy of Network Fabric, on page 126.
* Physical NIC/interface—See Redundancy of Physical NIC or Interface, on page 126.

* NFVIS Virtualization Infrastructure—See Redundancy of NFVIS, Virtualization Infrastructure, on page
126.

* Service-Chain/VNF—See Redundancy of Service Chain or VNF, on page 126.

* Cisco Colo Manager—See Recovery of Cisco Colo Manager, on page 129.
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Redundancy of Network Fabric

Network Fabric—The hardware switch redundancy features are used to handle network fabric failures. In a
switch failure, ensure that the standby switch takes over the traffic traversing through the failed switch.

Redundancy of x86 Compute Hardware

x86 Compute Hardware—Any hardware components such as, processor, storage, and others that are used on
the x86 compute hardware can fail leading to a complete Cisco Cloud Services Platform (CSP) system failure.
The Cisco vBond orchestrator continuously monitors the health of the x86 compute platform by using ICMP
ping through the management interface. In a system failure, the orchestrator shows the device status and the
service chains and VMs impacted. Take desired action to bring up service chains. See Monitor Cisco SD-WAN
Cloud onRamp for Colocation Solution Devices, on page 107. Depending on the operational status of the VNFs
(Virtual Network Function), the VMs must be brought up on a different CSP if enough are resources are
available. This action allows the VNF to retain the Day-N configuration. If the VNF disk is using local storage,
the entire service group must be respun on another CSP device with the Day-0 configuration that is stored in
the orchestrator.

Redundancy of Physical NIC or Interface

Physical NIC or interface—If a physical NIC (PNIC) or interface or cable fails or gets disconnected, the VNFs
that are using these interfaces are impacted. If a VNF is using an OVS network, the port channel configuration
is used to achieve a link redundancy. If a VNF is using an OVS network, and if the VNF has an HA instance,
that instance has been already brought up on a different CSP. The failover happens to this VNF on the second
CSP. If there is no second VNF instance, the service chain with the failed VNF must be deleted and
reinstantiated.

Redundancy of NFVIS, Virtualization Infrastructure

Cisco NFVIS Virtualization Infrastructure—Multiple types of failures in the NFVIS software layer can occur.
One of the critical components of CSP can crash or the host Linux kernel can panic or one of the critical
components fails to respond. In case of critical component failures, the NFVIS software generates netconf
notifications. The orchestrator uses these notifications to show the failure on Cisco vManage. If Cisco CSP
or Cisco NFVIS crashes or control connection goes down, the orchestrator shows that device reachability is
down. You can resolve a networking issue (if any), or reboot the CSP device. If device does not recover, you
must proceed with removing the CSP device.

Redundancy of Service Chain or VNF

Table 41: Feature History

Feature Name |Release Description
Information

Placement of HA | Cisco SD-WAN | This feature provides an optimum placement of service chains and
VNF NIC for Release 20.5.1 | therefore maximizes the resource utilization while accounting for switch

Switch . redundancy. The VNICs of the HA primary and secondary instances
Cisco vManage . . .

Redundancy are placed on alternate CSP interfaces to achieve redundancy at switch
Release 20.5.1 level
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Feature Name |Release Description
Information

Modifications to | Cisco SD-WAN | This release modifies the placement of primary and secondary VNF
HA VNF NIC |Release 20.6.1 | VNICs on the physical NICs of the CSP device that are connected to

Placement . redundant switch interfaces.
Cisco vManage

Release 20.6.1

Service Chain or VNF—Some of the VNFs in the colocation service chain such as, firewall might support
stateful redundancy features by using a standby VNF, whereas VNFs such as Cisco CSR1000V might not
support stateful redundancy. The Cisco SD-WAN Cloud onRamp for Colocation solution relies on the VNFs
to achieve VNF high availability. The HA support at service chain level isn't available. If a VNF supports
stateful HA, it detects the failure and performs a switchover. The assumption is that the previously active
VNF goes down and reboots as a standby VNF if the CSP device hosting the VNF is functional, and all the
NIC or interface connectivity is functional. If the VNF isn't operational, the HA for VNF isn’t functional from
that time and you must fix the issue.

If a VNF doesn’t support HA, it’s assumed that the VNF reboots if any critical process fails within the VNF
and no HA support is available for such VNFs.

Placement of Highly Available VNF NIC for Switch Redundancy

Starting from Cisco SD-WAN Cloud onRamp for Colocation Release 20.5.1, the network services in a service
chain forward traffic without interruption even during switch failures. The traffic flow is uninterrupted because
the virtual NICs (VNICs) of an HA virtual instance are placed on a different switch than the one that has the
primary HA instance. For example, if VNF-primary is placed on the physical NIC of CSP1, which is connected
to switch1, VNF-secondary is placed on the physical NIC of CSP2, which is connected to switch-2.

The image below shows the following:

* The solution provisions the primary instances of VNF #1 and VNF #2 to the SR-IOV ports on CSP #1,
which are connected to switch #1.

* The secondary instances of VNF1 and VNF2 are placed on the SR-IOV ports of CSP2, which are connected
to switch2.

* If switch #1 fails, the traffic continues to flow from the switch#2 of the first VNF and second VNF using
the second switch.

Cisco SD-WAN Cloud OnRamp for Colocation Solution Guide, Release 20.8.1 [Jjj



High Availability |
. Redundancy of Service Chain or VNF

VNF #1-Primary

Fortville

IF 42-Primary VNF #1-Secondary VNF #2-Secondary
Niantic Fortvlle Niantic

CSP CSP #2

R-IOV ROV

Catalyst 9500 #1 Catalyst 9500 #2

1.f0f45”°”47 l
- (11
T

44| 1jo/us
1/0/46

2/0/47
/45

Egress Ingress- Egress ngress
WAN/Transport Uplink chwise irtuat s WAN/Transport Uplink

Notes About HA VNF NIC for Switch Redundancy

« This feature applies to single-tenant clusters only, where the VNFs use SR-IOV interfaces, and where
dual-homing to a switch is not supported. Multitenant clusters don’t require this feature because they
already use OVS interfaces, which are part of port channels and therefore, dual-homed to switches.

* The placement algorithm in the solution automatically places the service chains based on the redundancy
requirements specified above. You don't need any manual configuration.

* When you upgrade Cisco vManage from earlier releases to Release 20.5.1, the following points apply
when you use the HA VNF NIC redundancy feature:

* For the new service groups that you create, the placement of the VNICs of an HA virtual instance
on a CSP interface connecting to the alternate switch is automatic.

* For existing service groups, detach the service group from a cluster, and then reattach it to the cluster
to achieve switch redundancy for the service chain.

« At the time of placing the egress ports, the solution first attempts to place the egress port on the same
CSP port that hosts the ingress VNF port. If the CSP port doesn’t have sufficient bandwidth, the solution
attempts to place the egress ports on the additional ports on the same CSP device that is connected to the
same switch.

Starting from Cisco SD-WAN Cloud onRamp for Colocation Release 20.6.1, the solution supports service
chains with bandwidth of up to 10 Gbps. The placement of the ingress and egress VNICs of a VNF could be
on different CSP ports of the same CSP device if the bandwidth required is more than 5 Gbps and less than
or equal to 10 Gbps.
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Recommendations for Using Placement of HA VNF NIC for Switch Redundancy

* Design as many service chains as possible and provision these chains so that you use all service chain
resources to the maximum capacity. This enables the colocation solution to utilize the VMs bandwidth
completely in a sequential order without leaving any unused bandwidth on each port.

+ Attach high-bandwidth service chains to colocation clusters, followed by the low-bandwidth service
chains. For optimal resource utilization, attach highly available service chains to colocation clusters
followed by the stand-alone service chains.

Recovery of Cisco Colo Manager

Cisco Colo Manager Recovery—Cisco Colo Manager is brought up on a CSP device in a Cloud OnRamp for
Colocation. vManage selects a CSP with the DTLS tunnel to bring up Cisco Colo Manager. The Cisco Colo
Manager recovery flow is required during the following scenario:

If a CSP hosting Cisco Colo Manager is considered for Return Material Authorization (RMA) process and
there are at least two other CSP devices in the cluster after deleting this CSP, then a new Cisco Colo Manager
is brought up automatically by vManage on one of the existing two CSP devices during a new configuration
push.

Note  You must power down the CSP device that has been considered for RMA process or perform a factory default
reset on the CSP device. This task ensures that there is only one Cisco Colo Manager in the cluster.

Note A host with Cisco Colo Manager running can restart or reboot, and this action is not a recovery scenario as
Cisco Colo Manager should come up intact with all the configuration and operational data.

If after a cluster is successfully activated and then Cisco Colo Manager becomes unhealthy, see Troubleshoot
Cisco Colo Manager Issues, on page 155.

Handle Various Failure Scenarios

* VNF failure

* [fa VM in a service chain that is HA capable goes down, the standby VM takes over. This standby
service chain is functional within few seconds. The Cisco NFVIS software on a CSP device tries
to bring up the failed active VM if it’s a monitored VM. If the VM recovers successfully, it switches
to active and standby modes successfully. If the VM didn’t recover successfully and you want to
bring up HA capability on this VM, delete the service chain and bring up new service chain with
HA capability. Here, VM detects that the failure is based on heartbeat and there must not be any
impact on traffic (except few seconds). If an active VM recovers, this VM could become active
again or stay as standby and this state varies from one VM to another.

« Ifa VM isn’t HA capable, the service chain fails and traffic is black holed. Cisco Colo Manager
detects this failure and hence vManage as it receives notification that VM is down and service chain
is down, vManage sends an alert. If the VM recovers successfully, the same notification is sent and
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the service chain is functional without any intervention. If the VM doesn’t recover successfully,
delete the service chain and bring up a new service chain.

* Service chain failure

« [fall VMs in a service chain support HA, service chains can have active and standby service chains.
If an active service chain goes down, the standby service chain takes over and is functional within
few seconds. This behavior is VM level HA and VM failover behavior takes over. NFVIS software
on CSP also tries to bring up the failed active VMs (for monitored VMs) and if they recover
successfully, the VMs switch over to active and standby modes successfully.

* [f VM aren’t HA capable, the service chain fails and traffic is black holed. NFVIS and Cisco Colo
Manager send notifications that VMs are down and vManage send an alert. Based on the notification,
bring up another active service chain. If the service chain has recovered successfully, the same
notification is sent and the service chain is functional without any intervention.

* Cisco CSP device failure

If a Cisco CSP is down, all the service chains and VMs running on that CSP are also down. Cisco Colo
Manager sends notifications to Cisco vManage that the CSP device isn’t reachable and vManage detects
the DTLS connectivity loss with the CSP device. Cisco vManage sends alert about the CSP device and
you must bring up the service chains on another CSP device by creating the service chains and pushing
the configuration to a colocation. If there’s not enough compute hardware, add another CSP device to a
colocation and push the service chain configuration to the other CSP device.

Starting from Release 20.5.1, you can replace a faulty CSP device by creating a backup copy of the
device in a colocation cluster. Therefore, when a CSP device fails, you can add a new CSP device to
Cisco vManage, and restore the device to a state as the faulty device was in before the replacement. To
know more about how to replace a CSP device, see Return of Materials of Cisco CSP Devices.

» Switch link failure

If a link from a switch is down, the other switch takes over and service chain traffic continues.
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CHAPTER 9

Cisco SD-WAN Cloud onRamp for Colocation
Multitenancy

Table 42: Feature History

Feature Name |Release Description
Information

Colocation Cisco IOS XE | This feature enables a service provider to manage multiple colocation
Multitenancy Release 17.5.1a | clusters and share these clusters across tenants by using multiple

Using . colocation groups. In a multitenant setup, service providers don't need
Cisco SD-WAN . .

Role-Based to deploy a unique colocation cluster for each tenant. Instead, the
Release 20.5.1 . .

Access Control hardware resources of a colocation cluster are shared across multiple

Cisco vManage |tenants. With multitenancy, service providers ensure that tenants view
Release 20.5.1 | only their data by restricting access based on roles of individual tenant
users.

* Overview of Colocation Multitenancy, on page 131

* Roles and Functionalities in a Multitenant Environment, on page 132

» Recommended Specifications in a Multitenant Environment, on page 133
» Assumptions and Restrictions in Colocation Multitenancy, on page 134

* Service Provider Functionalities, on page 135

» Manage Tenant Colocation Clusters, on page 137

* c-tenant-functionalities, on page 138

* Monitor Colocation Cluster Devices and Cisco SD-WAN Devices in Comanaged Multitenant Environment,
on page 139

Overview of Colocation Multitenancy

In Cisco SD-WAN Cloud onRamp for Colocation multitenancy, a service provider can manage multiple
colocation clusters using Cisco vManage in single-tenant mode. A service provider can bring up a multitenant
cluster in the same way as bringing up a cluster in a single-tenant mode. A multitenant cluster can be shared
across multiple tenants. See Create and Activate Clusters.

The tenants share the hardware resources such as the Cisco Cloud Services Platform (CSP) devices and Cisco
Catalyst 9500 devices of a colocation cluster. The following are the key points of this feature.
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* A service provider deploys and configures the Cisco SD-WAN Controllers (Cisco vManage, Cisco vBond
Orchestrator, and Cisco vSmart Controller) with valid certificates.

* A service provider sets up colocation clusters after onboarding the Cisco CSP devices and Cisco Catalyst
9500 switches.

* Cisco SD-WAN operates in a single-tenant mode and Cisco vManage appears in a single-tenant mode.

* In a colocation multitenant deployment, a service provider ensures that tenants see only their service
chains by, creating roles. A service provider creates roles for each tenant in a colocation group. These
tenants are permitted to access and monitor the service chains based on their roles. However, they can’t
configure their service chains or change the system-level settings. The roles ensure that tenants can access
only the information that they are authorized to view.

* Each tenant traffic is segmented using VXLAN across the compute devices, and VLAN across the Cisco
Catalyst switch fabric.

* A service provider can provision service chains on a specific cluster.

The following are the two scenarios of a colocation multitenant setup:

* Service provider owned Cisco SD-WAN devices: In this scenario, the Cisco SD-WAN devices used in
a service chain belong to the corresponding service provider. The CSP devices and Catalyst 9500 switches
are owned, monitored, maintained by the service provider. The virtual machine (VM) packages are
owne